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Section 1. Introduction

1.1 Background

The Hazus Flood Loss Estimation Methodology provides state, local, tribal, and territorial (SLTT)
officials with a decision support software for estimating potential losses from flood events. This loss
estimation capability enables users to anticipate the consequences of floods and develop plans and
strategies for reducing risk. The Geographic Information System (GIS) based software can be applied
to study geographic areas of varying scale with diverse population characteristics and can be
implemented by users with a wide range of technical and subject matter expertise.

This Methodology has been developed, enhanced, and maintained by the Federal Emergency
Management Agency (FEMA) to provide a tool for developing flood loss estimates for use in:

= Anticipating the possible nature and scope of the emergency response needed to cope with a
flood-related disaster.

= Developing plans for recovery and reconstruction following a disaster.
= Mitigating the possible consequences of floods.

The Hazus Flood Model provides the capability to quantify potential building impacts and losses, and
social parameters such as shelter needs. The model analyzes flood hazards from a variety of inputs
or can develop a flood hazard using probabilistic parameters set by the user.

The current capability addresses all fifty states and Caribbean territories and includes both riverine
and coastal models. This flood methodology was developed by FEMA in the early 2000s and is
updated with ongoing modifications based on newer methodology or software development. It is
intended to help guide the allocation of federal resources to stimulate risk mitigation efforts and to
plan for a flood-related disaster response at all levels of government.

This Hazus Flood Model User Guidance (FEMA, 2024) outlines the background and instructions for
developing a Study Region and defining a scenario to complete a flood loss estimation analysis using
Hazus. It also provides information on how to modify inventory, improve hazard data and analysis
parameters for advanced applications, and guidance on calculating and interpreting loss results.

The Hazus Flood Model Technical Manual (FEMA, 2024) documents the methods used in calculating
losses. A companion document, the Hazus Inventory Technical Manual (FEMA, 2024), provides more
detailed methodology and data descriptions for the inventory shared by each hazard model.
Together, these documents provide a comprehensive overview of this nationally applicable loss
estimation methodology across Hazus.
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1.2 Hazus Users and Applications

Hazus can be used by various types of users with a wide range of informational needs. An SLTT
government official may be interested in the costs and benefits of specific mitigation strategies, and
thus may want to know the expected losses if mitigation strategies have (or have not) been applied.
Health officials may want information regarding the demands on medical care facilities and may be
interested in social impacts for different flood scenarios. Emergency response teams may use the
results of a loss study in planning and performing emergency response exercises. They might be
interested in the operating capacity of emergency facilities such as fire stations, emergency
operations centers, and police stations. Emergency planners may want estimates of temporary
shelter requirements for different flood scenario events. Federal and state government agencies may
conduct a loss analysis to obtain quick estimates of impacts immediately following a flood to best
direct resources to the disaster area. Insurance companies may be interested in the estimated
monetary losses so they can determine asset vulnerability.

Flood loss estimation analyses have a variety of uses for various departments, agencies, and
community officials. As users become familiar with the loss estimation methodology, they can
determine how to use it to best suit their needs, and how to appropriately interpret the study results.

The products of Hazus analyses have several pre- and post-flood applications in addition to
estimating the scale and extent of damage and disruption. Examples of pre-flood applications of the
outputs include:

= Development of flood hazard mitigation strategies that outline policies and programs for
reducing flood losses and disruptions indicated in the initial loss estimation study. Strategies can
involve rehabilitation of hazardous existing buildings (e.g., unreinforced structures in a high-risk
flood zone), building code enforcement, development of appropriate zoning ordinances for land
use planning in flood inundation zones, and the adoption of advanced building codes.

= Development of preparedness (contingency) planning measures that identify alternate
transportation routes, social preparedness, and public education.

= Anticipation of the nature and extent of response and recovery efforts including the identification
of alternative housing; the location, availability, and scope of required medical services; and the
establishment of a priority ranking for restoration of water and power resources.

Post-flood applications of the outputs include:

= Projection of immediate economic impact assessments for state and federal resource allocation,
and support for state and/or federal disaster declarations by calculating direct economic impact
on public and private resources, local governments, and the functionality of facilities in the area.

= Activation of immediate emergency recovery efforts including search and rescue operations,
rapid identification and treatment of casualties, provision of emergency housing shelters, and
rapid repair and availability of essential utility systems.
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= Application of long-term reconstruction plans that include the identification of long-term
reconstruction goals, implementation of appropriate wide-range economic development plans for
the impacted area, allocation of permanent housing needs, and the assessment of land use
planning principles and practices.

1.3 Assumed User Expertise

Users can be divided into two groups: those who perform the analysis and those who use the
analysis results. For some analyses, these two groups occasionally consist of the same people. The
more interaction that occurs between these two groups, the better the analysis will be. End users of
the loss estimation analysis need to be involved from the beginning to make results more usable.

Any risk modeling effort can be complex and would benefit from input from an interdisciplinary group
of experts. A flood loss analysis could be performed by a representative team consisting of the
following:

= Floodplain managers

= Structural engineers or architects
=  GIS professionals

= Economists

= Sociologists

= Emergency planners

= Loss analysts

The individuals needed to perform the study can provide valuable insight into the risk assessment
process and will depend on the desired level of analysis, explained in greater detail in Section 2.3. In
addition to subject matter expert involvement, at least one GIS specialist should participate on the
team.

If an SLTT agency is performing the analysis, some of the expertise may be found in-house. Experts
are generally found in several departments: building permits, public works, planning, public health,
engineering, information technologies, finance, historical preservation, natural resources, and land
records. Although internal expertise may be most readily available, the importance of the external
participation of individuals from academic institutions, citizen organizations, and private industry
cannot be underestimated.

1.4 When to Seek Help

The results of a loss estimation study should be interpreted with caution because default input
values have a great deal of uncertainty.
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If the loss estimation team does not include individuals with expertise in the areas described in
Section 1.3, one or more consultants will likely be needed to help interpret the results. It is also
advisable to retain objective reviewers with relevant expertise to evaluate the map and tabular data
outputs. A floodplain manager, hydrologist, or hydraulic engineer may be needed to provide
deterministic or probabilistic scenario data or review the software parameters.

If the user intends to modify the default inventory data or parameters, assistance will be required
from an individual with relevant expertise. For example, if the user wishes to change the default
percentages of foundation types in a region, a structural engineer with knowledge of regional design
and construction practices would be helpful. Modifications to defaults in the economic loss models
will require input from an economist.

1.5 Technical Support

Technical Support contact information is provided in the Hazus application at Help > Obtaining
Technical Support; technical assistance is available via the Hazus Help Desk by email at
FEMA-Hazus-support@fema.dhs.gov (preferred) or by phone at 1-877-FEMA-MAP (1-877-336-2627).
The FEMA Hazus website also provides answers to Frequently Asked Questions, and information on
software updates and training opportunities.

FEMA-provided resources also include the Hazus Virtual Training Library, a series of short videos
arranged into playlists that cover various Hazus topics, from an introduction to Hazus methodologies,
to targeted tutorials on running Hazus analyses, to best practices when sharing results with decision
makers. This easily accessible learning material provides quick topic-refreshers, free troubleshooting
resources, and engaging guides to further Hazus exploration.

The application’s Help menu references the help files for ArcGIS. Since Hazus was built as an
extension to ArcGIS functionality, knowing how to use ArcGIS and ArcGIS Help Desk will help Hazus
users.

Technical support on any of the four hazards is available in the contacts shown via Help > Obtaining
Technical Support.

1.6 Uncertainties in Loss Estimates

Although the software offers users the opportunity to prepare comprehensive loss estimates, even
with state-of-the-art techniques, uncertainties are inherent in any estimation methodology. The Flood
Model is only a tool for loss estimation from modeled flood events. Hazus does not compute
uncertainties in the loss estimates, provide ranges for possible losses, or offer any confidence levels.
The output of hard numbers is tied to the input data. Uncertainties may be estimated, but Hazus
does not output such statistics.
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Section 2. Overview of the Flood Model

This brief overview of the Flood Methodology is intended for SLTT officials contemplating a flood
analysis.

The Flood Model will generate an estimate of the consequences to a county or region of a scenario
flood (i.e., a flood of a specified magnitude). The resulting "loss estimate" will generally describe the
scale and extent of damage and disruption that may result from the modeled flood event. The
following information can be obtained:

= Quantitative estimates of structural damage based on specific building and occupancy types that
delineate how and to what extent a structure can be damaged by varying flood water depths.

= Quantitative estimates of losses in terms of direct costs for repair and replacement of damaged
buildings, direct costs associated with loss of function (e.g., loss of business revenue or
relocation costs).

= Estimates of social and infrastructure impacts.
To generate this information, the Methodology includes:

= (Classification systems used in assembling inventory and compiling information on the General
Building Stock (GBS), demographic, and economic data.

= Standard calculations for estimating type and extent of damage, and for summarizing losses.

= National and regional databases containing information for use as baseline (built-in) data
useable in the calculation of losses if there is an absence of user-supplied data.

These systems, methods, and data have been combined in a user-friendly GIS software for this loss
estimation application.

The Hazus software uses GIS technologies for performing analyses with inventory data and
displaying losses and consequences on applicable tables and maps. The Methodology permits
estimates to be made at several levels of complexity, based on the level of inventory data entered for
the analysis (i.e., baseline data versus locally enhanced data). The more concise and complete the
inventory information, the more accurate the results.

The following figure provides a graphic representation of the modules that the Hazus Flood Model
Methodology is comprised of, and their interrelation in deriving estimates.
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Figure 2-1 Hazus Flood Model Methodology Schematic

While Figure 2-1 shows the conceptual relationships, the steps used in the Hazus Flood Model are as
follows:

Select the area to be studied: The Hazus Study Regijon (the region of interest) is created based
on Census block, tract, or county level aggregation of data. The area generally includes a city,
county, or group of municipalities. It is generally desirable to select an area that is under the
jurisdiction of an existing regional planning group.

Specify the Flood hazard scenario: In developing the scenario, flood consideration should be
given to the availability of data including depth grids or elevation models from HEC-RAS or lidar-

derived sources

Integrate local inventory data: Include user-defined facilities and updates to GBS characteristics.

Use the formulas embedded in Hazus: Compute probability distributions for damage to different
classes of buildings, facilities, and infrastructure system components.

Page 2-2




Hazus Flood Model User Guidance

= Compute estimates of direct economic loss, infrastructure, and social impacts using the damage
and functionality information.

The user plays a major role in selecting the scope and nature of the output of a loss estimation
analysis. A variety of maps can be generated for visualizing the extent of the losses. Generated
reports provide numerical results that may be examined at the level of the Census block, tract, or
aggregated by county or region.

2.1 Flood Hazards in the Flood Model

The Hazus Flood Model analyzes both riverine and coastal flood hazards. Flood hazard is defined by
a relationship between depth of flooding and the annual chance of inundation to that depth.

Depth, duration, and velocity of water in the floodplain are the primary factors contributing to flood
losses. Other hazards associated with flooding that contribute to flood losses include channel
erosion and migration, sediment deposition, bridge scour, and the impact of flood-borne debris. The
Hazus Flood Model allows users to estimate flood losses from depth of flooding. The Flood Model
does not estimate the losses due to high-velocity flash floods.

In different contexts, flood hazard may have different meanings. Hazard can mean risk in some
contexts, and it can mean a source of danger in others. The hazard may be that an area is inundated
about once every 10 years (risk), or it may be that an area is subject to flood depths ranging from 5
to 10 feet (source of danger). Flood frequency studies combine these ideas and define flood hazard
in terms of the chance that a certain magnitude of flooding is exceeded in any given year.

Flood magnitude is usually measured as a discharge value, flood elevation, or depth. For example,
flood magnitude may be referred to as the 100-year flood elevation, which is the elevation, at the
point of interest, that has a 1% annual chance of being exceeded by floodwater. Using the flood
frequency convention, flood hazard is defined by a relation between depth of flooding and the annual
chance of inundation greater than that depth. The relation is called a depth-frequency curve.

2.2 Definitions of Structures

There are differences between terminology used to designate distinctions between types or
categories of structures. The term “structure” refers to all constructions, such as a building, bridge,
water tank, shed, carport, or other man-made thing that is at least semi-permanent. A building is a
structure with a roof and walls that is intended for use by people and/or inventory and contents,
such as a house, school, office, or commercial storefront. A facility corresponds to a particular place,
generally a building, with an intended purpose such as a school, hospital, electric power station, or
water treatment facility. Some facilities are defined as ‘essential facilities’ meaning the facility is
critical to maintaining services and functions vital to a community, especially during disaster events.
The buildings, essential facilities, and transportation and utility systems considered by the
Methodology are as follows:
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= General Building Stock: The key (GBS databases in Hazus include square footage by occupancy
and building type, building count by occupancy, and building type, building and content valuation
by occupancy and building type, and general occupancy mapping. The GBS commercial,
industrial, and residential buildings in a region are not considered individually when calculating
losses. These buildings within each Census block are aggregated and categorized. Building
information derived from Census and employment data are used to form groups of 33 specific
occupancy classes, seven foundation types, and five general building types (additional
information on the Hazus baseline GBS inventory data is provided in the Hazus Inventory
Technical Manual (FEMA, 2024). Degree of damage is computed for each grouped combination
of model building type and occupancy class.

= User-Defined Facilities (UDFs): A template database is available in Hazus to enter individual
accurate results. structures to be analyzed, instead of or in addition to the aggregated GBS.
Template databases are available in Hazus if the user is comfortable working with SQL Server.
More information on how to set up a UDF database can be found in Section 9 of this document,
the Hazus Inventory Technical Manual (FEMA, 2024) or in the documentation and sample
databases accompanying the Hazus FAST tool. Use of individual, site-specific data is highly
encouraged for more

2.3 Levels of Analysis

Hazus is designed to support two general types of analysis (Basic and Advanced), split into three
levels of data updates (Levels 1, 2, and 3). Figure 2-2 provides a graphic representation of the
various levels of analysis.

detailed
engineering data

Q
é_"o
\3

N
@ Combinations of local and
baseline hazard, inventory,
and damage information

0}(' Baseline hazard, inventory, and
Ao damage information

Figure 2-2 Levels of Hazus Analysis
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2.3.1 Analysis Based on Baseline Information

The basic level of analysis uses only the baseline databases built into the Hazus software and
Methodology on building square footage and value, population characteristics, costs of building
repair, and certain basic economic data. This level of analysis is commonly referred to as a Level 1
analysis. In a basic analysis (Level 1), the user must specify a drainage area for stream network
delineation, and Hazus will use these inputs to estimate a depth grid for the study region. Direct
economic and social losses associated with the GBS, and essential facilities are computed. Baseline
data for transportation and utility systems are included; thus, these systems are considered in the
basic level of analysis. However, there is a significant level of uncertainty pertaining to the estimates.

Other than defining the Study Region, selecting the scenario flood(s), and making decisions
concerning the extent and format of the output, an analysis based on baseline data requires minimal
effort from the user. As indicated, the estimates involve large uncertainties when inventories are
limited to the baseline data. This level of analysis is suitable primarily for preliminary evaluations and
comparisons among different Study Regions. A basic Level 1 analysis could be used for comparisons
and preliminary evaluations to assist in identifying potential mitigation actions within a community,
which could be useful if evaluating funding priority for projects.

2.3.2 Analysis with User Supplied Inventory

Results from an analysis using only baseline inventory data can be improved greatly with at least a
minimum amount of locally developed input. Improved results are highly dependent on the quality
and quantity of improved inventory data. The significance of the improved results also relies on the
user’s analysis priorities. This level of advanced analysis is commonly referred to as a Level 2/Level
3 analysis. The following inventory improvements impact the accuracy of Level 2/Level 3 Advanced
Analysis results:

= Use of locally available data or estimates of the square footage of buildings in different
occupancy classes.

= Use of local expertise to modify the mapping scheme databases that determine the percentages
of specific building types associated with different occupancy classes.

= Preparation of a detailed inventory of all essential facilities and infrastructure.
= Use of locally available data concerning construction costs or other economic parameters.

= Level 2 or 3 hazard data can also be incorporated in the form of independently generated depth
grids. Sources for these grids may include local engineering offices, state water departments
with access to lidar products, adapted Digital Flood Insurance Rate Maps (DFIRMs) from FEMA,
or the HEC-RAS (Hydrologic Engineering Center’s River Analysis System) tool.
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Section 3. Getting Started Part 1: Hazus Startup Screen

The Hazus Startup screen is the first screen users will see after launching Hazus.

3.1 Hazus Startup

Before running a loss estimation analysis, users must define a Study Region. The Study Regijon in
Hazus is the geographic unit for which data are aggregated, the flood hazard is defined, and the
analysis is carried out. Before starting, make sure that the appropriate state(s)’s Hazus data have
been downloaded and extracted here: C:\HazusData\Inventory.

Hazus will prompt users to create a new region or import a previously created region. Users can also
open, delete, duplicate, backup, or export an existing region.

Study regions which include multiple counties may not complete a Level 1 analysis and may include
multiple failed reaches.

3.2 Create New Region
In the Hazus Startup screen (Figure 3-1

Hazus Startup X
: Welcome 1o Hazus.

In order to use Hazus. you need to define the study
region to be used in the analysis.

Flease select the desired option below, and a wizard
will guide vou through the necessary steps.

» EARTHQUAKE = FLOOD

® Create a new region

(" Open aregion

= |
5
L

2 (" Delete aregion

sin seasmnt ik st () FEMA " Duplicate aregion
(" Export/Backup a region

(" Import a region

Exit
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Figure 3-1), users will take the first step in defining the Study Region. In Figure 3-1, Create a new
region has been selected. Click OK to activate the window shown in Figure 3-2

Create New Region

Welcome to the Create New
Region Wizard

This wizard will guide you through the steps needed to create a

new study region.

To continue, click Next.

Next > ] Cancel

Figure 3-2.

Click Next to open the window shown in Figure 3-3 and name the regjon in the first box (up to 18
characters, no spaces, and must not begin with a number). Enter a description of the region in the
second box. This is especially helpful if multiple users will be accessing this region in the future. Click
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Next, which will open the window shown in

Create New Region

Hazard Type
The hazard type controls the type and amount of data that will be aggregated. The hazard type selected affects the
analysis options that will be available.

Your study region can include one or more of the following hazards. Check below the
hazard(s) you are interested in_

| Earthquake
[v Flood
[ Hurricane

[ Tsunami

Notes:
1. Selection of hazards listed above depends upon the hazard modules installed.

2. Once a study region is built with a given hazard(s), it cannot be modified later on, in
other words, you cannot add another hazard to it. Alternatively, you may re-create a
similar region with different hazard(s).

3. If you are creating a Near Source only Tsunami region, please also check Earthquake
checkbox.

X

H)

< Back | Next > Cancel ‘

Figure 3-4. Select Flood from the Hazard Types and click Next. This selection cannot be altered later.
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Hazus Startup

KE » FLOOD

S

HURRICAME = T

"
E
o
=T
(]
=

Welcome to Hazus.

In order to use Hazus, you need to define the study
region to be used in the analysis.

Flease select the desired option below, and a wizard
will guide you through the necessary steps.

® Create a new region

(" Open aregion

(" Delete a region

(" Duplicate a region

(" Export/Backup a region

(" Import aregion

Exit

Figure 3-1 Select Create a New Region in Hazus Startup

Create New Region

Welcome to the Create New
Region Wizard

This wizard will guide you through the steps needed to create a
new study region.

To continue, click Next.

Next > ] Cancel

Figure 3-2 Select Create New Region in Wizard
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Create New Region X
Study Region Name
Each study region needs to be identified with a unique name.

Enter a name below which uniquely identifies your region. The name can be up to 18
characters long and cannot contain any spaces. Please note that your study region
name will appear in the footers of all Hazus reports and cannot be easily changed later.

ExampleRegion

Region description (optional):

This is an example of a region|

< Back | Next > Cancel

Figure 3-3 Create a Study Region Name

Create New Region X

Hazard Type
The hazard type controls the type and amount of data that will be aggregated. The hazard type selected affects the
analysis options that will be available.

Your study region can include one or more of the following hazards. Check below the
hazard(s) you are interested in.

[ Earthquake
[v Flood
[ Hurricane

[ Tsunami

Notes:
1. Selection of hazards listed above depends upon the hazard modules installed.

2. Once a study region is built with a given hazard(s), it cannot be modified later on, in
ather words, you cannot add another hazard to it. Alternatively, you may recreate a
similar region with different hazard(s).

3. If you are creating a Near Source only Tsunami region, please also check Earthquake
checkbox.

< Back Next > | Cancel

Figure 3-4 Select Hazard Type for New Region
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From the window shown in Figure 3-5, select one of the six aggregation levels. Click Next to open the
window shown in Figure 3-6. Select the state(s) covered by the Study Region. To select multiple
states, hold the Shift key while making selections. Click Next to open the window in Figure 3-7. Select
the county or counties covered by the Study Region.

Click Next to open the Region Wizard Completion notification shown in Figure 3-8

X

Create New Region
Completing the Create New
Region Wizard

You have successfully completed the Create New Region
Wizard.

To close this wizard and start the region creation, click
Finish. Hazus will begin creating your region. This process
may take up from a few minutes to an hour depending on
the region size and the hazards selected.

HURRICANE » TSUMAMI » EARTHQUAKE » FLOOD,

........................

< Back | Finish | Cancel ‘

Figure 3-8. Click Finish. The status window shown in Figure 3-9 will appear. It may take several
minutes for the region to be created. Once the process is finished, click OK to acknowledge the Study
Region has successfully been created (Figure 3-10). The Start Menu will reappear.
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Create New Region

Aggregation Level

The aggregation level indicates the geographic area for the risk analysis and loss calculations.

H)

You can define your study region at one of the geographical levels listed below. This is
called the aggregation level. For the flood model, it is recommended to choose a study
at the county level or smaller. Please select the level for your study region below.

(" State
® County
(" Census tract
(" Census block

" Community (NFIP)

(" Watershed

< Back | Mext > | Cancel

Figure 3-5 Select Desired Aggregation Level

Create New Region

State Selection
The state selection narrows down the location of the region to be created to specific state(s).

®@

Please select the state(s) for the study region you want to create.

States (1 selected):

Nevada (NV) ~
New Hampshire (NH)

New Jersey (NJ)

New Mexico (NM)

New York (N

North Dakota (ND)

Northern Mariana Islands(TS Only) (b
Ohio (OH)

Oklahoma (OK)

Oregon (OR)

Pennsylvania (PA)
Puerto Rico (PR) v Show map |

< Back | Next > |

Cancel
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Figure 3-6 Select Appropriate State for the New Region

Create New Region

County Selection

States:

North Carolina (NC

The county selection defines the county or counties within previously selected state(s), to include in the study region.

Please select the county or counties for the study region you want to create.

Counties (1 selected):

Alamance ~ Select all counties
Alexander
Alleghany
Anson Deselect all counties
Ashe
Avery
Beaufort
Bertie Show map
Bladen
Buncombe
Rirke ~
Total: 1 =

X

@

< Back Next > Cancel
Figure 3-7 Select County for the New Region
Create New Region X
mg Completing the Create New
Region Wizard
: You have successfully completed the Create New Region
N . Wizard.
< To close this wizard and start the region creation, click
Fimish. Hazus will begin creating your region. This process
& may take up from a few minutes to an hour depending on
= the region size and the hazards selected.
s assssmnst. ok sescton, €5 FEMA
< Back | Finish | Cancel

Page 3-8




Hazus Flood Model User Guidance

Figure 3-8 Create New Region Wizard Completion

Processing Status

Aggregate Boundaries

Copy Census Blocks

Figure 3-9 Create New Region Progress

X

Hazus

Region aggregation successful.
Please use "Open a region" option to open the region.

oK

Figure 3-10 Create New Region Acknowledgement

3.3 Open Region
The Open a region option will not be available in the Hazus Startup screen in Figure 3-11 until a
region has been created or imported. Select Open a region and click OK. The Open Region Wizard
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will appear (Figure 3-12). Click Next. An Open Region list will appear (Figure 3-13

Open Region X
Select Region
The study region selection sets the region that will be opened.

Select the study region you want to open from the list of study regions you have created

so far.
Region Description Created
Brunswick_NC Brunswick NC flood 11/3/20271 2:40:0(
< >

< Back | Next = | Cancel

Figure 3-13). Select which region should be opened. Click Next. Verify that the region name and
hazard type are correct (Figure 3-14). Click Finish. Clicking Finish will launch ArcMap. Refer to the
additional Hazus User Manuals for guidance.
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Hazus Startup

-
o
(=1
=]
(o
.

S
¢
L

ke
=
EE

ik srasmant, ik ntucion. (62 FEMA

Welcome to Hazus.

In order to use Hazus, vou need to define the study

region 1o be used in the analysis.

Flease select the desired option below, and a wizard

will quide you through the necessary steps.

(" Create a new region

(" Delete a region
(" Duplicate a region
(" Export/Backup a region

" Impart a region

Exit

| & |

Figure 3-11 Select Open a Region

...........

Open Region

* FLOOD

S

HURRICANE = T

UNAMI » EARTHQU

Welcome to the Open Region
Wizard

This wizard will help you select a study region from among the

regions you have already created.

To continue, click Next.

| Next > | Cancel
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Figure 3-12 Open Region Wizard

Open Region

Select Region

so far.

The study region selection sets the region that will be opened.

H)

Select the study region you want to open from the list of study regions you have created

Region

Brunswick_NC

Created
11/3/2021 2:40:04

Description
Brunswick NC flood

< >
< Back | Next > | Cancel
Figure 3-13 Select the Region to Open
Open Region X
m Completing the Open Region
: Wizard
N : You have successfully completed the Open Region Wizard.
You have selected to open the region:
< T Brunswick_NC
: The hazard you selected was:
v hesemmes ok s, (29 FEMA Flood
To close this wizard, click Finish.
< Back — Cancel

Figure 3-14 Open Region Wizard Completion
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3.4 Delete Region

The Delete a region option will not be available in the Hazus Startup screen in Figure 3-15 until a
region has been created or imported. Select Delete a region and click OK. A Delete Region list will
appear (Figure 3-16). Select a region from the list and click Delete to permanently delete the region.
The Delete Region Confirmation window will appear (Figure 3-17). Click Yes to delete or No to return
to the Delete Region window (Figure 3-16). Click Done to close the window and return to the Hazus
Startup screen.

Hazus Startup X

‘Welcome to Hazus

In order to use Hazus. you need to define the study
region to be used inthe analysis.

Please select the desired option below, and a wizard
will guide you through the necessary steps

(" Create a new region

(=]
=
Q
3
'S
4
=2
(=]
==
z
[+
T
(1)
=
5
w
2

" Open aregion

HURRICANE

@ Delete a region

" Duplicate aregion
(" Export/Backup a region

" Import a region

Exit

il

Figure 3-15 Select Delete a Region
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Delete Region X

Below is alist of the study regions you have created so far. Select the region you want to delste.
Right-click mouse for more options.

Description Created

# regions listed: 1 Delete Cone

Figure 3-16 Select Region to Delete

Warning

I--""_"“--I You've selected to delete study region: [Brunswick_NC]. Once a
b = region is deleted, it cannot be retrieved back. Are you sure you
want to proceed?

Yes No

Figure 3-17 Delete Region Confirmation

3.5 Duplicate Region

The Duplicate a region option will not be available in the Hazus Startup screen in Figure 3-18 until a
region has been created or imported. Select Duplicate a region and click OK. A Duplicate Region list
will appear (Figure 3-19). Select the region from the list to be duplicated. Click Duplicate. A duplicate
region confirmation window will appear (Figure 3-20). Click Yes to duplicate or No to return to the
Hazus Startup screen (Figure 3-18). The Duplicate Region Name dialog will appear (Figure 3-21).
Enter the name of the new region (18 characters and no spaces) and a brief description. Click OK. A
progress bar will appear (Figure 3-22). It will close once the region has been successfully duplicated.
This may take several minutes depending on the size of the region and the speed of the computer. A
duplicate region completion notification (Figure 3-23) will appear to notify the user that the region
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has been duplicated. Click OK to return to the Duplicate Region list (Figure 3-19

Duplicate Region X

Below is a list of the study regions you have created so far. Select the region you want to duplicate. and
then click 'Duplicate’ button below

Created

Description

Region:  Brunswick_NC

# regions listed: 1 Duplicate Done

Figure 3-19). Click Done to return to the Hazus Startup screen.

Hazus Startup et

Welcome to Hazus.

(=)
o
[=}
-
'S

‘é
>4
T

In order to use Hazus. you need 1o define the study
region to be used in the analysis.

Please select the desired option below, and a wizard
will guide you through the necessary steps.

(" Create a new region
" Open aregion

= (" Delete aregion

e @FEMA * Duplicate aregion
(" Export/Backup a region

" Import a region

Exit

Figure 3-18 Select Duplicate a Region
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Duplicate Region X

Below is a list of the study regions you have created so far. Select the region you want to duplicate. and
then click 'Duplicate’ button below

Description Created

Region:  Brunswick_NC

# regions listed: 1

Duplicate Done

Figure 3-19 Select a Region to Duplicate

Warning

| You selected to duplicate region [Brunswick_NC] Proceed?

Yes No

Figure 3-20 Duplicate Region Confirmation

Duplicate Region Name

X
Name duplicated region as:

IDupIica’re Cancel

Description (optional):

IBrunswiok NC duplicate regoin|

Figure 3-21 Provide Duplicate Region Name
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Hazus =
Loading duplicate region Duplicate 83% ....

Figure 3-22 Duplicate Region Progress

Hazus K

Region duplicate completed.

oK

Figure 3-23 Duplicate Region Completed
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3.6 Export/Backup a Region

The Export/Backup a region option will not be available in the Hazus Startup screen in

Hazus Startup X

Welcome 1o Hazus.

In order to use Hazus, you need to define the study
region to be used in the analysis.

Flease select the desired option below, and a wizard
will guide you through the necessary steps.

(" Create a new region
(" Open aregion

(" Delete aregion

a
[
Q
-l
'S
Ed
=
(=
I
E
[+ 4
=4
(1)
=
2
'l_.
Lt
Ed
]
[
&
= |
=
- € rEMa

(" Duplicate a region
@ Export/Backup a region

(™ Import a region

Exit

Figure 3-24 until a region has been created or imported. Select Export/Backup a region and click OK.
An Export/Backup Regijon list will appear (Figure 3-25). Select the region to export or backup from
the list. Click Browse to select a file location to save the export/backup. Click Export/Backup. A
progress bar (Figure 3-26) will appear. It will close once the region has been successfully exported.
This may take several minutes depending on the size of the region and the speed of the computer.
An Export/Backup Region Completion notification (Figure 3-27) will appear once the export has
completed. Click OK.
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Hazus Startup X

YWelcome to Hazus.

In order to use Hazus. you need to define the study
region to be used in the analysis.

KE = FLOOD

Please select the desired option below, and a wizard
will guide you through the necessary steps.

o
=
&
I
=
il
=
=

(" Create a new region

o
S

(" Open a region

HURRICAMNE = T:

(" Delete aregion

P o K Mkt @rsr-.-m - Duplicate a region

® Export/Backup aregion

" Import a region

il

Exit

Figure 3-24 Select Export/Backup a Region
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Export/Backup Region et

Below is a list of the study regions you have created so far. Select the region you want to
exportfbackup. then specify the name of the export file by clicking 'Browse', and finally click
'Export/Backup' button to start the export.

Created

Region:  Brunswick_NC

Export file name: Browse |

Export/Backup | Close |

Figure 3-25 Select a Region to Export or Backup

Hazus n

Exporting region Brunswick_NC 1% ....

Figure 3-26 Export/Backup Region Progress

Hazus X

Region export completed.

oK

Figure 3-27 Export/Backup Region Completed
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3.7 Import a Region

Select Import a region from the Hazus Startup screen in Figure 3-28 and click OK. Check the latest
Hazus version release notes for limitations on importing from previous versions. Hazus is backwards
compatible by one version. A file explorer will open. Select an export Hazus Packaged Regjon (.hpr)
file. In the Imported Region Name dialog (Figure 3-29), enter the name of the region (18 characters
and no spaces) and a brief description. The name must be different than the imported .hpr file
name. Click OK. A progress bar (Figure 3-30) will appear. It will close once the region has been
successfully imported. This may take several minutes depending on the size of the region and the
speed of the computer. A Region Import Completion notification will appear once the export has
completed. Click OK.

Hazus Startup X

Welcome 1o Hazus.

In order to use Hazus, you need to define the study
region to be used in the analysis.

Flease select the desired option below, and a wizard
will guide you through the necessary steps.

o
<
[=1
=
i
.
E
=
(=3
=L
=
[
=
u
z
z

(" Create a new region

28
S

" Open aregian

HURRICANE = T¢

(" Delete aregion

(" Duplicate a region
(" Export/Backup a region

® |mport a region

Exit

il

Figure 3-28 Select Import a Region
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Imported Region Name X

Narne imported region as:
IBrunswiCk_Import Cancel |

Description {optional):

|Brun5wick NG impart examp|e|

Figure 3-29 Provide the Name for the Imported Region

Hazus '

Validating export file ...

Figure 3-30 Import Region Progress

Region import completed.

o |

Figure 3-31 Region Import Completed
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Section 4. Getting Started Part 2: Basic Hazus Analysis

The Flood Model allows practitioners to estimate the economic and social losses from flood events.
The information provided by the model will help state and local officials evaluate, plan for, and
mitigate the effects of flooding. The Flood Model provides practitioners and policy makers with a tool
to help reduce flood damage, reduce disaster payments, and make wise use of the nation’s
emergency management resources.

Section 4 explains how to run a basic riverine Flood Level 1 GBS Analysis for a single flood event with
flooding modeled by Hazus. This analysis makes use of Census blocks that have been
dasymetrically-adjusted based on land cover data, meaning that areas with land cover types that
typically do not contain structures have been removed from the Census block boundaries. Refer to
the Hazus Flood Model Technical Manual (FEMA, 2024) for information on dasymetric Census blocks
and the methodology used by Hazus to produce the flood depth raster.

Launch Hazus and select Open a Region on the Hazus Startup screen (Figure 4-1). Information on
the other options is provided in Section 3. Click OK, which will open the Welcome to the Open Regjon
Wizard (Figure 4-2). Select Next.

Hazus Startup X

“Welcome to Hazus.

In order to use Hazus. you need 1o define the study
region to be used in the analysis.

Please select the desired option below, and a wizard
will guide you through the necessary steps.

(" Create a new region

fa}
3
-
re
-
=
=
[=4
£
=
o
=+
[}
=
s
w
B

HURRICANE

(" Delete aregion

(" Duplicate a region
(" Export/Backup a region

" Import a region

Exit

Figure 4-1 Open a Region
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Open Region

Welcome to the Open Region
Wizard

This wizard will help you select a study region from among the
regions you have already created.

To continue, click Next.

HURRICANE = TSUNAMI = EARTHQUAKE = FLOOD

...............

Next > | Cancel

Figure 4-2 Open Region Wizard

In the Select Region window (Figure 4-3), select the desired Study Region. Click Next, which will open
the Completing the Region Review Wizard (Figure 4-4). Here, the user can review the selected region
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and hazard. Select Finish. An ArcMap window showing the Study Region will open (Figure 4-5

° Hazus: Flood - MontgomeryCo_VA O X
File Edit View Inventory Hazard Analysis Results Bookmarks Insert Selection Geoprocessing Customize Windows
;7 OES B x|o &b~ |[1450978 Vi EEEBD Pz
QA i« -0 KO/ B2 MDD D
f Content e ~ @
e
g @ @ = "‘\ g
S & Layers W -
=l Census Blocks . =
[] Census Blocks i} \\ 1?
[ENQ Census Tracts A =
[] Census Tracts /5\ 3
= @ Study Region Boundary —
[ Study Region Boundar
—
/"'-f
L@\U‘W\S\'
v
< >jaja| & un < >
-80.578 37.186 Decimal Degrees
Figure 4-5).
Open Region
Select Region
The study region selection sets the region that will be opened.

Select the study region you want to open from the list of study regions you have created
so far.

Region Description Created

MontgomeryCo_VA : azus Level 1 Riverine flood analysis

< Back | Next > | Cancel
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Figure 4-3 Select the Region to Open

Open Region

Completing the Open Region
Wizard

You have successfully completed the Open Region Wizard.

You have selected to open the region:

MontgomeryCo_WVA

The hazard you selected was:

Risk Assessrant. Risk Anduction. IMA F\E}Od

To close this wizard, click Finish.

< Back Finish | Cancel

Figure 4-4 Confirm the Selected Region
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Q Hazus: Flood - MontgomeryCo_VA = O X
File Edit View Inventory Hazard Analysis Results Bookmarks |nset Selection Geoprocessing Customize Windows Help
FOES B x b - |[1450,978 Vi EER@O F g
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Figure 4-5 Example - Flood Model in ArcMap

To choose a riverine flood hazard type, open the Hazard drop-down menu and select Flood Hazard

Type (Figure 4-6).

b

Hazard \ Analysis  Results Bookmarks Insert Selecti

| Flood Hazard Type... |—v‘ ot G
U i Flood Hazard Type....
Select the flood hazard type
Scenario
Riverine »
Coastal » o

Figure 4-6 Select Flood Hazard Type in Hazard Menu

Selecting Flood Hazard Type will open the Flood Hazard Type window (Figure 4-7). Select Riverine

only and click OK.
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Flood Hazard Type X

Study reqion flood hazard type
(®) Riverine only
() Coastal only

() Riverine and coastal

Combined wind and flood

Storm surge

Cancel

Figure 4-7 Select Flood Hazard Type

To obtain the digital elevation data required for this analysis, open the Hazard drop-down menu, and
select User Data (Figure 4-8). Please note, it is recommended that users import user-defined flood
hazard depth grids if available. The Hazus hydrology and hydraulic methodology here should only be
used if user-defined data are not available. Please refer to Hazus Flood Level 2 Standard Operating
Procedure (FEMA, 2018) published in the FEMA Library for more information.

Hazard | Analysis Results Bookm
Flood Hazard Type... I

[ User Data

User Data l
Scenario User Data
Riverine »

Coastal »

Figure 4-8 Select User Data in Hazard Menu

Selecting User Data will open the User Data window (Figure 4-9). Click Determine required DEM
extent.
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User Data
DEM  Fm Depth Grid HEC-RAS
DEM metadata
Vertical units Meters v
Vertical datum NAVDE2 v
Other vertical datum
Select DEM dataset(s)
Browse...
Determine required DEM extent
Progress
OK Cancel

Figure 4-9 Select Determine Required DEM Extent

After a short pause, the DEM Extent window will appear (Figure 4-10). Click Download required DEM
for Hazus to obtain all the required digital elevation model (DEM) files and save them within the
Hazus Study Region folder.
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53 DEM Extent — X
Your analysis will require a DEM bounded by these coordinates in decimal degrees

MNorthmost Latitude

WestmostLongitude N EastmostLongitude
w Southmost Latitude w
N

Select NED Resolution: | 1 Arc-Second v
Click link to download DEM file.

| NED Dataset esolution Size MB Last Updated A
|USGS_1_n37w080_202... | 1Arc-S...|56.50 | 2021-03-18T02:39:58.000Z |
|USGS_1_n38w080_202... | 1Arc-S... |56.25 |2021-03-18702:40:39.0002 |
|USGS_1_n39w080_202.. |1Arc-S... |54.82 |2021-02-05T02:17:28.0002 |
|USGS_1_n37w081_202.. |1Arc-S... |55.53 | 2021-03-18702:40:05.000Z |
|USGS_1_n36w081_202... |1Arc-S... |55.20 |2021-03-18T02:40:45.000Z |

LUSGS 1 n39w081 202 Mﬂﬂzmm_

Please note: Obtaining the DEM data through Hazus requires an internet connection.
For a manual workaround, please contact the Hazus Help Desk at FEMA-Hazus-
Support@fema.dhs.gov.

Download DBEM | Download required DBEM

Close

Figure 4-10 Select Download required DEM

Hazus will take several minutes to download all the DEM files. When the process has completed, a
notification window will appear (Figure 4-11) to indicate the files have been downloaded and saved.
Click OK.

Save DEM X

Downloaded and saved 9 required DEM tiles at:
C:\HazusData\HazardInput\DEM\MontgomeryCo_VA

Figure 4-11 DEM Downloaded and Saved
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A popup window (Figure 4-12) will ask the user whether to automatically load the DEM data into the
User Data window. Click Yes.

Automatically Loading DEM

Would you like to incorporate the 9-tile DEM data that was
just downloaded to:
C:\HazusData\HazardInput\DEM\MontgomeryCo_VA

as MontgomeryCo_VA Study Region DEM?

Yes No

Figure 4-12 Automatically Load DEM

Hazus will load the file paths for all the DEM files into the User Data window (Figure 4-13). Click OK
to complete importing the DEM files. Click Yes (not shown) on the next popup window to proceed
with DEM analysis.

User Data

DEM FIT Depth Grid HEC-RAS
DEM metadata

Vertical units e o
Vertical datum NAVDEE

Other vertical datum

Select DEM dataset(s)

C:\HazusData\Hazardinput\DEM\MontgomeryCo_VAWSGS_1_n37w080 A '
C\HazusData\Hazardinput\DEM\MontgomeryCo_VAWSGS_1_n38w080
C:\HazusData\Hazardinput\DEM\MontgomeryCo_WVAWSGS_1_n39w080
C:\HazusData\Hazardinput\DEM\MontgomeryCo_WVAWSGS_1_n37w081
C:\HazusData\Hazardinput\DEM\MontgomeryCo_WVAWSGS_1_n38w081
C:\HazusData\Hazardinout\DEM\MontaomervCo VAWSGS 1 n39w081 ¥
< >

Browse...

Determine required DEM extent

Completed calculating DEM coordinates 36.8670268900555, -

80.9961054168787, 37.5176589109032, -79.8816382855074
OK Cancel

Figure 4-13 Import DEM Files into Hazus
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A progress bar (Figure 4-14) will appear as Hazus imports and merges all the individual files into a
single DEM for the Study Region. This may take several minutes depending on the size of the Study
Region. A notification (Figure 4-15) will appear once the DEM import is completed. Click OK.

. Processing Status

Creating study region DEM

Merging and clipping

Figure 4-14 DEM Import Progress

Run Time

Successfully constructed the study region DEM.
Total time: Howurs: 0, Mins:02, Secs:20

Figure 4-15 DEM Import Completed

The Hazus Flood Model mapping should look like Figure 4-16

° Hazus: Flood - MontgomeryCo_VA
File Edit View Inventory Hazard Analysis Results Bookmarks Insert Selection Geoprocessing Customize Windows Help

FOES LB X 0o b 00 v EEEEE
Q@ i« E-E k@ 7/ BR2NADE DR
Table Of Contents 7 x “rL ] :

88
= & layers A~
= @ RegionDEM
Value
| High:4358.32

-

“Low: 884,197

‘uoxeas@\ﬁomeoﬂ‘

= [ Census Blocks
[] Census Blocks
= Census Tracts
[] Census Tracts
=] Hillshade

Value
High: 254

Low:0
=] Study Region Boundai

-StudyRegionBounv . g J S
< > |jmaien < >

-80.453 37.137 Decimal Degrees

Figure 4-16 after the DEM import.
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° Hazus: Flood - MontgomeryCo_VA

7 OES

R QEI@ 2522 + = |-

Table Of Contents X

EEEX M=

= & layers A~
= @ RegionDEM

Value
- High : 4358.32

-

“Low: 884,197

= [ Census Blocks
[ Census Blocks
= Census Tracts
[] Census Tracts
=] Hillshade

Value
High: 254

Low: 0

=] Study Region Boundai
[ Study Region Boun o

< >

K@ BIZNAARIT

jEaien <
-80.453 37.137 Decimal Degrees

File Edit View Inventory Hazard Analysis Results Bookmarks Insert Selection Geoprocessing Customize Windows Help

iBx|0cS-[Hm | E@EEO

‘uoxeas@\ﬁomeoﬂ‘

Figure 4-16 Example - Flood Model after DEM Import

To create the stream network, open the Hazard drop-down menu and select Develop Stream

Network (Figure 4-17).

Hazard | Analysis Results Bookmarks Insert Selectio

Flood Hazard Type... :‘ . s
User Data @ | ™

[ Develop Stream Network... A :E.i" -
Scenario Develop Stream Network...
Riverine Set Stream Drainage Area
Coastal

Figure 4-17 Select Develop Stream Network in Hazard Menu

The Develop Stream Network window (Figure 4-18) will appear. Use the default value of 10.0 square
miles that appears in the drainage area field and click OK. Click Yes (not shown) on the next popup

window to proceed with developing the stream network.
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Develop Stream Network X
Input a stream drainage area for the study region.

When you select OK, the stream network will be
created. This process may take some time.

Input stream drainage area :
(affects stream density) Square miles

(0.25 - 400 square miles)

Cancel

Figure 4-18 Enter Drainage Area for Develop Stream Network

A progress bar (Figure 4-19) will appear as Hazus performs the GIS analysis to develop the stream
network. This may take several minutes to an hour depending on the size of the Study Region. A
notification (Figure 4-20) will appear once the stream network has been completed. Click OK.

& Processing Status X

Building stream network

Collecting default watersheds

Figure 4-19 Develop Stream Network Progress

Run Time X

Successfully delineated reaches.
Total time: Hours: 0, Mins:03, Secs:21

Figure 4-20 Develop Stream Network Completed
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The Hazus Flood Model mapping should look like Figure 4-21

o Hazus: Flood - MontgomeryCo_VA

yeds
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Figure 4-21 after developing the stream network.
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Figure 4-21 Example - Flood Model after Developing Stream Network
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To create a scenario within the Flood Model, open the Hazard drop-down menu and select Scenario
and New (Figure 4-22).

Hazard | Analysis Results Bookmarks Insert Selection Geoprocessing

Flood Hazard Type... v| s m o gpq -
User Data n TE_J 3 _ -
Develop Stream Network... __ — .

Scenario V[ New..
Riverine »

Coastal »

Figure 4-22 Select Scenario and New in Hazard Menu

The Create New Scenario window (Figure 4-23) will appear. Enter a unique name for the scenario
and a brief description. Click OK.

Create New Scenario X

Enter a unique name for the New Scenario:

11004

Description

Cancel

Figure 4-23 Provide Name for New Scenario

The New Scenario window (Figure 4-24) will appear. To select the streams to add to the scenario
from the Flood Model mapping, click the + button to the right of Add to selection. This will activate
the screen cursor on the mapping screen in ArcMap, which allows the user to select all the streams
in the region.
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MNew Scenario
Select map features to be included in

thescenario. Asingle scenario may
contain morethan one objecttype.

Map layer type

(® Riverreaches

User-defined depth grids

Map layer selection
Add o selection [+ ]

Remove from selection E

Clear selection >
Saveselection

Figure 4-24 Select Add to Selection for River Reaches

Once the streams have been selected, the Flood Model will show the streams in a different color as
shown in Figure 4-25.

RQAMOI
Table Of Contents

EEELE

File Edit View Inventory Hazard Analysis

I'OH% ‘.‘:@EX v @-I11450.973

& =5
3 x

= & layers
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[ RegionDEM
Value
- High: 4358.32
-

“Low: 884.197

= Census Blocks
[ Census Blocks
B Census Tracts
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=] Hillshade
Value

High: 254
Low: 0
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° Hazus: Flood - MontgomeryCo_VA (100yr)

Results  Bookmarks

Insert  Selection Geoprocessing Customize Windows Help
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Sl

-0 8@ @

Number of features selected: 32
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-80,247 37.08 Decimal Degrees

O X

‘umeasﬂ]] Gojeje ﬂ]

Figure 4-25 Example - Flood Model after Stream Selection
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To complete the stream selection, go back to the New Scenario window and click on the button with
the disk graphic to the right of Save selection (Figure 4-26). The OK button will become active. Click

OK to complete the stream selection.

New Scenario

Select map features to be included in
thescenario. Asinglescenario may
contain morethan one objecttype.

Map layer type

(®) Riverreaches

Map layer selection
Add to selection *

Removefromselection | =

Clear selection X
Saveselection =B
OK €

Figure 4-26 Select Save Selection to Finalize Selected River Reaches

If the stream selection was performed correctly, the Flood Model should look like Figure 4-27
- O X

o Hazus: Flood - MontgomeryCo_VA (100yr)
File Edit View Inventory Hazard Analysis Results Bookmarks Insert Selection Geoprocessing Customize Windows Help

FQES LABXI 0o b [BH | EEEEOIN

RAMQxii &= W-O K@ 7 BZMNDE T RE
Table Of Contents +x L vl { ]
Heos = St
= = layers " E
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P ?
= O Reaches 2
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Value
] High : 4358.32

“Low: 884.197
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[ Census Blocks
= M Census Tracts
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Value
High : 254

> jaie|&n <

-80.536 37.048 Decimal Degrees

Figure 4-27. All selected streams are saved to a new data layer called Chosen Reaches and are

shown in red.
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@ Hazus: Flood - MontgomeryCo_VA (100yr) - O X
File Edit View Inventory Hazard Analysis Results Bookmarks Insert Selection Geoprocessing Customize Windows Help

FOES LABXI9C & [(EE | EEEEDIR
B QRii & -

KO LASS TR
Table Of Contents R P s g ; ! a
308 g
= = layers (o §
2 ChosenReaches ‘%
-— @
= @ Reaches S
&l

= M RegionDEM
Value
| High:4358.32

“Low: 884.197

[Z] Census Blocks
[] Census Blocks
2 Census Tracts
[] Census Tracts
=] Hillshade

Value
High: 254

I v

< > |jaia|=n

-80.536 37.048 Decimal Degrees

Figure 4-27 Example - Flood Model after Stream Reaches Chosen for a Scenario

To conduct the hydrologic analysis, open the Hazard drop-down menu and select Hydrology (Figure

4-28).

Hazard I Analysis Results Bookmarks Insert Selection Geoproce

i Flood Hazard Type... v|sZ m % |
User Data — @
Develop Stream Network...

Scenario
| Riverine
Coastal

Figure 4-28 Select Riverine and Hydrology in Hazard Menu

A notification window (Figure 4-29) will warn the user that raster processing cannot be canceled.

Click Yes.

A progress bar (Figure 4-30) will appear as Hazus performs the hydrologic analysis. This may take
several minutes to several hours depending on the size of the Study Region and the number of
selected streams. A notification (Figure 4-31) will appear once the hydrologic analysis has been

completed. Click OK.
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Process

To ensure proper operation, canceling is not allowed.

o The proceeding analysis requires raster processing.
Continue?

] w

Figure 4-29 Select Yes to Start Hydrologic Analysis

. Processing Status

Performing hydrologic analyses

Processing reach watersheds

Figure 4-30 Hydrologic Analysis Progress

X

Run Time

Successfully completed hydrologic analyses.
Total time: Hours: 0, Mins:22, Secs:36

Figure 4-31 Hydrologic Analysis Completed

If the hydrologic analysis was performed correctly, the Flood Model should look like Figure 4-32.
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Table Of Contents
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o Hazus: Flood - MontgomeryCo_VA (100yr)
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e £ layers

= [ Reaches
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Value
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"Low : 884.197
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To conduct the floodplain analysis, open the Hazard drop-down menu and select Delineate

Figure 4-32 Example - Flood Model after Hydrologic Analysis

Floodplain (Figure 4-33).

Hazard l Analysis Results Bookmarks Insert Selection Geoprocessing Custom

Flood Hazard Type... :1 - m % — }u .
User Data —y—
Develop Stream Network... M ST :
Scenario "
Riverine »|  Hydrology L7y
Coastal " - 3
i s Delineate Floodplain

Delineate Floodplain

Figure 4-33 Select Riverine and Delineate Floodplain in Hazard Menu

The Riverine Hydraulic Analysis window (Figure 4-34) will open. Select Single Return Period for

Analysis type. Keep the default Output cell size. Finally, for each stream keep the default return
period of 100 years and the default Manning’s roughness coefficient n-value shown in the third
column of the table. Click OK.
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. Riverine Hydraulic Analysis X
Analysis type: Single Return Period v
Output cell size: 24.7583566822159 ~
River reaches

Reach ID | Retumn Period [prs) | n-value A
100 0.160
15 100 0.160
16 100 0.160
17 100 0.160
18 100 0.160
19 100 0.160
20 100 0.160
21 100 0.160
22 100 0.160
23 100 0.160
24 100 0.033
25 100 0.160
26 100 0.160
27 100 0.160

28 100 nn3z v

l OK ‘ I Cancel I

Figure 4-34 Delineate Floodplain for a Single Return Period

A progress bar (Figure 4-35) will appear as Hazus performs the hydraulic analysis needed to

delineate the floodplain for each selected stream. This may take several minutes to several hours
depending on the size of the Study Region and the number of selected streams. A notification (Figure
4-36) will appear once the floodplain analysis has been completed. Click OK.

Processing Status - Reach 1 of 32

Current progress for reach ID 6 (RP100)

Building the flow centerine...

Figure 4-35 Delineate Floodplain Progress
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Run Time

Successfully computed riverine flood hazard.
Total time: Hours: 2, Mins:31, Secs:55

Figure 4-36 Delineate Floodplain Completed

If the floodplain analysis was performed correctly, the Flood Model should look like Figure 4-37.

° Hazus: Flood - MontgomeryCo_VA (100yr) - O X
Eile Edit View Inventory Hazard Analysis Results Bookmarks [nsert Selection Geoprocessing Customize Windows Help

FOES LARX P0G MW | BEEBDFg
CROR AN JE-HAR Tl R KO BEZNASS TR

'FbleOfContents 2 x ]
ol O
el E
=3
= = layers A g
= M BoundaryPolygon =
o =)
173
= @ RPD100_r s
Value g
I High : 45.9309 ]
" Low : 0.00012207

=] ChosenReaches

=] Reaches

=] RegionDEM

Value
- High : 4358.32

“Low: 884,197

|mlz1run <

-80.685 37.408 Decimal Degrees

Figure 4-37 Example - Flood Model after Delineate Floodplain

Begin computing losses within the Study Region’s newly delineated floodplains by opening the
Analysis drop-down menu and selecting Run (Figure 4-38).
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Analysis | Results Bookmarks Insert

Damage Functions »
! Restoration Functions >
H Parameters »

Average Annualized Loss

Figure 4-38 Select Run in Analysis Menu

The Analysis Options window (Figure 4-39) will open. Click the + button to the left of General Building
Stock Damage and Loss to expand and view the loss category. Next, click the small open box to the
left of General Building Stock Damage and Loss so that all subcategories are also selected. Click OK.

Analysis Options

B General Building Stock Damage and Loss

E| Building and Content Damage (%)

E| Direct Economic Loss ($) (Bidg, Cont, Inv)
-] Damage Building Count

E| Depreciated Building and Content Loss ($)
#-[C]Essential Faciiities Select All
|:| User Defined Structures
(23] -DTransporlation Systems Deselect All
-] Utiity Systems —
[ ]Vehicles
-] Debris
B D Direct Social Loss

Cancel

C:\ has 109.92 GB free space;

Figure 4-39 Select General Building Stock Damage and Loss from Analysis Options
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A progress bar (Figure 4-40) will appear as Hazus calculates flood losses. This may take several
minutes to several hours depending on the size of the Study Region. A notification (Figure 4-41) will

appear once floodplain losses have been completed. Click OK.

. Processing Status

GBS Damage Analysis process

Started Process

Figure 4-40 Flood Losses Progress

Flood Analysis

Your selected analysis has completed.
Total time: Hours: 0, Mins:07, Secs:28

Figure 4-41 Flood Losses Completed

At this point, the user will have successfully created a Study Region, delineated streams and
floodplains, and calculated losses. For more information on displaying, understanding, and exporting

loss results, see Section 8.
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Section 5. Model Menu: Inventory

The Inventory menu, shown in Figure 5-1, has inventory types and subtypes that allow the estimation
of the amount of exposure and potential damage in the Study Region. Inventory data include basic
information on population, buildings, and facilities obtained from the United States Census and other
national sources. These data can be supplemented with additional user-supplied datasets. The
screenshots in this section show all of the options for the Inventory menu.

Inventory I Hazard Analysis F

General Building Stock  »

Essential Facilities

User Defined Facilities

Transportation Systems

Utility Systems

Demographics

Vehicles

View Classifications >
Figure 5-1 Inventory Menu

5.1 General Building Stock

The first type of inventory is General Building Stock. The subtypes are Square Footage, Building
Count, Valuation Parameters, Dollar Exposure, Depreciation Parameters, Depreciated Exposure,
General Occupancy Mapping, and Flood Specific Occupancy Mapping, as shown in Figure 5-2. First
Floor Elevations is temporarily disabled.

Inventory' Hazard Analysis Results Bookmarks Insert Selection Geopi

| General Building Stock  » Square Footage

: Essential Facilities Building Count
User Defined Facilities Valuation Parameters

J Transportation Systems Dollar Exposure (Replacement Value)
Utility Systems Depreciation Parameters

Demographics Depreciated Exposure

Vehicles General Occupancy Mapping

Flood Specific Occupancy Mappin
View Classifications » P i e

45.9300 i

Figure 5-2 Inventory > General Building Stock Menu
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5.1.1 Square Footage

Square Footage, opened through the menu shown in Figure 5-2, allows the user to view the type of
square footage distribution per the Census block, as shown in Figure 5-3.

B Square Footage (thous. sq ft) - O >
Select County to displayw:
|Coos. OR (41011) v|
Show Scenario Cenzus Blocks
CensuzBlock RES1 RESZ RES3A RES3E RES3C RES3D ~
1 [410110001 004033 2580 1499 0.o0 n.on 0.00 n.o
2 410710007 004060 4841 46,77 0.on 0.oa 0.o0 0o
3 410710007 004064 0.0 000 0.on 0.oa 0.00 0o
4 410710001 004065 0.0 0,00 0.on 0.oa 0.00 n.o
3] 410110001 004066 n.on 0.on 0.o0 n.on 0.00 n.o
] 41071100071 004073 0.0 000 0.on 0.oa 0.00 0o
7 4107100071 008002 119.95 27.86 0.on 0.o0 0.00 0o
a 410711000100801 2 0.0 0,00 0.on 0.oa 0.00 n.o
| 41071100071 00501 3 E.BE 1.99 0.on 0.oa 0.o0 0o
10 41071100071 00501 4 163.27 CPRE) 0.on 0.oa 0.00 0o
11 4107110001 005021 0.0 0,00 0.on 0.oa 0.00 n.o
12 410110001 005024 167 1.00 0.o0 0.00 0.00 n.o
13 410710007 005025 0.0 000 0.on 0.oa 0.00 0o
14 A41071100071008027 0.on 0.o0 0.on 0.o0 0.00 0o
15 4107110001 005023 0.0 0,00 0.on 0.oa 0.00 n.o
16 4107110007 005030 0.0 000 0.on 0.oa 0.00 0o
17 4107110007 005031 41,65 9,95 0.on 0.oa 0.00 0o
18 4107110001 008003 11.66 3.93 0.on 0.oa 0.00 n.o
19 4107110001 006071 n.on 0.on 0.o0 0.00 0.00 n.o
20 4107100071 00601 2 0.0 1.00 0.on 0.oa 0.o0 0.0
£ >
Cloze tap Frint

5.1.2 Building Count

Figure 5-3 Square Footage Table

Building Count allows the user to review the building count per Census block By Occupancy and By
Building Type for specific and general occupancies, as shown in Figure 5-4. The user can view and
modify the building count values by only specific occupancy for each Census block.
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87 Building Count — O et
By Occupancy By Building Type
Table Type:
|General Qcocupancy Type | |I:00$, OR (41011) R
Show Scenano Censuz Blocks
CensusBlock, Taotal Residential Commercial Industrial Agniculture Relig
1 410110007 004033 5 4 i 1 i
2 410110007 004060 a3 a5 2 1] 1]
3 410110007 004064 1] 1] i i i
4 410110007 004065 0 0 1] 1] 1]
5 410110007 004086 ] ] 1] 1] 1]
B 410110007 004073 0 0 1] 1] 1]
7 410110007 005002 104 100 2 1 1
o) 410110007005012 1] 1] il il il
& 410110007 005013 3 3 1] 1] 1]
10 410110007 00507 4 4 136 4 1 il
11 410110007 005021 ] ] 1] 1] 1]
12 410110007 005024 3 2 1 i i
13 410110007 005025 ] ] 1] 1] 1]
14 410110007 008027 1] 1] i i i
15 410110007 005023 0 0 1] 1] 1]
16 410110007 005030 ] ] 1] 1] 1]
17 410110007 005031 a0 L] K] 1 1 o
Sqft Factors Cloge tdap Print

Figure 5-4 Building Count (by Occupancy) Table

5.1.3 Valuation Parameters

Valuation Parameters allow the user to review the replacement costs for each occupancy type, as
shown in Figure 5-5. Clicking the Next button on each window will take the user through the following
information windows:

1.

Replacement Cost (based on a specific year)

Location Factors

Single-Family (RES1) Garage Distributions by Census Block
Single-Family (RES1) Garage Replacement Cost
Single-Family (RES1) Basement Distribution by Census Block

Height Distribution (Number of Stories) by Census Block
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B Valuation Parameters - O >
Replacement Cost  RES1 Feplacement Cost
R eplacement Cost
Occupancy H azuzDefinition O coupancyE sample AverageCost

1 [REST lSingle Family Dweling | Refer to hzRES 1R eplCost

2 RESZ b arufactured Housing | M anufactured Housing 5314
3 RES 3 kulti Family Cowelling 1 s Duples 13457
4 RES3A kulti Family Cowelling 1 sm Triples/Guads 118.30
5 RES3C kulti Family Cowelling 1 me 5-3 unitz Za0.13
E RES3D b ulti Farily Cowelling 1 me 10-13 unitz 23263
7 RES3E b ulti Farmily Cowelling 1 lar 20-43 units 217.05
e RES3F b ulti Farmily Cowelling 1 lar 50+ units 133.83
9 RES4 Temp. Lodging Hatel, medium 20453
10 RESH Inztitutional Crarmikary Crarm, medium 22812
11 RESE Murzing Home Murzing horme Z61.45
12 COk1 Fetail Trade Drept Stare, 1 st 133.61
13 COm2 Wholezale Trade wharehouze, medium 135.47
14 COw3 Ferzonal and Repair Ser Garage, Fepair 162.58
15 COkr4 Frofezzionald Technicald Office, Medium 204.43
16 COrE Barksz Barnk. 30388
17 COME Huozpital Hozpital, kedium 33276
13 COMT Medical OfficeClinic Med. Office, medium 27338
19 COmra Entertainment & Fecreat B estaurant 2h3.48
20 COomrAa Theaters M ovie Theatre 21333
21 Cam10 Farking Parking garage 9388
22 MO Heawy Factaory, zmall 162.65
23 INDZ Light wiarehouze, mediuim 13547
24 IND3 Food/Drugz/Chemical: | College Laboratony 23043
25 MO b etalz/tineralz Processi Collegs Laboratany 23043
26 IND5 High Techrology College Labaratary 23043
27 IMNDE Construction Wharehouze, medium 135.47
23 REL1 Church Church 22210
29 AGR1 Agriculture wiarehouze, mediuim 13547
a0 E1NLTY | General Services T Hall, zmall 174.35
1| GO Ermergency Responze | Police Station 284 45
32 EDLA Schoolz/Libranies High Schiool 23773
33 EDLZ Colleges/Univerzsities College Clazsroom 137.10

Mext » Cloze Frint

Figure 5-5 Valuation Parameters Table

5.1.4 Dollar Exposure (Replacement Value):

Dollar Exposure (Figure 5-6) allows the user to review the exposure per Census block By Occupancy
and By Building Type. The user can view and modify the exposure values by only specific occupancy
for each Census block.
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[ Dollar Exposure (thous. dollars)

By Occupancy By Building Type

Table Type:
] General Occupancy Type I l Montgomery, VW [51121) v ] [Building v
[7] Show Scenario Census Blacks

__ CensusBlock TotalE xposure Residential Commercial Industrial ~ Agriculture A

1 511210201001000 18059 18059 1] 0 0

2 |511210201007001 45605 45605 1] 0 0

3 511210201001002 0 0 0 0 0

4 |511210201001003 0 0 0 0 1]

5 |511210201001004 0 0 0 0 0

5 |511210201001005 0 0 0 0 0

7 511210201001006 0 0 0 0 0

a |511210201001007 0 0 0 0 1]

9 |511210201001008 0 0 1] 0 0

10 |511210201001009 0 0 0 0 0

1 |511210201001010 0 0 0 0 0

12 |511210201001011 0 0 0 0 1]

13 |511210201001012 0 0 1] 0 0

14 |511210201001013 0 0 0 0 0

15 |511210201001014 0 0 0 0 0

16 |511210201001015 0 0 1] 0 0
17 511210201001016 0 0 0 0 0 v
< > .

Close Map Print

Figure 5-6 Dollar Exposure Table

5.1.5 Depreciation Parameters

Depreciation Parameters (Figure 5-7) allow the user to review the median year built and median age

of buildings in each Census block.
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B ' Depreciated Parameters - O X
Select County to display:
|Coos, OR [41011) v
CensuzBlock M edianearBuilt b ediandge ~
1 4101100071 007 000 | 1973 43
2 4101100070070 1978 43
3 4107110007007 002 1978 43
4 4107110007 007 003 1973 43
4] 4101100071007 004 1978 43
B 410110007007 005 1978 43
7 41071710007 007 00E 1973 43
a 4107110001 007007 1973 43
93 4101710007007 003 1978 43
10 4107110007007 003 1978 43
11 410110001007 07 0 1973 43
12 4101100071001011 1978 43
13 410110001001012 1978 43
14 41011000100707 3 1973 43
15 4101100010070 4 1973 43
16 4101100010011 5 1978 43
17 1011000100107 6 1978 43
18 410110001007101 7 1973 43
14 4101100010071078 1978 43
20 4101100010071019 1978 43
21 4107110001007 020 1973 43 -
£ >
et > Cloge Prirt

Figure 5-7 Depreciation Parameters Table

5.1.6 Depreciated Exposure

Depreciated Exposure (Figure 5-8) allows the user to review the depreciated exposure By Occupancy
or By Building Type. This data is calculated based on the median building age and a depreciation
curve. The user can view and modify the building depreciated values by only specific occupancy for
each Census block.
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[ Depreciated Exposure s 0 %

By Occupancy By Building Type

Table Type:

|General Occupancy Type  ~ | l Montgomery, Vi, [51121) v | | Building v

[7] Show Scenario Census Blacks

CensusBlock TotalE xposure Residential Commercial Industrial Agriculture A
1 511210202011000 | 0 0 0 0 0
2 511210202011001 58792 52757 3352 294 106
3 511210202011002 1678 483 1195 0 0
4 511210202011003 0 0 0 0 0
5 511210202011004 0 0 0 0 0
5 511210202011005 483 483 0 0 0
7 511210202012000 143 14 110 2 1
a 511210202012001 50907 48090 1708 97 42
9 511210202012002 505 0 505 0 0
10 511210202012003 32 0 32 0 0
11 511210202012004 0 0 0 0 0
12 511210202012005 5513 5464 43 0 0
13 51121020201 2006 279 275 4 0 0
14 511210202013000 43122 43122 0 0 0
15 511210202013001 38328 37461 482 42 15
16 511210202013002 9896 9896 0 0 1]

17 511210202013003 3521 _A 0 0 0 o

< >

Close Map Print

Figure 5-8 Depreciated Exposure Table

5.1.7 General Occupancy Mapping

The General Occupancy Mapping window (Figure 5-9) allows the user to view, copy, edit, and delete
the distribution of general building types in the Study Region. By default, the specific state
distribution is the only scheme available. This data can be viewed and copied but cannot be edited
or deleted. The user can make a copy of the baseline data (by selecting the baseline data and
clicking Copy and entering a new scheme name and description) and edit this data (by clicking the
new copy and clicking Edit).
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General Occupancy Mapping X

States: Counties:

showes
YA Montgomery | Mapping Scheme: WA v Apply

.~ CensusBlock  Mapping Scheme
511210201001000 VA1
511210201001001 VA1
511210201001002 VA1
511210201001003 VA1
511210201001004 VA1
511210201001005 VA1
511210201001006 VA1
511210201001007 VA1
511210201001008 VA1
511210201001008 VA1
511210201001010 VA1

44 e e O o A sihd

W 00~ O & =3

L P
i

[] Show Seenario Census Blocks (® Census Block List () Census TractList (O County List

#  SchemeMName MappingType Date Crested Date Updated Description

1 VAl System Dec132002 Dec132002 VA Default Mapping Scheme [based on low seismic de View

Copy
Edlr

Delete

Cancel

< 0

Figure 5-9 General Occupancy Mapping Schemes

5.1.8 Flood Specific Occupancy Mapping

Flood Specific Occupancy Mapping (Figure 5-10) allows the user to view the default assumptions for
physical building characteristics of structures in any specific occupancy category. There are three
default mapping schemes (Coastal, Great Lakes, and Riverine). All three schemes can be copied,
and the copy versions can be edited to create custom schemes.

For example, to view the Pre- and Post-FIRM (Flood Insurance Rate Map) distributions of foundation
types for all RES1 buildings, select a Mapping Scheme and click View.

Figure 5-11 shows the Flood Building Characteristics Distribution window that will appear. Users can
create custom schemes by clicking the Copy button, which activates the Edit button. Click Edit to
change percentage values in the copy.
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Flood Specific Occupancy Mapping X
States: Counties: Block Type:
1 511210201001000  RiverineDiit 1980 R
2 511210201001001  RiverineDfit 1980 R
3 511210201001002  RiverineDfit 1980 R
4 511210201001003  RiverineDfit 1980 R
5 511210201001004  RiverineDfit 1980 R
& 511210201001005  RiverineDfit 1980 R
7 511210201001006  RiverineDfit 1980 R
g 511210201001007  RiverineDflt 1980 R
9 511210201001008  RiverineDfit 1980 R
10 |511210201001003  RiverineDfit 1980 R
[[] Show Scenario Census Blocks (® CensusBlock List  (O) Census Tract List (O County List

Feb 132003
Nov 4 2021

=

Figure 5-10 Flood-Specific Occupancy Mapping Schemes
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Flood Building Characteristics Distribution X
Scheme Mame: Scheme Description:
CoastalDfit | |
Distribution by: Pre-Firm Foundation Types:
=) Decupancy A # FoundationT ype FoundationDistribution B
M REST - Single Family Dwelling 1 |Pie 34 —
- RES2 -- Manufactured Home 2 Pier 7|
- RES34 - Multi Family Dwelling 3 Solidwall 2|
-~ RES3B -- Multi Family Dwelling 4 |Basement 0
RES3C - Multi Family Dwelling 5  Crawl 20
- RES3D - Multi Family Dwelling 6 Fil 0|
- RES3E - Multi Family Dwelling 7 Slab 37
RES3F - Multi Family Dwelling
RES4 - Temporary Lodging
RESS - Institutional D ormitory
RESE - Nursing Home
COMT - Retail Trade
COM2 - Wholesale Trade Past-Firm Foundation Types:
COM3 - Personal and Repair & # FoundationT ype AZ oneDistribution WZoneDistribution B
- COM4 - Financial/Professional 1 Pie 50 &80 =
- COMS - Banks 2 |Pier 15 15
- COMB - Hospitals 3 Salidwall 2 2
- COM7Y - Medical Offices/Clinic 4 |Basement 0 0
COM8 - Entertainment & Recre §  Crawl 20 1
- COM3 - Theaters 6 Fil 0 0
COM10 - Parking v 7 Slab 13 2
< >
Expand All Collapse Al

Cancel

Figure 5-11 Flood Building Characteristics Distribution

5.1.9 First Floor Elevations Flood-Specific Occupancy Mapping

The First Floor Elevations window (Figure 5-12) allows the user to view the default assumptions for
first floor heights of various foundation types. Editing functionality was temporarily disabled. The
original process required user-defined first floor heights to be assigned by clicking on the User-
defined tab and selecting the Use user-defined values check box, then editing the first-floor height
values for the foundation types and clicking OK. If this functionality is not working, users can contact
the Hazus Help Desk for guidance on using SQL Management Studio to view or modify Finished Floor

Elevations.
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B3 First Floor Height Above Grade *
Default  User-defined
Use default values
FFEID Faundation Mates ~
1 F'ile 7.00| PRE-FIRM construction in census block s with
2 2 Pier F.00| Riverine construction
3 3 Salid wial .00 [e.q., HazardType = 1]
4 4 Bazement/Garden 4.00
B 5 Crawl Space 300
B E Fill 200
7 7|5lab on Grade 1.00
g 2 Pile 8.00/POST-FIRM construction in census blocks with
q 9 Pier B.00| Riverine construction
10 10 Salid wal 8.00 [e.q., HazardType = 1]
11 11 Bazement/Garden 4.00
12 12 Crawl Space 4.00
13 T3 Fill 200
14 14 5lab on Grade 1.00
15 15 Pile 7.00| PRE-FIRM construction in census block s with
1E 16 Pier 5.00| Coastal construction
17 17 Salid wial .00 [e.q., HazardType = 2]
13 18 Bazement/Garden 4.00
19 13 Crawl Space 300
20 200Fill 200
21 21/5lab on Grade 1.00
22 22 Pile 8.00/POST-FIRM construction in census blocks with
23 23 Pier £.00| Coastal construction
ET A Cnlid a2l 00N e n HazardTone — 7 sokizckad be w7
£ >
OK Cancel

5.2 Essential Facilities

Selecting Essential Facilities from the Inventory menu (Figure 5-13) will display the Essential

Figure 5-12 First Floor Elevations

Facilities Inventory table (Figure 5-14), which allows the user to view and map the locations and
characteristics of medical care facilities, emergency centers, and schools.
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Inventory i Hazard Analysis Results Bookmarks |
General Building Stock ~ » v I]

User Defined Facilitie Essential Facilities
Transportation Syste  View/Modify Essential Facility
Utility Systems Data

Demographics
Vehicles

View Classifications >

Figure 5-13 Inventory / Essential Facilities Menu

Essential Fadilities Inventory (thous. dollars)

Medical Care Facilies  Emergency Centers  Schools
Medical Care

Name Address City
LEWISGALE HOSPI13700 SOUTH MAIN € BLACKSBURG
CARILION NEW RIVI 2900 LAMEB CIRCLE CHRISTIANSBURG

| Cose || Msp || Pin

Figure 5-14 Essential Facilities (Medical Care Facilities) Table
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5.3 User-Defined Facilities

Selecting User-Defined Facilities from the Inventory menu (Figure 5-15) will display the User-Defined
Facilities table (Figure 5-16), which allows the user to view and map the locations and characteristics
of any facilities that have been imported by the user.

Invmtotyiﬂuatd Analysis Results Bookmarks In:
General Building Stock  » i |J

Essential Facilities

Transportation Sy
Utility Systems
Demographics
Vehicles

View Classifications

Data

Figure 5-15 Inventory / User-Defined Facilities Menu

User Defined Facilities — O XK

User Defined

Figure 5-16 User-Defined Facilities Table
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5.4 Transportation Systems

Selecting Transportation Systems from the Inventory menu (Figure 5-17) will display the

Transportation Systems Inventory Data table (Figure 5-18), which allows the user to view and map
the location and characteristics of highways, railways light rails, buses, ports, ferries, and airports.

Inventory | Hazard Analysis Results Bookmarks Ins

General Building Stock  »

Essential Facilities . B & n )
User Defined Facilities ( M‘M—f
Transportation Systems | s .
Utility Systems Transportation Systems
Demographics View/Modify Transportation

System Inventory Da

Vehicles

View Classifications

ta

Figure 5-17 Inventory > Transportation Systems Menu

B ' Transportation Systems Inventory (thous. dollars) — *
Highway FRailway  Light Rail  Bus Port Ferry  Airport
Table Type:
Highway Bridges e
D I arne Dwrer BridgeClazs BridgeType Ul
1 [Mamo05z3  |'wWATER BELLE ISLE City or Municipal High HWE23 BO1
2 AO00524 "wWATER CHARLES F State Highway Agenc HWwEBZ28 111
3 AO00525 'COME SOL FLD RO State Highway Agenc HwEBZ8 32
4 MAO0D52E 'COME 5T3/5728 & State Highway Agenc HwEBZ8 3N
5 k4000530 "wWATER CHARLES F State Highway Agenc HwBZ8 HE
5 hA000534 "wWATER CHARLES F City or Municipal High HwB12 303
7 000535 "wWATER CHARLES F City or Municipal High HwEB15 410
] 000536 "wWATER CHARLES F City or Municipal High HwB12 303
g AOO0537 'O0THER wWAREHOL! City or Municipal High Hw/B14 302
10 FA000533 Hw' WATER ST' | City or Municipal High HwB4 302
11 FA000539 'US 1 NB/BOS LOW State Highway sgenc HwEB12 303
12 rA000540 ‘Hwy' CHELTWM L State Highway Agenc HwB12 303
13 rA000541 ‘Hw'y' CHELSEA ST State Highway Agenc HwB3 30
14 AO00542 ‘US 1 MBAAT MYST State Highway Agenc HwB3 30
15 rAO00543 ‘Hwy' CHELSEA LO State Highway Agenc HwB12 303
16 AO00544 ‘U5 1 MB/CHEL L State Highway Agenc HwB12 303
17 AO00545 '0THER RELIEF" | State Highway Agenc HwB12 303
18 MAOO054E ‘U5 1 MB/TOLL PLA State Highway Agenc HwB12 303
10 b A MINNFAT WAATER MVETIE DI Chabe Hinbusan daoee Hus0 A0 N
< >
Cloze Map Print

Figure 5-18 Transportation Systems Table
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5.5 Utility Systems
Selecting Utility Systems from the Inventory menu (Figure 5-19) will display the Utility Systems

Inventory table (Figure 5-20), which allows the user to view and map the locations and
characteristics of facilities for potable water, wastewater, oil, natural gas, electric power, and

communications.

Invunolyil-luard Analysis Results Bookmarks Insert

General Building Stock  » .— v|| o
Essential Facilities I’ B | n ﬁ 8 |
User Defined Facilities . FLE

Transportation Systems
Demographics
Vehicles

View Classifications

Figure 5-19 Inventory / Utility Systems Menu

Table Type:

Potable \Water

Potable Water \waste Water  Qil

Utility Systems Inventory (thous. dollars)

Natural Gas  Electric Power  Communications

Potable Water System Facilities ~

A
Loa BLACKSBURG-CHRS

City
CHRISTIANSBURG

| Cose ||

Map

||

Figure 5-20 Utility Systems Table
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5.6 Demographics

Selecting Demographics from the Inventory menu (Figure 5-21

Inventory | Hazard Analysis Results Bookmarks Insert
E
General Building Stock  » m

YEIFE

Essential Facilities

User Defined Facilities

Transportation Systems
Utility Systems

Demographics

Vehicles

Demographics
View/Modify Demographic Data

View Classifications
450300 il |

Inventory| Hazard Analysis Results Bookmarks Insert
=
General Building Stock  » m v| 7

Essential Facilities
User Defined Facilities

L d
[T
=)

e

Transportation Systems
Utility Systems

Demographics

Vehicles Demographics

View Classifications View/Modify Demographic Data

450300 T

Figure 5-21 Inventory / Demographics Menu

Figure 5-21) will display the Demographics table (Figure 5-22), which allows the user to view and
map categorical Census data aggregated by Census block.

Page 5-16




Hazus Flood Model User Guidance

[E7 Demographics — O it
Select County to display:
Montgomery, VA (51121] |
CensusBlock Population Households GroupQuarters MaleLess16 Male16toBS Malel ~
1 257 0 257 0 228
2 511210201001001 649 0 643 1 432
3 511210201001002 0 0 0 0 0
4 511210201001003 0 0 0 0 0
5 511210201001004 0 0 0 0 0
] 511210201001005 0 0 0 0 0
7 511210201001006 0 0 0 0 0
8 511210201001007 0 0 0 0 0
9 511210201001008 0 0 0 0 0
10 511210201001009 0 0 0 0 0
1 511210201001010 0 0 0 0 0
12 511210201001011 0 0 0 0 0
13 511210201001012 0 0 0 0 0
14 511210201001013 0 0 0 0 0
15 511210201001014 0 0 0 0 0
16 511210201001015 0 0 0 0 0
17 511210201001016 0 0 0 0 0
18 511210201001017 0 0 0 0 0
19 511210201001018 0 0 0 0 0
20 511210201001019 133 1] 133 0 33
21 511210201001020 26 1] 26 0 26 o
( il 44 7 OO NN O N N baial n N ) =
Close Map Print

Figure 5-22 Demographics Table

B.7 Vehicles

Selecting Vehicles from the Inventory menu (Figure 5-23) will display the Vehicles table (Figure 5-24),
which shows two tabs with information about vehicle count and dollar exposure by Census block.
Default vehicle data is no longer added to Hazus as this data type was discontinued in the 2020
Census data update. However, the empty tables and the analysis module is still available in Hazus,
for users to import their own vehicle data. The table can be changed to show daytime or nighttime
values using the Day / Night drop-down. These values are estimated based primarily on the building
occupancies in each Census block.
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Inventory I Hazard Analysis Results Bookmarks
General Building Stock  » )g»o[)o

! Essential Facilities ’ & n
User Defined Facilities -

-

] Transportation Systems
Utility Systems

Demographics

| Vehicles

View Classificatid Vehicles

45.9309 View/Modify Vehicular Data

Figure 5-23 Inventory / Vehicles Menu

[ Vehicle Inventory Count and Exposure (dollars) — O X
Vehicle Count  Dollar Exposure
Day / Night:
| Montgomery, VA [51121) v ‘ [ Daytime v
[ Show Scenaria Census Blocks
CensusBlock TotalDay Cars LightTrucks HeavyTucks Shape A
1 511210201001000 I 151 86 B3 2
2 511210201001001 176 100 74 2
3 511210201001002 0 0 0 0
4 511210201001003 0 0 0 0
5 511210201001004 0 0 0 0
5} 511210201001005 0 0 0 0
7 511210201001006 1] 0 0 0
8 511210201001007 0 1] 1] 0
9 511210201001008 0 1] 1] 0
10 511210201001009 0 1] 1] 0
1 511210201001010 0 0 0 0
12 511210201001011 0 0 0 0
13 511210201001012 0 0 0 0
14 511210201001013 0 0 0 0
15 511210201001014 0 0 0 0
16 511210201001015 1] 1] 0 0
17 511210201001016 0 1] 0 0 v
< i i ) i >
Close Map Print

Figure 5-24 Vehicles (Vehicle Count) Table

5.8 View Classifications

View Classifications (Figure 5-25) allows users to view definitions of the classification categories. The
subtypes are General Building Stock, Essential Facilities, High Potential Loss Facilities,
Transportation Systems, and Utility Systems, as shown in Figure 5-25
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Inventory | Hazard Analysis Results Bookmarks Insert Selec

General Building Stock ~ » v || o i
Essential Facilities ' -+ ) R [
User Defined Facilities > =i |
Transportation Systems s g
Utility Systems y
Demographics g
Vehicles A
| View Classifications 3 General Building Stock
45.9309 ! Essential Facilities
Transportation Systems
1,00012207

Utility Systems

Figure 5-25 Inventory / View Classifications Menu

Building Stock Classifications

The Buildings Classifications table (Figure 5-26) allows the user to view the assumptions used to
define values for Building Occupancy Classes and Model Building Types.

Building Classifications —

Building Dccupancy Claszes  Model Buiding Types

Building Types

Specific Docupancy General Jccupancy Description
1 [RES1 JSingle Family Single Family Diwelling
2 RES2 Fiesidential Manuf. Housing
3 FRES34 Fiesidential Druplex
4 RES3E Fiesidential Triplex / Quads
5 RES3C Fiesidential ulti-dwelingz (3 to 3 units)
E RES3D Fiesidential ulti-dwelingz (10to 13 units]
7 RES3E Fiesidential ulti-dwelings (20 to 43 units]
g RES3F Fesidential ulti-dwelingz [S0+ unitz]
3 FRES4 Fiesidential Temporary Lodging
10 RESS Fiesidential Institutional Diormitony
11 RESE Fiesidential Murzing Home
12 COM1 Commercial Rietail Trade
13 COm2 Commercial wholesale Trade
14 COM3 Comrnercial Perzonal and Repair Services
15 COm4 Commercial Professional/T echnical Services
16 COME Commercial Banks
17 COME Comrnercial Hogpital
18 COmM7 Commercial Medical Office/Clinic
19 COmE Commercial E nitertainment & R ecreation
20 COMS Commercial Theaters
21 COM10 Camnnercial Parking
22 IMDA Indusztrial Heawy
23 IND2 Industrial Light
< >
Cloze Pirt

Figure 5-26 Buildings Classifications Table

5.8.2 Essential Facilities Classification

The Essential Facilities Classifications table (Figure 5-27) allows the user to view the assumptions

used to define values for Medical Care Facilities, Emergency Centers, and Schools.
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Essential Fadilities Classification

Medical Care Faciities Emergency Centers  Schools |

Medical Care
Categary Description
EFHL Medical Care Large Hospital [areate
2 EFHM Medical Care Medium Hospital (50 1
3 EFHS Medical Care Small Hospital [less ¢
4 Medical Care
5 DEFAULT Default for Medical

Figure 5-27 Essential Facilities Classification Table

5.8.3 Transportation Systems Classification

The Transportation Systems Classification table (Figure 5-28) allows the user to view the
assumptions used to define values for Highway, Railway, Light Rail, Bus, Port, Ferry, and Airport.
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Transportation Systems Classification - O X
Highway Railway LightRail Bus  Port  Femy  Airport
Table Type:
|Highway Bridges v
eClass Category ~ Description
=l HDFLT Highiwiay Default Bridge
7 HWE1 Highway 'Maijor Bridge - Length
3 HWEB10 Highway Continuous Concrete
4 HWE11 Highway Continuous Concrete
5 HwWB12 Highway | Steel, Multi-Calumn B
[ HwB13 Highway | Steel, Multi-Column B
7 HWB14 Highway | Steel, Mult-Column B
8 HWB15 Highway | Continuous Steel [
g HWB16 Highway | Continuous Steel (Sei
10 HWB17 Highway 'PS Concrete Multi-Co
11 HwWB18 Highway 'PS Concrete, Multi-C
12 HWB19 Highway |PS Concrete, Multi-C
13 HwB2 Highway ‘Major Bridge - Lenath
14 HwB20 Highwiay 'PS Concrete, Single
15 HWB21 Highway 'PS Concrete, Single
16 HwB22 Highway Continuous Concrete
17 HwB23 Highway Continuous Concrete
18 HwWEB24 Highway ' Same definition as H
10 W iR IR Himbusisi | € arma Aakimilian za L
|« e e e R >
| Cese || Pint |

Figure 5-28 Transportation Systems Classification Table

5.8.4 Utility Classifications

The Utility Classifications table (Figure 5-29) allows the user to view the assumptions used to define
values for Potable Water, Wastewater, Qil, Natural Gas, Electric Power, and Communications.
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Utility Classifications - O X

Potable W ater 'wmwuerj O NatwalGas Electic Power Communications

Table Type: | Potable Water System Facilties v
Potable W/ ater
Category. Description
A PCVS Control Vaults Potable Water Contro
2 PDFLT DEFAULT Default Facility
3 PPPL Potable “/ater
4 PPFPM Potable '/ ater
5 PPPS Potable W ater
5 PSTAS Potable “/ater Above Ground Steel
7 PSTBC Potable "/ater Buried Concrete Tanl
2 PSTGC Potable W ater On Ground Concrete
9 PSTGS Potable W ater On Ground Steel Tan
10 PSTGW Potable " ater On Ground Wood Ta
1 PwE Potable “/ater ‘Wells
12 PwWTL Potable W ater Large WTP > 200
13 Potable ' ater
14 Potable ‘/ater Smal ‘W TP [ < 50 MG

Figure 5-29 Utility Classifications Table
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Section 6. Model Menu: Hazard

The Hazard menu (Figure 6-1) within Hazus has several analysis types from which to choose. These
options enable the user to select the appropriate analysis to perform on the Study Regjon. This
section explains the selections and the inputs required for each.

| Hazard Analysis Results Bookm

Flood Hazard Type...
User Data

Develop Stream Network...

Scenario »
Riverine »
Coastal 3

Figure 6-1 Hazard Menu

6.1 Flood Hazard Type

The riverine and coastal hazards have different requirements for developing the hazard and the
digital elevation data required to support the analysis.

The first option on the Hazard menu (Figure 6-2) is Flood Hazard Type. Selecting this option activates
the Flood Hazard Type dialog shown in Figure 6-3. In this dialog, the user selects the Study Region’s
flood hazard type for analysis. The Storm surge option is only enabled if the user is conducting a
combined Hurricane and Flood hazard analysis and previously ran the Hurricane model.

The Flood Hazard Type selection on the Hazard menu (Figure 6-2) prevents users from having to
supply unnecessary digital terrain data for the selected hazard type and enables only those menu
items that are needed to support the hazard.

- '
Hazard | Analysis Results Bookmarks Insert Sel

Flood Hazard Type... ] v| o2

Uszer Data

Flood Hazard Type...
Develop Stream N
Select the flood hazard type

Scenario
Riverine )
Coastal »

Figure 6-2 Select Flood Hazard Type
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Flood Hazard Type X

Study reqion flood hazard type
(®) Riverine only
() Coastal only
() Riverine and coastal

Combined wind and flood

Storm surge

Cancel

Figure 6-3 Flood Hazard Type Dialog

Users should think carefully about which hazard type (or both) they are interested in analyzing, as the
selection will drive the entire hazard assessment. Changing the Flood Hazard Type selection will
change the DEM requirements and prevent the user from accessing some of the menu items not
applicable for that flood hazard type. For example, selection of the Riverine only button will require a
DEM that covers both the Study Region and all the watersheds that intersect that Study Region and
will require the user to develop a stream network, creating a Scenario (described later in this
section). A coastal analysis does not require a stream network or hydrologic analysis but does
require a DEM for the coastal area of the Study Regijon.

6.2 User Data

The User Data selection from the Hazard menu (Figure 6-4) activates the window shown in Figure
6-5. Here, the user can select the appropriate tab to import the relevant data for the analysis. The
User Data window offers four data import options: DEM, Depth Grid, and HEC-RAS. This section will
provide details on using the DEM import option, while Section 12 provides more details on the other
two options. Note: the Flood Information Tool (FIT) has been deprecated as of Hazus 5.0, however,
users with existing FIT data may still import FIT folders using the FIT tab.

' Hazard Analysis Results Bookm

Flood Hazard Type...
User Data

Develop Strean| User Data

Scenario User Data

Riverine 3

Coastal »
Figure 6-4 Select User Data
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User Data

DEM  FmT Depth Grid HEC-RAS

DEM metadata

Vertical units Meters v
Vertical datum NAVDSS v
Othervertical datum

Select DEM dataset(s)

Browse...

Determine required DEM extent

Progress
OK Cancel

Figure 6-5 User Data Options Window

Click Determine required DEM extent shown in Figure 6-5 to have the Flood Model determine the
DEM files required for the analysis. The extent will be different for riverine versus coastal flood
analysis.

After a short pause, the DEM Extent window will appear, as shown in Figure 6-6. This window lists the
required latitude and longitude coordinates that are needed to download the U.S. Geological Survey
(USGS) DEM data. The latitude and longjtude shown may extend beyond the defined boundaries of
the Study Region because the watersheds that affect the region’s flood risk probably extend outside
the political boundaries.

Note that any DEM imported into the Flood Model must meet the bounding coordinate constraints
established by this dialog. The Model will discontinue processing if it identifies gaps in the data
coverage.
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5 DEM Extent — X
Your analysis will require a DEM bounded by these coordinates in decimal degrees

Morthmost Latitude
WestmostLongiude N Eastmost Longitude

w Southmost Latitude w
N

Select NED Resolution: | 1 Arc-Second v
Click link to download DEM file.

NED Dataset esolution Size MB Last Updated A

' USGS_1_n37w080_202... |1Arc-S... 56.50 | 2021-03-18T02:39:58.000Z
USGS_1_n38w080_202... |1Arc-5...|56.25 | 2021-03-18T02:40:33.000Z
USGS_1_n38w080_202... |1Arc-5...|54.82 | 2021-02-05T02:17:28.000Z
USGS_1_n37w081_202... |1Arc-5...|55.53 2021-03-18T02:40:05.000Z
USGS_1_n38w081_202... |1Arc-S... ' 55.20 ' 2021-03-18T02:40:45.000Z
USGS 1 n39w081 202 (1arcs |ssea  12021.0205T02:17:31.0007 | Y|

Please note: Obtaining the DEM data through Hazus requires an internet connection.
For a manual workaround, please contact the Hazus Help Desk at FEMA-Hazus-
Support@fema.dhs.gov.

Download DEM Download required DEM

Close

Figure 6-6 DEM Extent Window

Use the Select NED Resolution drop-down menu to choose the desired resolution. The default is 1
Arc-Second (~30 meters). Not all Study Regions will have available USGS DEM data for resolutions
other than 1 Arc-Second. For example, choosing 1/3r Arc-Second for a Study Region in Montgomery
County, VA, will refresh the table and warn the user, “Problem downloading DEM”

6.2.1 Automated DEM Download

Click Download required DEM in the DEM Extent window shown in Figure 6-6 for Hazus to obtain all
the required DEM files and save them within the Hazus Study Region folder.

Hazus will take several minutes to download all of the DEM files. When the process has completed, a
notification window will appear (Figure 6-7) to indicate the files have been downloaded and saved.

Click OK.
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Save DEM X

Downloaded and saved 9 required DEM tiles at:
C\HazusData\HazardInput\DEM\MontgomeryCo_VA

Figure 6-7 DEM Downloaded, Unzipped, and Saved

A popup window (Figure 6-8) will ask the user whether to automatically load the DEM data into the
User Data window. Click Yes.

Automatically Loading DEM

Would you like to incorporate the 9-tile DEM data that was
just downloaded to:
C:\HazusData\HazardInput\DEM\MontgomeryCo_VA

as MontgomeryCo_VA Study Region DEM?

Figure 6-8 Automatically Load DEM
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Hazus will load the file paths for all of the DEM files into the User Data window (Figure 6-9

User Data

DEM  Fm Depth Grid HEC-RAS

DEM metadata
Vertical units Meters >
Vertical datum NAVDES

Othervertical datum

Select DEM dataset(s)

C:\HazusData\HazardIinput\DEM\MontgomeryCo_WAWSGS_1_n37w080 A Browse...
C:\HazusData\HazardIinput\DEM\MontgomeryCo_WVAWSGS_1_n38w080
C:\HazusData\HazardIinputWDEM\MontgomeryCo_WAWSGS_1_n39w080 ===
C:\HazusData\Hazardinput\DEM\MontgomeryCo_WA\WSGS_1_n37w081
C:\HazusData\Hazardinput\DEM\MontgomeryCo_WAWSGS_1_n38w081
C:\HazusData\Hazardinout\DEM\MontoomervCo VAWSGS 1 n39w081 ¥ Remove
< >

Determine required DEM extent |

Completed calculating DEM coordinates 36.8670268900558, -
80.9961054168787, 37.5176589109032, -79.8816382855074

’ OK ‘ Cancel

Figure 6-9).
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User Data
DEM FIT Depth Grid HEC-RAS
DEM metadata
Vertical units Mikore P
Vertical datum NAVDSES A
Othervertical datum
Select DEM dataset(s)
C:\HazusData\HazardIinput\DEM\MontgomeryCo_WAWSGS_1_n37w030 A Browse..
C:\HazusData\Hazardinput\DEM\MontgomeryCo_WVAWSGS_1_n38w080
C:\HazusData\Hazardinput\DEM\MontgomeryCo_WVAWSGS_1_n39w080
C:\HazusData\Hazardinput\DEM\MontgomeryCo_WAWSGS_1_n37w081
C:\HazusData\HazardIinputWDEM\MontgomeryCo_WAWSGS_1_n38w081 —
C:\HazusData\Hazardinout\DEM\MontaomervCo VAWSGS 1 n39w081 ¥ €
< >
Determine required DEM extent
Completed calculating DEM coordinates 36.86702689005585, -
80.9961054168787, 37.5176589109032, -79.86816382855074 oK Casinel

Figure 6-9 Import DEM Files into Hazus

Click OK to complete importing the DEM files. Click Yes (not shown) on the next popup window to
proceed with DEM analysis.

A progress bar (Figure 6-10) will appear as Hazus imports and merges all the individual files into a
single DEM for the Study Region. This may take several minutes depending on the size of the Study
Region. A notification (Figure 6-11) will appear once the DEM import is completed. Click OK.
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53 DEM Extent —
Your analysis will require a DEM bounded by these coordinates in decimal degress

Morthmost Latitude

Westmost Longitude 37.518 N Eastmost Longitude
w Southmost Latitude w

N

Select NED Resolution: |1 Arc-Second v‘
Click link to download DEM file.

NED Dataset esolution Size MB Last Updated A
USGS_1_n37w080_202... |1Arc-S... |56.50 2021-03-18T02:39:58.000Z
USGS_1_n38w080_202... |1Arc-S... |56.25 2021-03-18T02:40:39.000Z
USGS_1_n39w080_202... |1Arc-S... |54.82 2021-02-05T02:17:28.000Z
USGS_1_n37w081_202... |1Arc-S... |55.53 2021-03-18T02:40:05.000Z
USGS_1_n38w081_202... |1Arc-S... |55.20 2021-03-18T02:40:45.000Z
USGS 1 n39w081 202 1Arc-S_ 15593 2021-02-05T02:17:31.000Z | ¥

Please note: Obtaining the DEM data through Hazus requires an internet connection.
For a manual workaround, please contact the Hazus Help Desk at FEMA-Hazus-
Support@ fema.dhs.gov.

Downloading required DEM tile 2 of 9

| Download required DBEM |

i_ Close

Figure 6-10 DEM Import Progress

Save DEM X

Downloaded and saved 9 required DEM tiles at:
C:\HazusData\HazardIinput\DEM\MontgomeryCo_VA

Figure 6-11 DEM Import Completed
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6.3 Develop Stream Network

If the Study Region is subject to riverine flood hazard, the next step is to generate a stream network.
This is not required if the user is only running scenarios with the recommended user-supplied flood
hazard data (depth grids or HEC-RAS floating-point binary (.FLT) grids). Generating a stream network
is a one-time analysis that establishes the river network identity for all subsequent scenarios.

The Develop Stream Network selection on the Hazus menu (Figure 6-12) activates the Develop
Stream Network dialog shown in Figure 6-13. Enter the number of square miles that define the
stream drainage area for the Study Regjon.

Hazard i Analysis Results Bookmarks Insert Se

Flood Hazard Type... ] vAl=

User Data H g 8
=l XY
Develop Stream Network... }

Scenario
Develop Stream Network...
Riveri .
— Set Stream Drainage Area
Coastal

r

|

Figure 6-12 Select Develop Stream Network

Develop Stream Network X

Input a stream drainage area for the study region.
When you select DK, the stream network will be
created. This process may take some time.

Input stream drainage area ;
o 9 ‘ 10.0| Square miles

(affects stream density)
[0.25 - 400 square miles)

Cancel

Figure 6-13 Develop Stream Network Dialog

The model will process the DEM for the Study Region to determine the locations of streams. This
analysis will take some time, ranging from 5 minutes to several hours, depending on the computer’s
processing speed, the size of the Study Region, and the complexity of the DEM. When the process is
complete, the identified streams will appear on the Study Region, like Figure 6-14.

=  Selecting a small number of square miles, such as 1, for the drainage area will result in a highly
defined stream network. This value represents the total land area, in square miles, that drains
into any given reach, excluding that drainage at the starting node of the reach (the downstream
node from the prior reach). The smaller the drainage area, the more processing time required by
the Flood Model for subsequent analyses.
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Q Hazus: Flood - MontgomeryCo_Va = O X

File Edit View Inventory Hazard Analysis Results Bookmarks Insert Selection Geoprocessing Customize Windows Help

FOBS B x & - 1452123 Vi EEE R &g

=il

Table Of Contents B x

008

= £ layers A
B Reaches

=] RegionDEM

Value
- High : 435832

® Q@ 2k i3 LA BRI R el

yoleasg ﬂ Bojelen ﬂ

"Low: 884,197

m

[1] Census Blocks
[]Census Blocks

Census Tracts
[] Census Tracts

Hillshade

Value
High: 254

Low:0

-80.44 37.127 Decimal Degrees

Figure 6-14 Example - Flood Model after Developing Stream Network

= Running the stream network, the first time, is fairly time consuming as the model performs an
analysis to fill in spurious sinks in the DEM. However, to save the user time for subsequent runs,
the model saves the results of the sink-filling process. As such, if the user decides to change the
drainage area number, the model will not require nearly as much time to perform the analysis.
For example, if the user runs the stream network at 5 square miles and then decides that the
network requires more detail, changing the drainage area to 1 square mile will process
significantly faster than the original analysis. Please note that Hazus must still re-calculate and
assign the Manning’s-n coefficient, associated with stream roughness, to each reach. This
process will appear to the user as “Finalizing Stream Network” and will take additional
processing time if the user changes the drainage area value.

If a river in the analysis forms a border between two counties, including both counties on either side
of the river in the Study Region is recommended. The stream network in Hazus is known as a
synthetic network because it is derived entirely from the DEM. No imagery or pre-existing map layers
are used in its generation. More specifically, streams in a synthetic network exist at DEM grid cell
locations that receive drainage from a threshold number of upstream grid cells. If the DEM is not
large enough, the threshold number of grid cells may not be reached.

Figure 6-15 shows an example of this situation with a discontinuous synthetic stream. The Study
Region consists of one county, for which the one river (displayed in red) forms a border. Because the
DEM does not include areas draining to both sides of the river, the resulting synthetic stream is
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discontinuous. There are simply not enough DEM grid cells draining to the discontinuous portions to
properly delineate them.

Figure 6-15 Example Discontinuous Synthetic Stream

The solution to this discontinuity problem is to include counties on both sides of the river during
Study Region creation. Including both counties will result in a larger DEM that drains to both sides of
the river. Figure 6-16 illustrates this concept using the same stream as shown in Figure 6-15 The
second Study Region consists of counties on either side of the river (shown in red) and the resulting
synthetic stream network is now continuous.

Figure 6-16 Example Continuous Synthetic Stream

6.4 Scenario

A scenario defines the specific stream reaches, or lengths of coastline for coastal users, and the
hydrologic and hydraulic characteristics to be included in one analysis run. A scenario could include
all stream reaches in the Study Region, and/or the coastline in a coastal Study Region. However,
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because the analysis requires significant computer processing, dividing the region into several
smaller scenarios may be preferable. Figure 6-17 shows the Hazard > Scenario menu with only the
New selection active prior to defining the first scenario for a Study Region. Figure 6-18 shows the
Hazard > Scenario menu with all selections active after the initial scenario has been defined.

Hazard | Analysis Results Bookmarks Insert Selection Geopr

Flood Hazard Type... v| 82 m @ i
User Data n r;._.J 3 -
Develop Stream Network... - =

Scenario » m

Riverine »

Coastal »

Figure 6-17 Select New Scenario (Prior to Defining First Scenario)

6.4.1 New

Under the Scenario menu option, select New, as shown in Figure 6-18 to create a new scenario. The
process of defining a new scenario for riverine, coastal, and combined analyses each require
different steps. These steps are detailed in the next sections.

Hazard | Analysis Results Bookmarks Insert Selection Geoprocessing

Flood Hazard Type... v| o2 G & ]| e s

User Data

Develop Stream Network...

Scenario

Riverine

Coastal

Figure 6-18 Select New Scenario (After Defining First Scenario)

6.4.1.1 Riverine Scenario

The Create New Scenario window, shown in Figure 6-19 will appear. Enter a name for the scenario
and an optional description. Be careful not to include any leading or trailing spaces. The Description
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will be visible to the user when opening scenarios in the future to help differentiate between similarly
named scenarios.

Create New Scenario X

Enter a unique name for the New Scenario:

MyRiverineCase

Description
Riverine scenarino for Montgomery Va

Cance

Figure 6-19 Enter a Name for the New Scenario

After naming the scenario, the New Scenario window (Figure 6-20 will open, allowing the user to
select which stream reaches to include in the scenario. Click the radio button next to the appropriate
Map layer type. To select features, click the Add to selection ( + ) button, then drag the selection box
around the features to be selected to add reaches to the scenario and then click Save selection (the
floppy disk icon). The Remove from selection ( — ) button removes reaches from the selected
reaches. Similarly, the Clear selection ( X ) button clears all reaches from the selection.

The selected features will be highlighted in a light blue color, as shown in Figure 6-21 After saving
the selected stream reaches, click OK to complete the definition of the scenario. The color of the
selected reaches changes from light blue to red when this process is complete.
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New Scenario

Select map features to beincluded in
thescenario. Asinglescenario may
contain morethan one objecttype

Map layer type

(® Riverreaches

Coastal shorelines

Map layer selection

Add to selection E

Clear selection _)Tl

Save selection

Figure 6-20 Select Map Features

° Hazus: Flood - MontgomeryCo_Va (MyRiverineCase)

File New Scenario

- 7 & selectmap features to beincluded in
5 the scenario. Asingle scenarioc may
: Q @ contain morethan one objecttype

Table Oi Map layer type

(®) River reaches

Map layer selection
Add to selection |I]

Removefrom selection -
Clear selection E)t(]
o Saveselection

=

< > jaiz| & un

Analysis Results Bookmarks Selection Geoprocessing Customize

& - |[1452123

CIET el

O

I EEEE0

Figure 6-21 Select River Reaches for a Scenario

Page 6-14




Hazus Flood Model User Guidance

= After selecting the features in the map layer, users must click Save selection for each specific
map layer type. For example, if a user wants to create a scenario with river reaches and coastal
shorelines, the user must: 1. Select the River reaches radio button, click the Add to selection
button, select reach(es), click the Save selection button. 2. Select the Coastal shorelines radio
button, click the Add to selection button, select shoreline(s), click the Save selection button.

Click OK.

If the user has imported any flood depth grid(s), those areas can be selected by clicking on the User-
defined depth grids radio buttons. Note, Hazus provides an option to import data from the Hazus FIT
tool, however North American Vertical Datum of 1988 (NAVD88) is no longer supported. Select and
save FIT areas and/or flood depth grids in the same manner as the reach selection if necessary,
however it is considered a best practice to use user-supplied depth grids.

If more than one flood depth grid is selected for the scenario, the dialog will expand to show the list
of selected flood depth grids selections, as shown in Figure 6-22. Users can select one or more

depth grids for the scenario.

New Scenario

Select map features to be included in
thescenario. Asinglescenario may
contain morethan one objecttype

Map layer type

(® User-defined depth grids

Map layer selection

Add to selection El

Removefrom selection -

Clear selection X

Saveselection &
Cancel

Thecurrentselection of depth grid polygons contains two or more
features that may share a common area. Please selectthe desired
polygon(s)toincludein this scenario.
Name Return Period FID ~
1 DGO0_quick: 1
2 DGOT_quick: 100
(¥
< >
[] Check All Select

Figure 6-22 Select User-Defined Depth Grids for a Scenario
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6.4.1.2 Coastal Scenario

The coastal analysis does not require the user to generate a stream network or run the hydrologic
analysis. However, the user will still be required to obtain and identify the DEM to be used in the
analysis. The extent of the DEM necessary for the coastal flood hazard is different from that required
for the riverine flood hazard. The necessary DEM is determined by the union of the region shoreline
with the Study Region boundary.

Once the DEM has been added, the user can move directly to defining a scenario by selecting New
from the Hazard > Scenario menu. The Create New Scenario window will appear (Figure 6-23). As
with the riverine analysis, enter a name and, if desired, a description for the scenario, and click OK.
The window shown in Figure 6-24 will appear.

Create New Scenario X

Enter a unique name for the New Scenario:

Scenariol

Description
User Guide Example [CharlestonSC

Cancel

Figure 6-23 Enter a New Scenario (Coastal)
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@ Hazus: Flood - CHarlestonSC1 (Scenario™)
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Value
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Value
High: 254

Low: 0
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[l Study Region Boundar,
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Map layer selection
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Cancel
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Figure 6-24 Select a Shoreline for a New Coastal Scenario

Like the riverine hazard, the user will be asked to select a shoreline or shorelines for analysis (Figure
6-25). Click the radio button next to the appropriate Map layer selection (Figure 6-25). The Flood
Model uses a standard GIS selection tool to allow the user to select the shorelines. Click the Add to

selection ( + ) button, then either click on the shoreline or draw a box to select more than one

shoreline. Note that although the shoreline is simplified, selecting small island areas off the main
coast can produce island transects that interfere with the main coastal segment. They should be

analyzed separately or left out of the analysis.
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New Scenario

Select map features to be included in
the scenario. Asingle scenario may
contain morethan one objecttype

Map layer type

(® Coastal shorelines

Map layer selection

Addto selection +
Removefrom selection -
Clear selection X
Saveselection E
Cancel

Figure 6-25 Select Shoreline

= To select discontinuous shorelines, such as islands, press the Shift key while selecting additional
shorelines. To deselect shorelines, press the Shift key and click on the shorelines that are not to
be included in the selected shorelines.

= Hazus has a built-in default national shoreline that is delineated by county. In Study Regions that
are sub-county or a combination of multiple sub-counties, all the associated shorelines of the
counties will be brought in. This is by design to account for coastal flooding at specific locations
that does not necessarily originate from the closest shorelines to those locations.

= The Flood Model has shorelines for mainland areas, barrier islands, large islands, small islands,
and the Great Lakes. These shorelines have been smoothed to allow the Flood Model to build
shore normal transects in a less time-consuming fashion.

Once the shorelines have been selected, click the Save Selection button (the floppy disk icon); the
OK button will become enabled (Figure 6-25). Click OK. This completes the process of creating the
new scenario and selecting shorelines. The next step in the process is to characterize the chosen
shorelines.
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The Shoreline Limits dialog (Figure 6-26) will automatically pop up after shorelines are selected for
the scenario to characterize the limits of the shoreline. This dialog begins the process in which the
user identifies where they wish to start characterizing the shoreline (Shoreline Start) and where they
would like to finish the characterization (Shoreline End) as shown on the interactive map layer
(Figure 6-27). In between these two points, the user will want to add any breaks in the shoreline
(Breaklines) where the geographic characteristics of the shoreline change. The Flood Model will
develop transects at 1,000-foot increments and perform the analysis (e.g., simplified Wave Height
Analysis for Flood Insurance Studies [WHAFIS]) only between the Shoreline Start and Shoreline End
lines. If the default locations (at the end of each segment) are moved, the Flood Model will limit the
development of transects between these locations.

= The Flood Model will develop transects and perform a simplified WHAFIS and runup analysis
between the Shoreline Start and Shoreline End lines—either the default locations or those
generated by the user. The Flood Model will still develop a stillwater elevation (SWEL) surface
over the entire Study Region to ensure that flooding through other low-lying areas is properly
accounted for.

The Shoreline Limits dialog allows the user to perform the segmentation of the shoreline if necessary
(Figure 6-26). Figure 6-27shows the interactive map layer.

Optionally draw shoreline startline, endline, and breaklines. Single dick
to add a vertex and double dick to finish drawing the line. For
breaklines only, right click a line to remove it.

Current shoreline

< Previous Shoreline 1 of 3 Next Shoreline >
Limit type Action

|

@ Startiine °
] C' Endline
' (O Breakline Use Default
|

Cancel Next >

Figure 6-26 Input Shoreline Limits
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@ Hazus: Flood - CHarlestonSC1 {Scenario?)
File Edit View Inventory Hazard Analysis Results

BERQ@ i« E-I O B INDHE

=z

»ea8

H@ x

Bookmarks |nsert Selection Geoprocessing Customize Windows Help

Table Of Contents B x

Qu\.ﬁ =

5 & Layers
© & ChosenShorelines
= & RegionShore
= & RegionDEM
Value
" High:117.338

“Low: -54.0415

= [ Census Blocks
[ Census Blocks
= @ Census Tracts
[J Census Tracts
=] Hillshade
Value
High : 254

[ Study Region Boundar

P —
— s

Optionally draw shareline startline, endline, and
breaklines only, right dick 2 line to remove it.
Current shoreline —

< Previous Shoreline 1 o |3

breaklines. Single dick

to add a vertex and double dick to finish drawing the line. For

Next Shoreline >

Limittype Agtion
. =
Low: D @® startiine (’
() Endline S——
= B Study Region Boundary O Breakline Use Default

2|

:uuadgﬂ Bojeles ﬂ

Cancel Next >

< >|jae| @<

-79.803 32.651 Decimal Degrees

Figure 6-27 Example - Setting Shoreline Limits

The user can leave the shoreline start and end as shown in Figure 6-27 or change the limit(s)
(Startline or Endline) and click the Draw button (circled) to draw a new line on the map. The model
will remove the default line and replace it with the newly drawn line. For example, Figure 6-28 shows
what the user might see upon changing the Shoreline Start point (Startline).

= The user must be sure to draw the line so that it crosses the shoreline only once. This could be
from inland into the flood source or from the flood source inland. The Flood Model will
automatically make the line shore normal or perpendicular to the shoreline.

= Hazus allows users to zoom in or out of the map before clicking on the Draw button. After clicking
the Draw button, the tool is set to the Line tool, and the customization becomes locked;
therefore, users will not be able to select any other tool until the Startline, Endline, and
Breakline(s) are drawn.

= The user can move the Startline if the initial effort is not in the right location by merely
reselecting the Draw button and drawing the Startline in another location. Similarly, if the user
decides not to change the Startline after having drawn one, the user can click on the Use Default
button and restore the Startline to its default location.

= (Clicking on the Use Default button (see Figure 6-28) will only restore the active Limit type, such
as the Startline or the Endline. To restore both the Startline and the Endline, the user needs to
select the appropriate radio button and click on the Use Default button for each line.
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@ Hazus: Flood - CHar

File Edit View Inventory Hazard Analysis Results Bookmarks Insert Selection Geoprocessing Customize Windows Help

€« (-0 8@/ BENASS TR #OES L BB x| 0~ b [l ME4l=1]

®RaMO

=]

—

FE P,

Table Of Contents ax

EEELEE
= & Layers
5 B ChosenShorelines

= © RegionShore
= @ RegionDEM
Value
. High: 117.338
-

Low : -54.0415

© [ Census Blocks

uweasm‘ nmelegﬂ

[] Census Blocks
= B Census Tracts
[ Census Tracts —
= Hillshade Shoreline Limits
V_lluz o ¥ draw shorel tline, endline, and breakl le dick
High: 254 to add a vertex and double click to finish drawing the line. For
I breaklines only, right click a line to remove it.
Low:0 Current shoreline
| <previous shoreline | 1 of | 3 | NextsShoreline >
£ B Study Region Boundary | |
[ Study Region Boundar|
@ Startiine [ paw
O Endiine e —
O Breakline (| useDefault |)
Concel v
< >||j@e|an c >
C)

Figure 6-28 Example - Resetting the Shoreline Startline

Figure 6-29 shows an example of a changed Shoreline End (Endline). Like the Startline, the user can
change the location of the Endline by clicking on the Draw button and drawing a new line. To restore
the Endline to its default location, click on the Use Default button with the Endline radio button

enabled.
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Figure 6-29 Example - Resetting the Shoreline Endline
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As stated previously, if the Study Region geography changes along the shoreline, the user will want to
segment the shoreline and classify the shoreline into the proper geophysical properties. Consult a
Flood Insurance Study (FIS), identify the areas along the shoreline where the SWEL changes, and
create a Breakline at these points. Select the Breakline radio button and click Draw. As with the
Startline and the Endline drawing, draw a line crossing the shoreline only once, as circled in Figure
6-30.

0 Hazus: Flood - CHarlestonSC1 {Scenario) =23 X
File Edit View Inventory Hazard Analysic Results Bookmarks Insert Selection Geoprocessing Customize Windows Help
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Figure 6-30 Example - Adding a Breakline to the Selected Shoreline

= The user cannot change or move a Breakline once it has been drawn; to remove the line, clear
the Breakline using the Clear All button and redraw the Breakline in the new location.

After all breaklines have been drawn, click Next to open the Shoreline Characteristics window shown
in Figure 6-31. The information for this window can be obtained from a FEMA FIS. Check the FEMA
website for information on obtaining an effective FIS for the Study Region.

Input the SWEL in the Elevation field shown in the Shoreline Characteristics window (Figure 6-31).
This field and the Vertical Datum field are required and will be shown in red text. The Hazus default
vertical datum is National Geodetic Vertical Datum of 1929 (NGVD29), however, users should be
aware that NAVDS88 is more commonly associated with the SWEL for recent FEMA studies. The other
SWEL fields are loaded with default parameters calculated using the standard FEMA ratios but can
be edited and overwritten by the user if the data are available from the FIS.

= The user should review the FIS carefully to determine whether the 100-year SWEL includes wave
setup. If it does, the user should put in the 100-year SWEL as noted in the FIS but must also
check the Yes radio button under the Elevation includes wave setup? question. Doing this will
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enable the Wave Setup (ft) field. The user should enter the wave setup value here. If the user
cannot identify whether wave setup is included, quickly graph the SWELSs listed in the FIS and
check whether the 100-year SWEL is higher than expected by the graph. If so, it most likely
includes wave setup.

= Users should select a wave exposure for each segment corresponding to its fetch under 100-year
flood conditions, not under normal conditions. For example, a mainland shoreline segment,
landward of a low-lying island, may have a short fetch under normal conditions, but the island
may be flooded, and the fetch may increase under more severe conditions.

After entering the Elevation and Vertical Datum for each shoreline segment, click Finish.

Shoreline Characteristics

Current shoreline:
< Previous Shoreline i of 4 Mext Shareline = Apply to All Segments

100-vear Flood Conditions

100-year stillwater elevation

Elevation (ft): |:| 10yr: E00-yr:

Elevation includes wave setup? BOLyT:

Wave Setup (ft):

“Vertical datum

Vertical datum: NAVDEE

Other name:

Cancel = Back Finish

Figure 6-31 Shoreline Characterization - Stillwater Flood Conditions Window

Once the user has completed inputting the required information in the Shoreline Characteristics
window, the Flood Model has the necessary data to perform a coastal analysis for any given return
interval.

6.4.1.3 Combined Riverine and Coastal Scenario

Hazus asks the user to select between three flood hazard types in the Flood Hazard Type dialog
(Figure 6-3) to limit the DEM requirements: Riverine Only, Coastal Only, or Riverine and Coastal.
Selecting Riverine and Coastal will require the user to acquire a DEM that supports the analysis for
both hazard types. Once the user provides the DEM, they can perform any of the hazard analyses.

For example, if the user selects Riverine and Coastal, they are required to build the Stream Network
with the shorelines already available. While creating a scenario, the user has the option to build a
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scenario with only river reaches, only shorelines, or a combination of reaches and shorelines. The
Flood Model maintains the riverine and the coastal hazard depth grids separately because the depth
of flooding alone does not determine which hazard is producing the most damage by occupancy.

Create a riverine and coastal flood hazard analysis within the Study Regjon. If necessary, first create
a new Study Region. Once the Study Region is created, open it, open the Hazard drop-down menu,
and select Flood Hazard Type. Choose the Riverine and Coastal flood hazard type (Figure 6-3). See
Section 3 to review how to create a flood Study Region and Section 4 for details on opening a Study
Region.

If the user chooses to run a scenario with river reaches and coastal shorelines, the Flood Model will
analyze the impact of both hazards on the inventory independently. It will then compare the resulting
losses to determine which hazard is the controlling hazard (i.e., the hazard that has the greatest
impact on that occupancy or structure).

To perform a combined analysis, the user would create a new scenario with both riverine and coastal
components. After the Create New Scenario window (not shown), select the River reaches radio
button (Figure 6-32). Then, select reach(es) using the Add to selection ( + ) button, and click Save
selection. Second, select the Coastal shorelines radio button (Figure 6-32). Then, select shoreline(s)
using the Add to selection button, and click Save selection. Click OK to ensure that both selected
layers are saved. For more detailed instructions, refer to the previous sections on creating Riverine
and Coastal Scenarios separately.

Select map features to beincluded in || Select map features to beincluded in

the scenario. Asinglescenariomay || thescenario. Asinglescenario may
contain morethan one objecttype contain morethan one objecttype.
Map layer type Map layer type
| Orwerrescnes
(O Coastal shorelines |@® Coastal shorelines|
Map layer selection Map layer selection

Addto selection + Add to selection

Removefrom selection - Remove from selection =
Clearselection > Clear selection X

Saveselection n Save selection

Cancel OK

Figure 6-32 Select River Reaches and Coastal Sho;elines
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6.4.2 Open

A user may create multiple scenarios for each Study Region. Select Open from the Scenario menu,
as shown in Figure 6-33 to open a previously created scenario. The Open Scenario dialog will appear
(Figure 6-34). Click on the scenario’s name to highlight it, and then click OK. Only one scenario can

be opened at a time.

Hazard | Analysis Results Bookmarks |nsert Selection Geoprocessin
Flood Hazard Type... M S - P 0 &
User Data
Scenario 4 | New...

Riverine » | Open...

Coastal 3 Save| Open...
Edit. Open Existing Study Case
Close

Figure 6-33 Select Open Scenario

Open Scenario

Select the Scenario to open:

Scenariol

Description

oK

Cancel

Figure 6-34 Open Scenario Dialog
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6.4.3 Save As

The Save As option under the Scenario menu allows users to skip the hazard analysis every time
they want to run different parameters in the Inventory or Analysis menu. It saves the user time by
skipping the hazard selection and rerunning the analysis. It also provides the user a way to preserve
previous results without using the Duplicate Study Region function, which requires much more disk
space. The results tables are scenario-specific and creating a new scenario using the Save As
function assumes the user wants new results. As such, the old results are not carried over.

In addition to creating a new scenario and opening a scenario, the Scenario menu options shown in
Figure 6-35 let the user edit, close, or delete any created scenarios. To use the Save As capability,
the scenario to be saved must be open. From the Scenario menu, select Save As. The Save Scenario
As window, shown in Figure 6-36, will appear. Enter a name for the new scenario and an optional
description. Click OK to save the old scenario and automatically open the new scenario.

NOTE: Each scenario must have a unique name.

| Hazard | Analysis Results Bookmarks Insert Selection Geoprocessin

Flood Hazard Type... ML ’ > @ =

User Data

Scenario » ] New...

Riverine » Open...

Coastal » l Save As...

r Edi{ Save As...

Clo Save Current Study Case As
Del| Different Name

Figure 6-35 Select Save As

Save Scenario As x

Enter a unique name for the Scenario to be Saved As:

Desciiption

Cancel

Figure 6-36 Enter a New Name for the Scenario
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=  When a user modifies the inventory, all future results are affected as future analyses will use the
updated inventory. If the inventory is modified, the analysis should be rerun. Users that plan on
modifying the inventory should “duplicate” the Study Region to compare results, otherwise the
results are overwritten. The results will be overwritten if and only if the user reruns the analysis
on the same scenario.

Users that plan to modify the functions/parameters in the Damage and Loss Estimate analysis
should use the Save As capability to compare results between scenarios, otherwise they are
overwritten. The changes to damage functions are per Study Region, so the user is responsible for
knowing which damage functions were used to create the results of which scenario. The user will not
be able to display which damage functions were used for each scenario.

Users that plan to modify the hazard analysis do not need to use the Save As capability. However, a
few cases must be taken into consideration:

Mix grid: Mix grids are created when Hazus does not know what return period to assign to the grid,
such as the case of running a specific discharge analysis or assigning different return periods to
different reaches in a single scenario. If a user is dealing with a mix grid case and reruns the hazard
by changing some parameters (return period of one or more reaches, or the discharges), the
changes to the depth grid and floodplain polygon due to this rerun will not be reflected in the loss
analysis results until the loss analysis is rerun.

Edits to scenario: If a user reruns the hazard by adding or subtracting at least one reach from the
scenario but uses the same return period, the user should rerun the loss analysis so that the results
reflect the changes to the hazard.

User Depth Grids and HEC-RAS .FLT Depth Grids: Inside the Flood Model, the only option available to
the user in terms of modifying User Depth Grid/.FLT Depth Grid results is to choose which User
Depth Grid/.FLT Depth Grid polygons to include in the scenario. If that kind of modification is made
to the hazard, the user should rerun the flood delineation analysis so that the results reflect the
changes to the hazard.

In all three cases, if the user reruns the analysis without using the Save As capability, the previous
results will be lost.

6.4.4 Edit

The Edit option under the Scenario menu, shown in Figure 6-37 allows users to add/remove reaches
to the scenario. If a user has not selected the correct reaches or shoreline, the Edit option allows the
user to go in and re-select the correct reaches or shoreline.
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Hazard | Analysis Results Bookmarks Insert Selection Geoprocessin
Flood Hazard Type... n 3‘3! x@Y - Va Q
User Data
Scenario > | New...

Riverine > Open...
Coastal > Save As...
| Edit...
Close | Edit...
Delete] g4t Current Study Case

Figure 6-37 Select Edit

6.4.5 Close

The Close option under the Scenario menu, shown in Figure 6-38, closes the scenario in the mxd.
The scenario is not deleted but will not be the active scenario for any changes or updates.

Hazard | Analysis Results Bookmarks Insert Selection Geoproce
Flood Hazard Type... | R - P @
User Data
Scenario > | New...

Riverine > Open...
Coastal » Save As...
' Edit..
Close
il
Close

Close Current Study Case

Figure 6-38 Select Close

6.4.6 Delete

The Delete option under the Scenario menu, shown in Figure 6-39, allows users to delete scenarios
that are no longer needed. The Delete option allows users to delete multiple scenarios all at once by
clicking on the scenarios. To use the Delete capability, the scenario to be deleted must be closed.
Select Delete from the Scenario menu. The Delete Scenario dialog will appear (Figure 6-40). Select
the scenario(s) to be deleted and click OK.
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User Data
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Figure 6-39 Select Delete

Delete Scenario K

Select the scenariofs] to be deleted:

Scenariol

Description

o

Figure 6-40 Delete Scenario Dialog
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NOTE: To delete a scenario, manually close out of all references to the scenario itself or any of the
scenario directory sub-tree files, such as log files, rasters, shapefiles, personal geodatabases, and
file geodatabases in either text editor, ArcCatalog, ArcMap, or Windows Explorer. Failure to do so will
result in an incorrect sync between the scenario database-related data and their file system-related
objects.

6.5 Riverine

The Hazard / Riverine menu provides the Flood Model riverine analyses for deriving peak flows
(Hydrology) and associated flood depths and boundaries (Delineation Floodplain). Like other Hazus
analyses, this menu requires the analyses to be performed in sequential steps. For example, Figure
6-41 shows the Hydrology and Delineation Floodplain selections active.

Hazard ‘ Analysis Results Bookmarks |Insert Selection Geopi

Flood Hazard Type... j " GE B
User Data n g{j P\f -
Develop Stream Network...
Scenario »

| Riverine > m Hydrology |
Coastal Delinei Hydrology

Hydrology

Figure 6-41 Select Hydrology

6.5.1 Hydrology

Once the user has defined the scenario, the Hydrology option, on the Hazard > Riverine menu,
becomes enabled (Figure 6-41). To conduct the hydrologic analysis, select Hydrology and a
notification window (Figure 6-42) will warn the user that raster processing cannot be canceled. Click
Yes.

Process

The proceeding analysis requires raster processing.
To ensure proper operation, canceling is not allowed.
Continue?

Yes No

Figure 6-42 Select Yes to Start Hydrologic Analysis
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A progress bar (Figure 6-43) will appear as Hazus performs the hydrologic analysis. This may take
several minutes to several hours depending on the size of the Study Region and the number of
selected streams. A notification (Figure 6-44) will appear once the hydrologic analysis has been
completed. Click OK.

Performing hydrologic analyses
Reach identification and network navigation

Figure 6-43 Hydrologic Analysis Progress

Run Time X

Successfully completed hydrologic analyses.
Total time: Hours: 3, Mins:28, Secs:06

Figure 6-44 Hydrologic Analysis Completed

6.5.1.1 Best Practices and Troubleshooting

There is a tendency for ArcMap and Hazus to experience runtime issues that can lead to the Flood
Model failing to complete the analysis. Because the hydrologic analysis is specific to the Study
Region and is dependent only on the river network developed by the user, there are options to
reduce the possibility of the code reaching a memory limit.

Performing the hydrologic analysis on a watershed-by-watershed basis is recommended, thereby
limiting the processing within the model. Here are two recommended approaches:

1. Create a scenario for each watershed and then perform the hydrologic analysis on each
scenario. The hydrologic results are stored in a single table independent of scenario.

2. Create a single scenario, start with one county or watershed, and perform the hydrologic
analysis. When completed, edit the scenario, add the next county or watershed, and rerun the
hydrologic analysis. The model will skip those reaches for which the hydrologic analysis has
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already been performed and will perform the analysis on the added reaches. Repeat as needed
to complete all watersheds in the Study Regijon.
For scenarios with many stream reaches, running the hydrologic analysis for large areas is
recommended to improve processing time. Figure 6-45 provides an example showing reaches

selected for analysis (shown in red).

@ Hazus: Flood - CharlestonSC3 (Caset)
File Edit View Inventory Hazard Analysis Results Bookmarks Insert Selection Geoprocessing Customize Windows Help

Y T I I o — AT LT L=

=] ChosenReaches

RAVNQ R €=+ W-TN@ ' PLMBS TR

Table Of Contents 2 x ~ @l

EEEEE g

= = Llayers §
=l

= @ Reaches
= @ RegionDEM
Value
. High : 387.036

“Low: -54.0415

= [ CensusBlocks
[] Census Blocks
= Census Tracts
[ Census Tracts
= @ Hillshade

Value
High: 254

Low: 0

=] Study Region Boundary
[ Study Region Boundar|

-79.937 32.976 Decimal Degrees

v

Figure 6-45 Select Streams for Hydrology

When running hydrologic analysis on large stream networks, continue to add streams by editing the
scenario using the Edit Scenario dialog shown in Figure 6-46.
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New Scenario

Select map features to be included in
thescenario. Asinglescenario may
contain morethan one objecttype.

Map layer type

(®) River reaches

Map layer selection
Addto selection

Removefrom selection -
Clear selection

Saveselection

OK

Figure 6-46 Edit Scenario Dialog to Add Streams

Hazard | Analysis Results Bookmarks Insert Selection Geop

Once streams have been added into the scenario, select Hydrology from the Riverine menu as shown
in Figure 6-47.

Flood Hazard Type...
User Data
Develop Stream Network...

. ERE®E
TR

Scenario
Riverine | Hydrology
Coastal Deline Hydrology

Hydrology

Figure 6-47 Select Hydrology

The Process dialog (Figure 6-48) will appear and ask if the user wants to continue with the
processing. Click Yes to continue. Once the hydrologic analysis has started, the process cannot be
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Process

To ensure proper operation, canceling is not allowed.

o The proceeding analysis requires raster processing.
Continue?

Yes No

Figure 6-48 Hydrology Processing Dialog

Once the user has edited the scenario and added more streams for hydrologic analysis, the
Overwrite Existing Results dialog will appear (Figure 6-49). If the user selects Yes to overwrite, Hazus
will overwrite previous hydrology values, which requires more processing time. If the user selects No,
the new results will be appended to the previous results and stored.

Overwrite Existing Results

The output discharge-frequency table already contains
results for reaches in the current scenario,

Would you like to overwrite them?

Yes No

Figure 6-49 Overwrite Hydrology Dialog

Hydrologic analysis is only important for performing frequency-related flood analyses (i.e., 100-year
return period, annualized loss, etc.). If the user wishes to apply a specific discharge to the reach(es),
they should proceed directly to the Delineate Floodplain option on the Riverine menu and select
Single Discharge (see Section 6.5.2).

When running hydrologic analysis, the Hazus screen might go blank, or the Task Manager
Applications tab will indicate that Hazus is not responding. This is a common occurrence for any
process-heavy software. To see whether Hazus is still running, check the Task Manager Processes
tab and sort the CPU column in descending order. The “ArcMap.exe” process should be on top. If the
“System Idle Process” is constantly on top at 99-100%, Hazus is not responding. Also, check the
Performances tab and make sure the CPU Usage is not O over a period of time. Another option is to
open the Study Region folder (in “Details” view within Windows Explorer) and make sure the
FIHydrologyLog.txt file is updating by looking at the “Date modified.”
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6.5.1.2 Excluding Problem Reaches from Scenario

Problem reaches are reaches for which regression equations and/or data are not available. When
computing the flood hazard, analysis results for a specific return period or suite of return periods will
not be available for reaches designated as Problem Reaches. Input of discharges will be required to
develop the flood hazard grids for Problem Reaches.

Users have the option to set Hazus to automatically remove problem reaches (if they exist) from the
scenario after the hydrologic process by selecting the Automatically remove problem reach(es)
checkbox under Customize > Flood Options on the main Hazus menu bar, as shown in Figure 6-50.

Flood Options X

Startup Options ~ Raster Options ~ Automation  Repository

[] Always show DEM (if available)
[] &lways show computed Reaches (if available)
Open last Scenaro (if available)
[] Show redo analyses Warming message box{es)

Automatically remove problem reach(es)

CustomBuffer (default: 2000 m)
Cancel

Figure 6-50 Flood Options, Check Automatically Remove Problem Reach(es)

If the Automatically remove problem reach(es) checkbox is not selected, at the end of the hydrologic
process, a Remove Problem Reaches message will appear, as shown in Figure 6-51, to notify the
user that problem reaches exist in the scenario and to give the user the option to remove the
problem reaches from the scenario (with one click of Yes button).
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Remove Problem Reaches

This scenario contains reaches for which regression equations or data
are not available,

You are now given the option of having Hazus automatically remove
these problem reaches from the scenario,

Please note if you choose not to remove the problem reaches at this
time,

you will have to edit the scenario to exclude the problem reaches.

You may also choose to run return period analysis by discharge.

Would you like to remove all problem reaches from the current scenario
at this time?

Yes No

Figure 6-51 Notification and Option to Remove Problem Reaches

If the user selects No in the Remove Problem Reaches notification, but later wishes to remove
problem reaches, they can manually edit the scenario to exclude the problem reaches. This only
applies to cases where the problem reaches exist in the scenario.

To manually remove problem reaches, click on the Hazard menu, select Scenario, and then click
Edit. The Edit Scenario dialog will open, as shown in Figure 6-52. Click OK.

Edit Scenario X

Scenario name:

| Cagel

Description

Cancel

Figure 6-52 Edit Scenario Window
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Once the user clicks OK, all the reaches in the scenario will be highlighted in light blue. Click the
Remove Problem Reaches button (as shown in Figure 6-53), to remove all the problem reaches, and
then click the Save selection button. After the user clicks OK, the new scenario will be mapped,

shown in Figure 6-54.

@ Hazus: Flood - CharlestonSC3 (Casel
File Edit View lnventory Hazard Analysis Results Bookmarks Insert Selection Geoprocessing Customize Windows Help
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| Select or deselect map features o
(=] lndndzldinme scenario. Asingle g
| scenario may contain morethan one 2
2H Map layer type 7
=] E @ Riverreaches
Map layer selection
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=l El Removefromselection | - |
28 | RemoverotiemResches
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.d o=
< > |E-EI an ¢ > v
-80.489 33.007 Decimal Degrees
Figure 6-53 Edit Scenario Dialog to Remove Problem Reaches
— X
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Figure 6-54 Example Edited Scenario with Problem Reaches Removed
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The scenario is now ready to start hydraulics (Riverine > Delineate Floodplain) for the Chosen

Reaches. The hydrologic analysis does not need to be rerun because Hazus has already computed
discharges for non-Problem Reaches. If the hydrologic analysis is rerun, the results will remain the
same because the Problem Reaches have been removed from the scenario.

6.5.2 Delineate Floodplain

Once the hydrologic calculations are complete, the Delineate Floodplain option on the Hazard >
Riverine menu is enabled (Figure 6-55). Select Delineate Floodplain to initiate the hydraulic analysis.
The Riverine Hydraulic Analysis dialog in Figure 6-56 will appear. Use the Analysis Type pull-down
menu to select the type of hazard analysis to run.

Hazard | Analysis Results Bookmarks Insert Selection Geoprocessing

L

Flood Hazard Type... :| 7 v | e
User Data n ;_5 x@v @ -
Develop Stream Network...
Scenario >
Riverine 4 | Hydrology
Coastal » | Delineate Floodplain l‘_
a4

Delineate Floodplain

Delineate Floodplain

Figure 6-55 Select Delineate Floodplain

. Riverine Hydraulic Analysis

Analysis type: Single Return Period

Full Suite of Return Periods

L Single Return Period
Single Discharge
River reaches
Reach ID | Retum Period [yrs) | r-value A
100 0.140
1054 100 0140
1055 100 0140
1056 100 0.140
1057 100 0.140
1065 100 0.140
1066 100 0140
1067 100 0140
1086 100 0.140
1087 100 0.140
1089 100 0120
1092 100 0120
1098 100 0.140
1105 100 0.140
1109 100 nizn ™
OK

Cancel

Figure 6-56 Riverine Hydraulic Analysis Dialog
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1. Select Full Suite of Return Periods to calculate flood depths and floodplains for the 10-year, 25-
year, 50-year, 100-year, and 500-year return period floods on each of the stream reaches in the
scenario. Starting with the 500-year return period, the Flood Model will go through each selected
reach and develop a single 500-year flood depth grid. This process is duplicated for the other
four return intervals. This option is required for average annualized loss. The multi return period
depth grids developed by the level 1 flood hydrology and hydraulics methodology do not
consistently align with each other and could potentially affect flood risk assessment results. To
work around this issue, the grids can be exported and aligned using Esri’s Snap Raster feature.
The updated depth grids can then be imported back into Hazus as a user-defined grid for each
return period.

2. Select Single Return Period to specify a return period between 2 years and 1,000 years for which
the flood characteristics will be calculated. Choose different return periods for different stream
reaches, if desired. Depending on the user selection, the resultant grid will be a single return
interval for all reaches selected by the user, like option 1 above, or a single grid of mixed return
intervals for the selected reaches.

3. Select Single Discharge to input anticipated stream discharge levels for each stream reach. Like
option 2 above, the user can enter different discharges for each reach.

o If the user opts to run different return intervals or specific discharges for each reach in
their scenario, the Transportation Bridge analysis cannot be run because the return
interval for the reaches in question needs to be specified and has not been defined for a
single discharge analysis.

o The Single Discharge option can decrease the runtime significantly if data are available.

The final delineated floodplain should look like Figure 6-57 where only the selected reaches for the
scenario have flood depth grids and boundaries delineated.
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Figure 6-57 Example Riverine Hydraulic Analysis Results

6.5.2.1 Best Practices and Troubleshooting

The Delineate Floodplain analysis can take large amounts of time, especially when generating a
flood depth grid in Hazus rather than importing a grid. Several days of processing time are possible
with the Full Suite of Return Periods Analysis Type for an individual county. Some general guidance is
listed below for the Delineate Floodplain analysis; however, this is not an exclusive list of best
practices and troubleshooting for issues experienced during the Delineate Floodplain analysis.
Please contact the Hazus Helpdesk (see Section 1.5) for support regarding specific issues.

Blank Screen:

When running the hydraulic analysis, the Hazus screen might go blank, or the Task Manager
Applications tab will indicate that Hazus is not responding. This is a common occurrence for any
process-heavy software. To see whether Hazus is still running, check the Task Manager Processes
tab and sort the CPU column in descending order. The “CoreOfHydraulics.exe” process should be on
top. If the “System Idle Process” is constantly on top at 99-100%, Hazus is not responding. Also,
check the Performances tab and make sure the CPU Usage is not O over a period of time. Another
option is to open the scenario folder (in “Details” view within Windows Explorer) and make sure the
FIHydraulicsLog.txt file is updating by looking at the “Date modified.”

Grid Cell Sizes:

Using a smaller cell size could dramatically increase the processing time and the size of the output
raster. Resampling larger cells into smaller cells to allow a merged grid for Study Regions with
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different topographic source data may lead to issues in Hazus. The recommended approach would
be to run the multiple source depth grids separately in Hazus and then combine flood loss results

after all Hazus loss runs.

Reaches with Hydraulic Problems:

If running the hydraulics (i.e., Delineate Floodplain) is taking a long time, the hydraulic process may
be hanging (i.e., getting stuck on a couple of reaches so that it cannot finish the hydraulics). The

following instructions will help bypass the problem.

1. Look in the log (flHydraulicsLog.txt located in Scenario folder) and note any reaches (ReachlD)
that have many errors and did not successfully complete processing. Example below:

: ReachID: 1425 Core of Hydraulics

. modLevelOne - CoreOfHydraulics: Reach 100 of 267

modLevelOne - CoreOfHydraulics: Return period: 100

modLevelOne - CoreOfHydraulics: What-if:

modLevelOne - CoreOfHydraulics: Available memory: 1631.05 mb

modinitialBuffer - InitBuffer: Reach length = 0.2 km

modinitialBuffer - InitBuffer: Reference (downstream node) discharge: 3,981 cfs

modXSections - PlacelnitXsects:

modXSections - PlacelnitXsects:

modXSections - PlacelnitXsects:

modXSections - PlacelnitXsects:

modXSections - PlacelnitXsects:

modXSections - PlacelnitXsects:

modXSections - PlacelnitXsects:

modXSections - PlacelnitXsects:

modXSections - PlacelnitXsects:

Short centerline length: 964.462826043346 feet
Buffer 3 of 9
Buffer 4 of 9
Buffer 5 of 9
Buffer 6 of 9
Buffer 7 of 9
Buffer 8 of 9
Buffer 9 of 9

Cross section count: 3
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modXSections - InitialXSectElevs: Drainage area reset from 219.9631 to
140.0594

modXSections - InitialXSectElevs: Drainage area reset from 220.2029 to
140.0594

GeometryToFeatureClass: Feature class: LeftBuffer
GeometryToFeatureClass: Feature class: RightBuffer

modGeometry - CleanPolygonlislands: Input geometry is nothing, leaving early.
ModBoundsandEnds - ValidateFloodPolygon: Error Number: 91

ModBoundsandEnds - ValidateFloodPolygon: Error: Object variable or With block
variable not set

modGeometry - CleanPolygonlislands: Input geometry is nothing, leaving early.
modGeometry - IntersectABS: Input geometry #1 is invalid. No intersection.
modLimits - NewLimitsandCenterlines: Error Number: 91

modLimits - NewLimitsandCenterlines: ERROR: Object variable or With block
variable not set at 8

modLevelOne - CoreOfHydraulics: Error Number: 91

modLevelOne - CoreOfHydraulics: ERROR: Object variable or With block variable
not set at 20

modLevelOne - CoreOfHydraulics: Error Number: 91

modLevelOne - CoreOfHydraulics: ERROR: Object variable or With block variable
not set at 20

modLevelOne - CoreOfHydraulics: Error Number: 91

modLevelOne - CoreOfHydraulics: ERROR: Object variable or With block variable
not set at 20

modLevelOne - CoreOfHydraulics: Error Number: 91

modLevelOne - CoreOfHydraulics: ERROR: Object variable or With block variable
not set at 20

modWsePts - FinalWsePts: Error Number: 5
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modWsePts - FinalWsePts: ERROR: Invalid procedure call or argument at 2

modLevelOne - CoreOfHydraulics: WARNING: FinalWsePts failed, continuing
process using points from InitialWsePts and/or IncreaseWsePts

modLevelOne - CoreOfHydraulics: Error Number: 91

modLevelOne - CoreOfHydraulics: ERROR: Object variable or With block variable
not set at 45

modAddBack - AddBack: Entering
modAddBack - FilDEMMask: Error Number: 91

modAddBack - FilDEMMask: ERROR: Object variable or With block variable not set
at4

modAddBack - AddBack: Error Number: 91

modAddBack - AddBack: ERROR: Object variable or With block variable not set at
5

MakePermanent: Entering for grid: 1425

MakePermanent: Path:
C:\HazusData\Regions\CharlestonSC3\Hydraulics\Reaches\100

MakePermanent: Leaving
modAddBack - AddBack: Leaving
GeometryToFeatureClass: Feature class: 1425_cl
ExportGDBFClass: Error: Featureclass Reach1425ConvPGRP100 not found.
modLevelOne - CoreOfHydraulics: Leaving
2. Open the Attribute Table for the Chosen Reaches layer.
3. Search for the reach using the ArcID and highlight/select the problem reach.

4. Right click on the line of the selected reach and select Zoom to Selected as shown in Figure 6-58
below.
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Table O x

G- B By O x

—
FID * Shape * FID_ | arcid grid_code | from_node | to_node | Shape_Leng | MANNINGN | Shape_lL
1 | Polyline o] 1391 1683 1441 1491 4484.371768 0.14 4484
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3 | Polyline o 1415 1707 1506 1508| 2484.926273 0.18 2484
4| Polyline o] 1421 1705 1503 1521 8243.46171 0.14 824
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| 1722 1525 1531 2138.089977 0.035 213¢
: 1719 1521 1536 1918.067483 0.035 191¢€
@ Identify... 1729 1536 1525 1576.66617 0.035 157
| [ Select/Unselect 1725 1531 1541 1778.422251 0.035 177¢€
| 1455 1568 1536 12445023994 0.14 12445
(#F Zoom To Selected

4 Clear S >

B Zoom To Selected

g o Zoom to selected features.  Modlecteh
q *
= 4

Figure 6-58 Chosen Reaches Attribute Table, Zoom to Selected Reach

5. The map will now zoom into the reach selected. Zoom out of the map to locate where the
selected reach is on the map (Figure 6-59). Keep in mind what the reach looks like.
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Figure 6-59 Example Selected Chosen Reach (highlighted), Zoomed Out

Page 6-44




Hazus Flood Model User Guidance

6. Click on the Hazard menu, select Scenario, then click Edit.
7. Once the Edit Scenario tool is available, zoom in to the area where the problem reach is located.

8. Click Remove from selection and select the problem reach. The reach selected will be highlighted
in red.

9. Click Save selection.

10. After the selection has been saved, the problem reach will be dark blue and will be excluded
from the scenario.

11. Click OK.

12. If the scenario is a riverine/coastal scenario, the Shoreline Characterization dialog will appear
after edits are made to the scenario. The original parameters that were set for the shoreline(s)
are saved if the shoreline(s) wasn’t added/removed from the scenario. Select the Next and
Finish buttons if the existing parameters are desired.

13. The scenario is now ready to re-start hydraulics (Riverine\Delineate Floodplain) for the Chosen
Reaches. The hydraulics process will automatically rerun any reaches that did not successfully
process in the previous run, skip any reaches that have been successfully processed, and then
will continue on the last reach processed. If there were any reaches where the Task Manager
was used to stop Core of Hydraulics, repeat the steps to get past those reaches.

6.5.2.2 Failed Reaches

Failed reaches are reaches that have been processed in the hydraulics process, but do not produce
a flood depth grid. An error message will appear to notify the user when a reach fails during the
hydraulics process. Click the Close button on any errors and the hydraulics process will continue
processing the next reach in the queue. The FailedReaches layer will appear on the map after the
hydraulics process completes, as shown below in Figure 6-60.
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Figure 6-60 Example Failed Reaches (purple) on Map after Hydraulics Completed

The hydraulics process should complete even if there are failed reaches. The only reason the
hydraulics process will not complete is if a failed reach causes the hydraulics process to hang.

When running the analysis on a scenario with failed reaches, the analysis will only process in areas
where the depth grid exists.

6.6 Coastal

The Hazard / Coastal menu (Figure 6-61) provides the Flood Model coastal analyses for deriving
flood depths and boundaries (Delineation Floodplain) associated with the coastal flood elevations
and shoreline segments entered when defining the scenario.
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| Hazard i Analysis Results Bookmarks Insert Selection Geop

Flood Hazard Type... M8 Lf_#] - pe
User Data

Scenario >

Riverine »

Coastal » ” Delineate Floodplain ]

Delineate Floodplain L

Delineate Floodplain

Figure 6-61 Select Delineate Floodplain

6.6.1 Delineate Floodplain

To delineate the floodplain, select Delineate Floodplain from the Hazard > Coastal menu (Figure
6-61). The Coastal Hazard Analysis dialog will open (Figure 6-62). This dialog allows the user to
select from two coastal analysis options:

1. If the user selects Full Suite of Return Periods from the Analysis Type drop-down menu, Hazus
will calculate flood depths and floodplains for the 10-year, 25-year, 50-year, 100-year, and 500-
year return period floods for the entire shoreline in the scenario. The Flood Model will produce a
single flood depth grid for the shoreline for each of the five return intervals.

2. If the user selects Single Return Period from the Analysis Type drop-down menu, the user can
specify any flood return period between 10 and 500 years for which the flood characteristics will
be calculated. Unlike the riverine hazard, the user cannot choose different return periods for
different shoreline segments. The Flood Model will produce a single flood depth grid for the
shoreline for the selected return period.

e Coastal Hazard Analysis X
Analysis type: Single Return Period v Fill All
Output cell size: | 26.1976452688588 fyt

Coastal Shorelines

Shore 1D Return Period [vrs) A

Fa— T
3

100
1 100
1 100

< >

Available memory: 2481 mb. Estimated use: 120

Figure 6-62 Coastal Hazard Analysis Dialog

Page 6-47




Hazus Flood Model User Guidance

6.6.2 User Inputs, Shoreline Segmentation and Characterization

The Hazus user is required to supply certain information for the coastal Flood Model to run - without
this information no coastal hazard results can be produced. More accurate user-supplied information
will result in more accurate coastal hazard and economic loss results. The following user inputs are
required:

=  Study region, over which coastal flood hazards will be computed. The study region boundaries
must be specified by the user at the beginning of the analysis. Given the region, the model will
determine which coastal counties are part of the study region and will locate default data (in
look-up tables) associated with each coastal county.

= Shoreline(s). The user must identify the start and end of shorelines across which coastal flooding
will propagate. Except for small islands, the user may choose to divide each shoreline into two or
more segments. Segmentation of shorelines is not required (if a shoreline is not segmented, the
entire shoreline will be attributed with the same shore characterization and 100-yr flood
conditions). Coastal flood return period(s). The user may specify one or more return periods
between 10 years and 500 years. A separate coastal hazard analysis will be performed for each
return period specified. In the Combined Wind and Flood (Coastal Surge) Model, one input
required to characterize each segment of a shoreline if “No Waves” was selected in the
Hurricane Surge analysis is:

o Wave exposure, used to determine whether coastal wave analyses will be run, and if so,
to determine the peak wave period Tp at the shoreline from a look-up table (default wave
period data are listed for 364 coastal counties in the table): - open coast (full exposure),
with over-water fetches > 50 miles - moderate, with fetches between 10 miles and 50
miles - minimal, with fetches between 1 and 10 miles - sheltered, with fetches less than
1 mile (Note that if a shoreline or segment is classified as sheltered, the model assumes
that no damaging waves will affect that shoreline or segment, and no dune/bluff erosion
or wave analyses will be computed along transects associated with that shoreline or
segment - a stillwater flood surface will be computed by the model.)

Two inputs are required to characterize 100-yr flood conditions at each shoreline segment (See
Figure 6-63:

= (1) 100-yr Flood Stillwater Elevation (SWEL), obtained from the FIS report or from another source

= (2) 100-yr wave setup, obtained from the FIS report or from another source. In addition, the user
may edit certain parameters calculated by the model:

= (3) Other stillwater elevations (ft): the model calculates values for the 10, 50 and 500-yr based
on the 100-yr value and default flood elevation ratios; the user may specify site specific values
from the FIS or another source.
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(4) Significant wave height Hs at shore (ft): the model assumes depth-limited wave heights at all
shorelines and exposures; the user may specify a value less than the depth-limited height.

Shoreline Characteristics

Current shoreline:

< Previous Shoreline 1 of 4 Next Shoreline > Apply to All Segments
100-Year Flood Conditions
100-year stillwater elevation o Other stillwater elevations (ﬂp
Elevation (ft): T 10-yr: 6.4| 500-yr [ 123
Elevation includes wave setup? 50-yr: 88
@ Yes (O No Significant wave height at shore (ﬂ}o
2
Wave Setup (ff): @ Depth limited

D User-defined

Vertical datum

Vertical datum:  |NGVD29

Other name:

Cancel < Back Finish

Figure 6-63 Required Shoreline Inputs

The coastal Flood Model will take the user inputs and default data, then create a stillwater flood
surface throughout the entire study region (i.e., the coastal model will: 1) overlay a stillwater flood
surface over the DEM, and 2) identify and remove any isolated pools without a hydraulic connection
to the flood source). Subsequent erosion and wave analyses will be used to determine where the

flood surface will lie above the stillwater surface. Figure 6-64 illustrates the overall coastal hazard
modeling process.
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User Inputs | Overlay stillwater flood surface
on study region

¢ Studvregion
o Shoreline(s), shoreline segments
* Retumperod(s), n, tobe analyzed I
+  Waveexposure (in Coastal Surge “No Study region detenmines coastand

Waves” analysisin HU Model) coastal counties analyzed. Model
o 100-YT SWEL gets default data for each county,
o 100-Yr Wave setup e.g:

¢ Transectlength
Wave Height Model

¢ Calculate SWEL ~ wave setup profile along transect. Calculate
stillwater depth, d;, along transect

s+ Compute significant wave height H, along transect

s+  Compute depth-limited wave heights (H: = 0.49 d;) along transect

»  Create wave crest profile using lesser of depth-limited andwave
height vahies

¢ Calculate wave height flood surface

* Identifv waveheight floodhazard zones

Determine controlling flood surface (stillwater and wave
height). Identify flood depths and flood hazard zones.

Figure 6-64 Overview of Hazus Coastal Flood Hazard Modeling Process

6.6.3 Best Practices and Troubleshooting

Coastal floodplain delineation in the Flood Model is much less likely to have issues than riverine
analysis. However, memory issues can still influence a larger coastal analysis. At the bottom of the

Page 6-50




Hazus Flood Model User Guidance

Coastal Hazard Analysis window (Figure 6-62

e Coastal Hazard Analysis

Analysis type: Single Return Period

Output cell size:  26.1976452688588

Coastal Shorelines

Shore ID

Fa— T
3

1 100
1 100

< >

Retumn Period [yrs)

N

Available memory: 2481 mb. Estimated use: 120
mb

OK

Fill Al

Cancel

Figure 6-62), Hazus indicates how much virtual memory is available on the machine and the
estimated virtual memory that will be used for the coastal analysis. When running the coastal flood
delineation analysis, the Hazus screen might go blank, or the Task Manager Applications tab will
indicate that Hazus is not responding. This is a common occurrence for any process-heavy software.
To see whether Hazus is still running, check the Task Manager Processes tab and sort the CPU
column in descending order. The “ArcMap.exe” process should be on top. If the “System Idle
Process” is constantly on top at 99-100%, Hazus is not responding. Also, check the Performances
tab and make sure the CPU Usage is not O over a period of time. Another option is to open the
scenario folder (in “Details” view within Windows Explorer) and make sure the FICoastallLog.txt file is

updating by looking at the “Date modified.”
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Section 7. Model Menu: Analysis

After Hazus has calculated the hazards, it will need to run the loss analysis to provide damage
estimates using the Analysis menu (Figure 7-1). As with other Hazus Flood Model menus, items
grayed out represent functionality not currently available given the type of analysis being conducted
and the completion of required prerequisite analysis steps.

In a Hazus loss analysis, the characteristics of the structures and people of the Study Region are
analyzed for vulnerability to the flood or floods that have been calculated in the scenario. Default
depth damage functions, which estimate percent damage relative to the depth of floodwater as
measured from the top of the first finished floor (riverine) or bottom of the first floor (coastal), are
provided within the Hazus program. Other damage functions are also included in the Flood Model to
estimate damages to vehicles, utility components, and transportation bridges.

Analysis | Results Bookmarks Inser

Damage Functions >
Restoration Functions >
Parameters »

Average Annualized Loss

Run

Figure 7-1 Analysis Menu

7.1 Damage Functions

The Analysis menu options reflect the functions that will be used to estimate damage of various
types. This section discusses the options on the Analysis > Damage Functions menu (Figure 7-2).

Analysis | Results Bookmarks Insert Selection Geoprocessing Cust
| Damage Functions » Buildings...
Restoration Functions 4 Essential Facilities...
Parameters » Transportation Systems... 1
Average Annualized Loss Utility Systems...
Vehicles...
i PR

Figure 7-2 Analysis > Damage Functions Menu
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Select Buildings from Analysis > Damage Functions menu. The General Building Stock Depth-
Damage Functions table shown in Figure 7-3 will appear. The Structure table provides information on
the default damage function associated with each specific occupancy class (e.g., RES1) and
subclass (e.g., RES1, one-story, no basement). Scroll to the right to see the percent of damage,
expressed in terms of building replacement cost, estimated at different water depths. The pull-down
menus at the top of the window allow the user to view the default damage functions for the flood
hazard types (Zone V, Coastal Zone A, and riverine) and other occupancy classes (e.g., COM1, AGR1,
IND1). Click on the different tabs at the top (Structure, Contents, Inventory) to view default damage
functions associated with building structures, and their contents, for all specific occupancy types and
inventory for selected occupancies (e.g.,COM1, IND1-6, AGR1).

|® ' General Building Stock Depth-Damage Functions - ] X
Stiucture  Contents  Inventary
Static c2
[Fiveine v|  |Rest v]
Occupancy SpecificOccupld Source Description Stories ~
1 [REST IR11M USACE - 'WR ohe story, no baseme 1 Story
2 RES1 R11B BCAR -Jan 2011 one story, w/ baseme 1 Story R
3 RES1 R12N Flé two floors, no baseme 2 Story
4 RES1 R12B Fla [MOD.) two floors, w/ baseme 2 Story
5 RES1 R13N FlA three or more floors, n 3 Story
[ RES1 R13B Fla [MOD.) three or more floors, w 3 Story
7 RES1 R1SN Fla zplit level, no baseme Split Level
8 RES1 R15B Fla& (MOD.) split level, w/ baseme Split Level
W
< >
Library Close Print

Figure 7-3 Building Depth-Damage Functions by Occupancy (Riverine) Table

Click on the Library button in the lower left corner of the Building Stock Depth-Damage Functions
window. The Structure Damage Functions library shown in Figure 7-4 will appear. Viewing the library
of damage functions allows the user to review other damage functions applicable to the occupancy

Page 7-2




Hazus Flood Model User Guidance

under consideration relative to the current default, as well as replace the current default with

another function from the library.

Structure Damage Functions
Occupancy: ‘
specificOccupld Stories

1 R1IN 1 Story

2 [R11B 1 Story

3 R12N 2 Stary

4 R12B 2 Stary

5 R13N 3 Story

6 [R13B 3 Story

7 RISN Split Level
8 |R1SB Split Level

4]
User Defined

Basement

HORORORO

-4t 3t | -2f
000, 000 000
000, 000 000

i

0ft 1ft 21t 3ft
3.000 13.00
0.00 18.00

23.00

2200 25.00

1
2
3

i

Default Source: USACE - I'wR

Current Source: FIA

41t

32.00) 4000/ 47.00
28.00

Sit Eft 71t aft 9ft | 10f

30.00

53.00 59.00) B3.00 67.00

31.00 40.00) 43.00 4300 4500 460

71.00, 730

Selected Source:

Occupancy
RES1

RES1

source

Damagefn
one floor. no basemer

comment

ID

S—

Figure 7-4 Building Depth-Damage Function Library

Cancel

Select

The Library uses color codes to help the user identify any changes and selections they may make in
the dialog. The Library dialog comprises three windows.

The left window is the navigation window where the user can change between occupancies,
foundation heights, and number of stories. This window allows the user to select a specific
occupancy (e.g., RES1) and shift through the potential foundation types (slab on grade, fill,
basement, crawlspace, pier, post, and pile) and number of stories typical for the selected specific
occupancy (one-story, two-story, three-story, split level for residential and low-, mid-, and high-rise for
non-residential) within that occupancy. The sub-occupancies displayed in the window (shown in the
first column) are a form of shorthand that identifies the occupancy class. The shorthand was
developed by taking the first letter and numeric values of the specific occupancy name (e.g., RES1
becomes R1 and COM10 become C10); this is concatenated with the value for the number of stories
(e.g., two-story becomes 2 and low-rise becomes L), and finally the existence of a basement derives
the last value (e.g., structures with a basement get a B and structures without a basement get an N).
Therefore, the residential occupancy classified as RES1 with one story and no basement becomes
R11N while the commercial occupancy classified as COM10, mid-rise, with a basement becomes

C10MB.

The bottom right window is where the library of damage functions is displayed for the user to view
and/or select. The user can browse between damage functions for the foundation and number of
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stories by selecting the sub-occupancies in the left column grid. In this case, Figure 7-4 displays all
the functions available for the sub-occupancy R11N (RES1, one- Story, with no basement). Selection
of C10MB (COM10, mid-rise, with basement) would display an entirely different set of damage
functions in the grid on the lower right.

Finally, the window in the upper right allows the user to make comparisons and selections among
the damage functions. The first row in the grid will always display the Hazus default function in red.
The second line in the upper right grid displays the “current” function or any damage function that
the user has highlighted in the lower window. To help the user view the current function, it is also
displayed in green text. The user may want to use the “current function” line as a way of displaying a
function and directly comparing it to the default damage function. Figure 7-4 displays a U.S. Army
Corps of Engineers (USACE) New Orleans District damage function (highlighted row 10) for RES1,
one- story, slab on grade. The third row in the upper right grid displays any function the user may
have “selected” as their damage function. That is, a damage function the Flood Model will use rather
than the default damage function. This is how the user can override the default damage functions
with either a library function that they believe better represents the local area or a custom function
they have built themselves as described below. Figure 7-5displays a USACE New Orleans District
damage function (lower right grid, blue text RES1, one-story, pier foundation) that was selected in
place of the default function. If the user chooses, they may use one of the library functions to build
their own custom damage function. To do this, click the User Defined button in the lower left corner
of the dialog. When the user selects this button, the Flood Model takes the highlighted damage
function, if any, and opens an editable dialog (Figure 7-6) for the user to make modifications. The
Flood Model inserts the damage function description from the starting damage function the user
selected (or the default damage function if none is selected) and adds a comment that identifies the
original source damage function. This allows the user to remember where they started the process.
The user is required to enter a source (or name) for the damage function. Editing of the Enter
Comment or Enter DmgFn Description fields is not recommended.
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Structure Damage Functions X
Oceupancy: [REST P tio] 3n [ -2r | A | of [ am | 2k | 3f | af | 5r | er | 7t | 8k | 9t | 10k
- - - 1 | 000 000 000 300 1300 2300 3200 4000 4700 5300 59.00 6300 67.00, 71.00 730
s s pac ficcoupl s tes S vt B asemant sl & 2 | 000] 000 000 000 18.00 2200 2500 2800 30.00 31.00 4000 4300 4300, 4500 460
1 R1IN 1 Story O 3| T T
2 R1iB 1 Story M S —
3 RI2N 25toy ] {]
4 R12B 2 Story M
5 AIN 3 Story O i ) i ,
& R 35ty = Default Source: USACE - 'wR Current Source: FlA Selected Source:
7 R1SN Split Level O
8 R1SB Split Level ™
| Occupancy source | DamageFn D comment E
1 |HES1 Fla one floor, no basemer 105
2 |RES1 UUSACE - Chicago | one story, no baseme: 132
3 |RES1 USACE - Galveston | one story, no baseme 139
4 |RES1 USACE - wWR one story, no baseme 129
5 |RES1 USACE - New Orlean’ one story, Pier founds 142
6 |RES1 USACE - Mew Orlean’ one story, Pier foundz 141
7 |RES1 USACE - Mew Orlean’ one story, Pier foundz 153
8 |RES1 USACE - Mew Orlean’ one story, Slab found: 144
9 |RES1 USALE - New Drlean! one Slab found: 143
10 |REST USACE - New Orlean one Slab found: 154
11 |REST LISACE - New Orlean one Structure 150
12 |REST USALE - New Orlean one Structure. 149
13 |RES1 USACE - St. Paul one story, Structure 173
[+ 1[5 BEGY LISACE . \Wilminatan | ane ston Pile forinda 178
7 . -
User Defined Select 0K Cancel
Figure 7-5 Building Depth-Damage Function Library User-Defined Option
User Defined Library X
Occupancy Type: REST Stories: 1 Story Basement Enter Source: “ ]
Enter DmaFn Description: Ione floor, no basement, Structure, A-Zone Enter Comment: ‘ [Started trom Fl&) ‘
Enter Percent Damage
4R -3 22/t 1R OR 16 21t 3ft 5ft Bt 7h aft Sft  10f | 1R | 12 13 | 14f | 15HR -
1 [ 000] ooo 000 000 1800 2200 2500 2800 3000 31.00 4000 4300 4300 4500 4600 47.00 4700 4900 50.00 50.00
4]
Cancel

Figure 7-6 Editing Dialog for User-Defined Function Development

If the user has decided to select a new damage function for use in the Flood Model, the entry dialog
will highlight the damage function to remind the user that a default function is not being used. Figure
7-7 shows how the change would appear in the entry dialog as compared to that shown earlier in this
section in Figure 7-3 using a User-Defined Depth-Damage Function.
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[87 General Building Stock Depth-Damage Functions — O X
Stucture  Contents  |nventory
Static c2
Riverine v RES1 v
Occupanc Specific0ccupld Source Description Stories ~
1 RES1 R11N USACE - 'wWR one story, no baseme 1 Story
2 RES1 A11N User Defined one floor, no basemer 1 Story 51
3 RES1 R11B BCAR -Jan 2011 one story, w/ baseme 1 Story R
4 RES1 R12M Fl& two floors, no baseme 2 Story
5 RES1 R12B Fl& (MOD.) two floors, w/ baseme 2 Story
[ RES1 FA13M Fla three or more floors, n 3 Story
7 RES1 R13B Fla (MOD.) three or more floors, w 3 Stary
8 RES1 R1SN Fla, zplit level, no bazeme Split Level
9 RES1 R1SE Flé (MOD.) split level, w/ baseme Split Level
v
< >
Close Print

Figure 7-7 Building Depth-Damage Function Dialog with a User-Defined Damage Function

Similar default damage functions are available for other facilities from the Damage Functions menu,
as shown in Figure 7-8 below. The damage function dialogs for Essential Facilities function in the
same way as those discussed above for the General Building Stock. In most cases, the damage
functions available in the Essential Facilities dialog area also available for the Government
structures in GBS. The Essential Facilities dialog does not have an inventory tab because the
Essential Facilities occupancies do not produce inventory for sale.

Analysis | Results Bookmarks Insert Selection Geoprocessing Cust
| Damage Functions » | Buildings...
Restoration Functions 4 Essential Facilities...
Parameters » Transportation Systems... 1
Average Annualized Loss Utility Systems...
Vehicles...
Run '} ,:?\ =

Figure 7-8 Analysis > Damage Functions Menu
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The Transportation Systems damage function dialog looks slightly different as there is only a
structure damage function (no contents or inventory), and the dialog’s tabs allow the user to shift
between highway, railway, and light rail facilities.

= Currently, the Flood Model has damage functions for bridges only related to highway, railway,
and light rail facilities.

= The Transportation Systems damage functions for bridges are based on return period. An
analysis cannot be performed on bridges if the user assigns mixed return periods on the selected
reaches. In other words, if the user assigns a different return period to each reach, or a single
discharge on the reaches, the Flood Model will not be able to analyze the bridges.

Figure 7-9
8" Damage Functions for Transportation System - Bridges Only — O >
Highwway  Raiway Light Rail
Highway Damage
Occupancy SpecificOccupld Source Dezcription ScourPatential ~
1 [HwE1 HwE150 HazuzDilk Continuouz Span 1 [
2 Hw/B1 Hw/B151 HazuzDifl Continuouz Span 1 [
3 Hw/B1 Hw'B152 HazuzDit Continuous Span 2 [
4 Hw/B1 Hw/B153 HazuzDilt Continuouz Span 3 [
q Hw/B 2 Hw B 250 HazusDilk Continuous Span 1 [
E HwBZ2 Hw/B251 HazuzDilE Continuouz Span 1 [
7 HwWEB2 HwWEB252 HazusDilk Continuous Span 2 [
g Hw/B 2 HwWEB253 HazusDiflk Continuouz Span 3 [
q Hw/B 3 HwEB 35U HazusDlE Single Span ] c
10 H'w/B 3 Hw/B 351 HazusDflk Single Span 1 ‘
11 HWwWE3 HWB352 HazuszDflk Single Span 2 £
12 Hw/B3 Hw/B353 HazuzDilk Single Span 3 ‘
13 HwW/B 4 HwWEB45U HazuszDflk Single Span i c
14 HwB4 Hw/EB451 HazuzDlk Single Span 1 <
15 HwWEB 4 HwWE452 HazuszDflk Single Span 2 b
16 Hw/B4 HwEB453 HazuzDlk Single Span 3 <
17 Hw/B5 Hw/BRSLI HazuzDilk Continuouz Span 1 [
12 HwWEBS HwWEBRS1 HazusDilk Continuous Span 1 [
19 HwWEBS HwWEBRS2 HazusDiflk Continuouz Span 2 [
20 HwWEBS HwWEBRS3 HazusDlE Continuous Span 3 [
1 Hw/BE Hw/BESL HazuzDilk Continuouz Span 1 [
) HwEBE HwEBES1 HazuzDifl Continuouz Span 1 [
3 Hw/BE Hw'BBS2 HazuzDit Continuous Span 2 [
el | HwEBE Hw/BES3 HazuzDilt Continuouz Span 3 [w
£ >
Library Cloze Frint

Figure 7-9 shows the Damage Functions for Transportation System table, which has the same table
columns for highway, railway, and light rail facilities.
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Darmage Functions for Transportation System - Bridges Only — O >
Highway  Raiway Light Rail
Highway Damage
Specificlcoupld Source D ezcription ScourPatential [
1 [HwE1 |HwE150 HazuzDilk Continuouz Span 1 [
2 HwE1 HwEB151 HazusDilk Continuous Span 1 [
3 HwE1 HwWEB152 HazusDiflk Continuouz Span 2 [
4 HwE1 HwWEB153 HazusDlE Continuous Span 3 [
5 Hw/B 2 HwB 250 HazusDflk Continuouz Span 1 [
E HwB2 HwB251 HazuzD it Continuous Span 1 [
7 Hw/B2 Hw'B252 HazuzDit Continuous Span 2 [
g HwB2 HwB253 HazuzDilt Continuouz Span 3 [
q Hw/B 3 Hw/B350 HazusDilk Single Span 1 <
10 HWwWE3 HWwWE 351 HazuszDflk Single Span 1 b
11 HwE3 HwWEB352 HazuzDlk Single Span 2 <
12 H'wW/B 3 HWwWB353 HazuszDiflk Single Span 3 b
13 HwiB4 Hw/EB45L HazuzDilk Single Span ] c
14 H/B 4 Hw/B 451 HazusDflk Single Span 1 ‘
15 HwWE4 HwWEB452 HazuszDflk Single Span 2 £
16 Hw/B4 Hw/B453 HazuzDilk Single Span 3 ‘
17 Hw/B5 Hw/BRSL HazuzDifl Continuouz Span 1 [
18 Hw/B5 Hw/B551 HazuzDit Continuous Span 1 [
19 Hw/B5 Hw/BRS2 HazuzDilt Continuouz Span 2 [
20 HwWEBS HwWEBSS3 HazusDilk Continuous Span 3 [
21 Hw/BE Hw/BESLI HazuzDilk Continuouz Span 1 [
22 HwWEBE HwWEBES1 HazusDilk Continuous Span 1 [
23 HwWEBE HwWEBES 2 HazusDiflk Continuouz Span 2 [
24 H'wWEBE HwWEBES3 HazusDilk Continuous Span 3 [
£ >
Library Cloze Frirt

Figure 7-9 Transportation Damage Function Table

Figure 7-10 shows the Damage Functions For Utility System table. As with the Transportation
Systems, the tabs allow the user to choose the utility type for review. Note, there are no

communication facility damage functions currently available.
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Damage Functions For Utility System - O X
Potable Water ‘\wWasteWater 01 Natwal Gas Electric Power Communications
Potable W/ ater Damage

SpecticOccupld Source Desciiption EquipmentHt | A
1 PDFLT PDFLT Hazus Dflt 3

2 PPPL PPPL Hazus Dflt Large Pumping Plant | 3 Er

3 PPPM PPPM Hazus Dflt Medium Pumping Plar 3 Er

4 PPPS PPPS Hazus Dfit Small Pumping Plant £ 3 Er

5 PSTAS PSTAS Hazus Dflt Elevated Tanks 80

B PSTBC PSTBC Hazus Dfit Buried Concrete Tank 3 e

7 PSTGC PSTGC Hazus Dfit At Grade Concrete Tz 0 Tz

8 PSTGS PSTGS Hazus Dt At Grade Steel Tank 0 Te

9 PSTGW PSTGW Hazus Dflt At Grade Wood Tank 0 Te
10 PWE PwWE Hazus Dflt Wells 3 As
11 PWTL PWTL Hazus Dflt Large Gravity or Oper 3 Sc
12 PwW T Pw/Th Hazus Dflt Medium Gravity or Op 3 Sc
13 PwWTS PWTS Hazus Dflt Sall Gravity or Open 3 Sc
14 PCVS PCVS Hazus Dflt Contral Yaults and Ca 0 Er

Figure 7-10 Utility Facility Damage Function Table

Figure 7-11 shows the Damage Functions For Vehicles table.
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B | Damage Functions For Vehicles - O X
Yehicles Damage

ehicleType Yehicleld Source Description ehicleHeight Defaull

1 {Car \Passenger Car ABS Default Damaage to car from It 1.50

2 LtTik Light Truck ABS Default Damage to light truck 2.70

3 HyTrk Heawy Truck ABS Default Damage to heawvy b 5.00
v

< >

Library Close Print

Figure 7-11 Vehicle Damage Functions Table

7.2 Restoration Functions

The Flood Model provides restoration functions for GBS and Essential Facilities. The GBS restoration
functions are discussed in the Analysis > Parameters menu discussion, as the GBS values are
included in the Direct Economic parameter tables. Built from the restoration timelines for the related
GBS occupancies, the Essential Facilities restoration models provide the user with a general
indication of the maximum restoration time for 100% operations. Obviously, there will be a great deal
of effort to quickly restore Essential Facilities to full functionality and therefore, this will be an
indication of the maximum downtime.

Selecting Essential Facilities from the Analysis / Restoration Functions menu (Figure 7-12) opens the
dialog shown in Figure 7-13. In this case, the figure shows the dialog on the Medical Care Facilities
tab. The Restoration Functions are editable, and the user can adjust the MaxDaysToRestoration
column and the FunctionalDepth column (scroll to the right). These values are based on the depth of
flooding at the specific facility (the latitude and longitude).
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Analysis | Results Bookmarks Insert Selection Geoprocessing

Average Annualized Loss

Run

Figure 7-12 Analysis > Restoration Functions Menu

Damage Functions e @ @ B3| e
| Restoration Functions » | Essential Facilities...
Parameters »

MaxD aysToRestoratic ~

[® 7 Restoration Functions For Essential Facilities
Medical Care Facilities Emergency Centers  Schools
Medical Care Facilities
EssntFlyClass FltyD escription MinimumDepth | MaximumD epth
1 EFHL JLarge Hospital [greater tk -4 0
2 EFHL Large Hospital [greater th 0 4
3 EFHL Large Hospital [greater th 4 g
4 EFHL Large Hospital [greater th 8 25
5 EFHM Medium Hospital (50 to 1 -4 0
6 EFHM Medium Hospital (50 to 1 0 4
v EFHM Medium Hospital (50 to 1 4 8
8 EFHM Medium Hospital (50 to 1 g 25
9 EFHS Small Hospital (less than -4 0
10 EFHS Small Hospital (less than 0 4
1 EFHS Small Hospital (less than 4 g
12 EFHS Small Hospital (less than 8 25
13 EFMC Medical Clinics and Labs -4 0
14 EFMC Medical Clinics and Labs 0 4
15 EFMC Medical Clinics and Labs 4 8
16 EFMC Medical Clinics and Labs g 12
17 EFMC Medical Clinics and Labs 12 25
18 MOFLT Default for Medical -4 0
19 MOFLT Default for Medical 0 4
20 MDFLT Default for Medical 4 8
21 MDFLT Default for Medical 8 25
<
|

Close

Print

Figure 7-13 Essential Facilities Restoration Functions Table

7.3 Parameters

There are several parameters the user may want to view and/or modify before starting the analysis.
This section walks the user through the available parameters. Every effort has been made to provide

Page 7-11




Hazus Flood Model User Guidance

default values wherever possible, which allow the model to perform most requested analysis without
user intervention.

The Analysis > Parameters menu appears in Figure 7-14. The menu provides access to the default
parameters used in the analysis of Debris, Shelter, and Direct Economic. Shelter is currently disabled
due to ongoing data updates, as shown in Figure 7-14, but is anticipated to be re-enabled in the
future.

Analysis | Results Bookmarks Insert  Selection  Geocprocessing

[ Darnage Functions 3

Restoration Functions 3 ﬂ m m ™ EP” 3
| Parameters J Debris...

Average Annualized Loss Shelter...

Direct Economic...

Figure 7-14 Analysis > Parameters Menu

Selection of the Debris menu item opens an editable Debris Parameters dialog (Figure 7-15) that
allows the user to view the default debris values. Debris is estimated based on the depth of flooding
within the structure, like the estimation of GBS damage, specific occupancy, and whether the
foundation has a footing or a slab. The user can use the combo boxes to shift between specific
occupancies and the foundation types.

Debris is estimated in three main classifications that align loosely with the earthquake models
method of classification: finishes (dry wall, flooring, insulation, etc.), structure (framing, walls,
exterior cladding), and foundation weight (concrete slab, concrete block, or other foundation). Unlike
the earthquake model, where moderate damage may still result in the foundation being removed,
flooding requires the structure to be considered substantially damaged before the foundation is
removed. The weights are in tons per thousand square feet of the structure.
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| Debris Parameters Weight in Tons - O X

Foundation Type:
Slab RES1

Specificd cocupanc: FoundationType MinimumD epth MaximumDepth FinishweightPeiTho ~
2 RES1 Slab 4 8
3 RES1 Slab 8 25
v
< >

Close Print

Figure 7-15 Debris Analysis Parameters Table

The Shelter menu item opens the Shelter Parameters dialog (Figure 7-16), which has multiple tabs
and provides access to the various parameters that affect the number of people who are evacuated
(displaced) and the number of people who require short-term sheltering. Because the Flood Model
does not address flooding, such as flash flooding or long-duration flooding, Hazus assumes that the
local authorities will have time to alert the residents and evacuate directly from the areas that will
flood. This means any portion of a census block that is flooded initially is assumed to have all of the
residents removed from the area. Ultimately, the level of damage within the GBS and the
characteristics of the population will determine how many people require short-term sheltering.

The first tab shown in Figure 7-16, Evacuation, allows the user to modify the Evacuation buffer in
feet, which will have a direct impact on the results. This value is a buffer the Flood Model will add to
the current floodplain polygon. In essence, this value will increase the floodplain polygon by the
distance input by the user, such as 500 feet. The model will then estimate the total population within
the floodplain boundary and the buffer to identify the displaced population.
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Shelter Parameters

Evacuation  \ttiity Factors Weighting Factors  Modification Factors

Access

Depth atwhich ingress/egress is resfricted: feet

Evacuation Zone

Evacuation buffer (additional perimeter evacuated for public safy): l:l feet

Figure 7-16 Shelter Evacuation Parameter Dialog

The Utility Factors tab (Figure 7-17) includes a field for Utility Outage, which is used in the
determination of the short-term shelter needs. The lack of utilities to areas impacted by floodwaters
will prevent some of the displaced population from immediately returning to their homes. This
percentage is used to help determine the short-term needs.

Shelter Parameters

Evacuation Utiity Facters  weighting Factors  Modification Factors

Utility Outage

Percent of Affected Households I:I %

Ok Cancel

Figure 7-17 Shelter Utility Outage Parameter Dialog
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The Weighting Factors tab is a table where the user can modify the weighting applied to certain
demographic characteristics for the population. As shown in Figure 7-18, the table includes income
and age. These values should sum to 1.0.

Shelter Parameters

Evacuation Utility Factors Weighting Factors | Modification Factors

Clazz Dezeription ImpartanceFact)  SortOrder
1 Income Weighting Factor 1.00 1
2 |Aw Age ‘weighting Factor 0.00 2

0K Cancel

Figure 7-18 Shelter Weighting Factors Table

The Modification Factors tab could be considered more closely than the weighting factors sub
classification weighting. For example, Figure 7-19 shows the Age modification factors. These factors
allow the user to place more emphasis or increase the importance of a certain population (under 16
or over 65), thereby increasing the number of people in those categories who would seek shelters.
The dropdown menu also provides the user with access to the Income weighting. Like the Age factor,
this weighting allows the user to place more importance on those residents that fall within a certain
income range. These values should be between 0.0 and 1.0.
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Shelter Parameters

Evacuation Utility Factors  Weighting Factors Modification Factors

Wodification Factors for

Age ~

Dezcnption

ImportanceF act

SortOrder

Population under 18-pears ald

0.05

Population between 13 and 64-pears old

0.z

Fopulation ower 64-pears ald

0.50

| oK H Cancel |

Figure 7-19 Shelter Weighting Factors Table

The Direct Economic parameter menu item opens the Direct Economic Loss Parameters dialogs,
which includes three tabs shown in Figure 7-20 through Figure 7-22. This dialog provides the user
with access to the default parameters that control the estimation of the direct damages to the GBS.
This includes the impact of the flood scenario on the wages, income, inventory, and maximum
restoration time for the GBS. The Business Inventory tab defines the amount of inventory in the
Study Region based on the square footage of specific Census blocks.
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Direct Economic Loss Parameters — O X
Business Inventory Restoration Time  Income Loss Data
Annual Gross Sales ($ per sqft) v
Business Sales Amount
AnnualGrossSalesPerSqFt A
1 COM1 56.00
2 COom2 81.00
3 IND1 750.00
4 IND2 238.00
5 IND3 733.00
[ IND4 £90.00
7 INDS 453.00
2] INDE 808.00
9 AGR1 156.00
W
< >
. Clse | Pint

Figure 7-20 Direct Economic Loss - Business Inventory Table

The GBS restoration functions define the maximum amount of time it should take for any given
specific occupancy to be restored. For example, the RES1 restoration time is based on the depth of
flooding within the structure (Figure 7-21). In the case of RES1, even though the water has not fully
entered the structure, it may take up to a year to clean up the structure, replace any sub-flooring that
may be damaged, obtain permits, and perform inspections. This is a maximum timeline meant to
provide a conservative estimate for the losses associated with the restoration process.
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Direct Economic Loss Parameters — O X

Business Inventory  Restoration Time Income Loss Data

BT |REST

Figure 7-21 Direct Economic Loss —Restoration Time Table

Figure 7-22 shows some additional parameters used to develop the direct losses for wages and
capital income presented in the GBS economic losses.
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[® 7 Direct Economic Loss Parameters — | X
Business Inventory  Restoration Time  Income Loss Data
[Fens v
Rental Loss
Specificd ccupancy RentalCostsPerSgFtPertMonth RentalCostsPerSaFtPeriDay A
1 [REST | 083 0.03
2 RES2 058 0.02
3 RES34 0.74 0.02
4 RES3B 0.74 0.02
5 RES3C 0.74 0.02
5 RES3D 0.74 0.02
7 RES3E 0.74 0.02
g RES3F 0.74 0.02
9 RES4 2.48 0.08
10 RESS 0.50 0.02
11 RESE 0.9 0.03
12 COM1 1.4 0.05
13 COmM2 058 0.02
14 COM3 1.65 0.06
15 COM4 1.65 0.06
16 COMS 207 0.07
17 COMB 165 0.06
18 COM7? 1.65 0.06
10 kg N7 nnz ¥
< >
Close Print

Figure 7-22 Direct Economic Loss - Rental, Owner-Occupied, Wages and Capital, and Recapture

Features Table

7.4 Annualized Loss

Average Annualized Loss Menu, shown in Figure 7-23 is the calculation step where a user combines
a series of individual recurrence interval losses into an additional estimate for annual loss. This
analysis is performed after the user has performed a Full Suite of Return Periods analysis in the
Hazard menu (as shown in Figure 7-24 and Figure 7-25 for riverine and coastal analysis) and has

performed a loss analysis in the Analysis > Run menu.
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Analysis | Results Bookmarks Insert Selection

Damage Functions >
Restoration Functions >
Parameters >

|| Average Annualized Loss | _'

Average Annualized Loss

Calculate GBS, UDF Average
Annualized Loss

Run

Figure 7-23 Analysis > Average Annualized Loss Menu

. Riverine Hydraulic Analysis X
Analysistype Full Suite of Return Periods v Fill Do
Output cell size: | 24.3053649656442 v]

River reaches
Reach D | Retun Periods [yrs] | nevalue A
34 10, 25,50, 100, 500 0.040
v
OK . Cancel

Figure 7-24 Riverine Flood Full Suite of Return Periods Analysis

. Coastal Hazard Analysis X
Analysis type: Full Suite of Return Periods v Fill All
Output cell size: - 24.3053649656442 v

Coastal Shorelines

Shore ID Feturn Periods [yrs) ~
1 10, 25, 50, 100, 500 v
< >
Available memory: 2167 mb. Estimated use: 60 mb OK Cancsl

Figure 7-25 Coastal Flood Full Suite of Return Periods Analysis
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The user has the option of performing average annualized loss calculations for either GBS or UDF
data, as shown in the Average Annualized Loss Analysis dialog (Figure 7-26) if loss analysis has been
performed for the five required events (10-, -25-, 50-, 100-, and 500-year).

Average Annualized Loss (AAL) Analysis X

Select which analysis to run:

General Building Stock [GBS) direct economic loss [

User Defined Facilities [UDF) loss

Figure 7-26 Average Annualized Loss Analysis Dialog

If the user has not performed the required loss analysis prior to trying to run the Average Annualized
Loss (AAL), Hazus will produce the error messages shown in Figure 7-27 and Figure 7-28 requesting
the user to perform these prerequisite analyses.

hzFlAnnualize.modAnnualize.InitFloodAnalysisFn@ 12 X

The General Building Stock (GBS) Analysis has not been run!
Please run the GBS Analysis, before Annualyzed Loss Analysis.
[Hint: Missing ReturnPeriod 10, 25, 50, 100, 500 GBS Analysis
Calculations)

Figure 7-27 Average Annualized Loss GBS Error Dialog

hzFlAnnualize. modUDFAnnualize.InitFloodAnalysisFn@ 12 et

The User Defined Facility (UDF) Analysis has not been run!
Please run the UDF Analysis, before Annualyzed Loss Analysis.
[Hint: Missing ReturnPeriod 10, 25, 50, 100, 500 UDF Analysis
Calculations)

Figure 7-28 Average Annualized Loss UDF Error Dialog
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7.5 Combined Wind and Flood

The Combined Wind and Flood menu (Figure 7-29) will become activated when a user has performed
the prerequisite analysis for a storm surge analysis in both the Hurricane Model and Flood Model.
See O for more details on all the steps to perform this type of analysis.

Analysis‘ Results Bookmarks Insert Select

Damage Functions rr G
Restoration Functions » &
Parameters »

Average Annualized Loss
Combined Wind and Flood... |
Run Combined Wind and Flood...

Calculate Combined FL/HU
Coastal Surge Economic Loss

Figure 7-29 Analysis > Combined Wind and Flood Menu

7.6 Run

Once the user parameters have been selected or modified, select Run from the Analysis menu
(Figure 7-30). The Analysis Options dialog shown in Figure 7-31 will appear. Clicking on the plus and
minus signs will expand and collapse the lists of available options, respectively. Click on the boxes of
the desired analysis options. A check mark will appear to indicate the options have been selected.
Note that some analysis options have pre-requisite analysis requirements and selection of those
options will automatically check the box of the prerequisites. At the bottom of the dialog, Hazus will
indicate the amount of hard drive disk space available on the machine and the percentage of the
Study Region’s database that has been used thus far. The Study Region’s database has a limit of 10
GB; therefore, if the percentage used is more than 50%, less than 5 GB of space is available for the
analysis.

Analysis | Results Bookmarks |nser

Damage Functions »
Restoration Functions »
Parameters »

Average Annualized Loss

I[ Run

Figure 7-30 Analysis > Run Menu
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Analysis Options

8¥4 General Building Stock Damage and Loss
----- E| Building and Content Damage (%)
----- E| Direct Economic Loss (3) (Bldg, Cont, Inv)
----- E| Damage Building Count
| ke E| Depreciated Building and Content Loss (3)
|_| @Essentlal Facilities
. ~[“IMedical Care
----- E| Police Stations
----- E| Fire Stations
----- E| Emergency Centers
S E| Schools
----- El User Defined Structures
I:I @Transponatlon Systems
|_| El Utility Systems
=] IZI Potable Water
P M Facilties
EI @Wastewater
P M Faciities
= IZI 0il
P M Facilties
EI E| Natural Gas
----- E| Facilities

u @Dlrec’( Social Loss
----- E| Shelter

C:\ has 9521 GB free space;

Select All

Deselect All

Cancel

Figure 7-31 Select Analysis Options

Hazus can conduct default analysis runs for the following items:

= GBS

= Essential facilities

= Selected infrastructure, including highway bridges and water systems
= Debris

= Shelter requirements
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The types of baseline data provided for the Study Regjon limit the type of analysis that can be run. To
run a What-If analysis, the same analysis must have been run from the hazard menu. When the
desired analysis options have been selected, click OK.

=  When running the Analysis, the Hazus screen might go blank, or the Task Manager Applications
tab will indicate that Hazus is not responding. This is a common occurrence for any software
process-heavy software. To see whether Hazus is still running, check the Task Manager
Processes tab and sort the CPU column in descending order. The “sqlservr.exe” process should
be on top. If the “System Idle Process” is constantly on top at 99-100%, Hazus is not
responding. Also, check the Performances tab and make sure the CPU Usage is not O over a
period of time. Another option is to open the scenario folder (in “Details” view within Windows
Explorer) and make sure the FlAnalysisLog is updating by looking at the “Date modified.”

= Running the Analysis, specifically the General Building Stock Damage and Loss, can take up too
many hours to process and successfully complete.

For users who would like to view the intermediate analysis completion status, go to Customize menu
and select Flood Options (as shown in Figure 7-32), and check the Show redo analyses Warning
message box(es) checkbox (example shown in Figure 7-33). This option only applies if the user is
redoing the analyses.

| Customize I Windows Help

Toolbars »

Extensions...

Add-In Manager...

Customize Mode...

Style Manager...

Flood Options...

ArcMap Options...| Flood Options... |

Flood specific options |

Figure 7-32 Customize > Flood Options Menu
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Flood Options X

Startup Options  Raster Options ~ Automation  Repository

[] &lwways show DEM [if available)
[ Always show computed Reaches [if available)
[] Open last Scenario (if available)
[] Show reda analyses Waming message box(es)

[] Automatically remove problem reach(es)

CustomButfer (default: 2000 m)

Figure 7-33 Check Show Redo Analyses Warning Message Box(es)
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Section 8. Model Menu: Results

The Results menu (Figure 8-1) within Hazus has several analysis types and menus from which to

choose. These options enable the user to select the appropriate results to review in the Study

Region. This section explains each selection and menu to further the user’s understanding of these

options.

Results | Bookmarks |Insert Selection G

View Current Scenario Results By...

Flood Hazard Maps »

General Building Stock »
Combined Wind and Flood Loss
Essential Facilities

User Defined Facilities

Transportation Systems

Utility Systems

Vehicles

Debris

Shelter

Summary Reports...

Figure 8-1 Results Menu

8.1 View Current Scenario Results By

Once the loss analysis has been run, the next step is to view the results. The first option within the
Results menu (Figure 8-2) is View Current Scenario Results By.... Selecting this option activates the
View Results by window shown in Figure 8-3. Select one of the Available Results. No results can be

viewed until a hazard analysis has been selected.

Results | Bookmarks |Insert Selection Geoprocessing

| View Current Scenario Results By... |h e
‘ v

Flood Hazard Maps

View Current Scenario Results By...

General Building St
Combined Wind an
Essential Facilities
User Defined Facilities
Transportation Systems
Utility Systems
Vehicles

Debris

Shelter

Summary Reports...

Figure 8-2 Results > View Current Scenario Results By Menu

Select Return Period to Report on
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View Results by X

Scenario Mame:
Case2

Scenario Description:

Available Results:
100 v

Mix0 denotes deterministic results.

‘What-[f Options:

Cancel

Figure 8-3 Select Available Results

8.2 Flood Hazard Map

To map the flood depth grid and floodplain boundary for the current scenario and return
period/discharge(s), select Thematic Map of Depth from the Results > Flood Hazard Maps menu.
The flood depth grid will be displayed in blue. The floodplain boundary will be displayed in orange in
the main Flood Model map window.

In the Results > Flood Hazard Maps menu (Figure 8-4), Thematic Map of Depth, will add specific
symbolized layers to the map. This option can be used as visualization tools to understand specific
spatial patterns in the Study Region.

Hazus automatically maps the flood depth grid and floodplain boundary for one of the available
depth grids when the hazard is computed, but other flood depth grids are available to be mapped
that may have also been computed.
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Results ] Bookmarks Insert Selection Geoprocessing Customize Windd
View Current Scenario Results By...
y BlFg
| Flood Hazard Maps »|  Thematic Map of Depth
General Building Stock » L
Combined Wind and Flood Loss

Essential Facilities

User Defined Facilities

Transportation Systems
Utility Systems
Vehicles

Debris

Shelter

Summary Reports...

Figure 8-4 Results > Flood Hazard Maps Menu

8.3 General Building Stock Damage

To view and map the general inventory damage results By Occupancy, By Building Type, By Count
and by Economic Loss, select General Building Stock from the Results menu (Figure 8-5).

Results | Bookmarks Insert Selection Geoprocessing Customize

View Current Scenario Results By...
- B3y
Flood Hazard Maps »
| General Building Stock | By Occupancy

Combined Wind and Flood Loss By Building Type
Essential Facilities By Count
User Defined Facilities Economic Loss »

Transportation Systems
Utility Systems
Vehicles

Debris

Shelter

Summary Reports...

Figure 8-5 Results > General Building Stock Menu
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8.3.1 General Building Stock Damage by Occupancy

Select By Occupancy from the Results > General Building Stock menu (Figure 8-5

Results I Bookmarks Insert Selection Geoprocessing Customize
View Current Scenario Results By...
w v B3

Flood Hazard Maps »

| General Building Stock > | By Occupancy
Combined Wind and Flood Loss By Building Type

Essential Facilities By Count

User Defined Facilities Economic Loss »
Transportation Systems :
Utility Systems
Vehicles

Debris

Shelter

Summary Reports...

Figure 8-5) to view and map tabular damage results by Census block. The user can show values
based on General Occupancy Type or Specific Occupancy Type and choose between Pre-Firm, Post-
Firm, or All (Figure 8-6). Select a specific column with numeric values in the table and click the Map
button to map the tabular results. Mapped results will appear on the screen.
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Results for
Scenario: CaseZ

[ General Building Stock Damage By Occupancy (thous. sq ft)

Return period: 100

General Occupancy Type I l Residential ~ ] l Pre-Firm v
CensusBlock = TotalSquareFootage SqFtwithSubstantialDmg UndamagedSgFt = SgFtl »
1 | 100050501031000 I 0.00 0.00 0.00
2 100050501031002 018 0.00 011
3 100050501031003 0.06 0.00 0.02
4 100050501031006 0.00 0.00 0.00
5 100050501032001 20,49 2.37 11.30
g 100050501032003 0.00 0.00 0.00
7 100050501032004 0.00 0.00 0.00
g 100050501032005 1.46 0.08 1.07
9 100050501032009 010 0.00 0.08
10 100050501032010 014 0.01 007
11 100050501032016 5.04 0.32 358
12 100050501032017 0.00 0.00 0.00
13 100050501032018 0.00 0.00 0.00
14 100050501032019 791 0.68 493
15 100050501032020 0.00 0.00 0.00
16 100050501032021 0.00 0.00 0.00
17 100050501032022 0.00 0.00 0.00
18 100050501032023 14 0.11 051 v
< >N
Close Map Print

Figure 8-6 General Building Stock Damage Results Table

8.3.2 General Building Stock Damage by Building Type

Select By Building Type from the Results > General Building Stock menu (Figure 8-5) to view and
map tabular damage results for wood, steel, concrete, masonry, and manufactured housing types.
Select the desired type of structure from the drop-down menu (Figure 8-7).
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[87 General Building Stock Damage By Building Type (thous. sq ft) — O X

Results for

Scenario: CaseZ Return period: 100

l Pre-Firm

Wood

Steel

Concrete

Masonry

ManufHousing TotalSquareFootage SgFtwithSubstantialDmg UndamagedSqFt SgFtl ~
1 ]1 00050501031000 I 0.00 0.00 0.00
2 100050501031002 0.00 0.00 0.00
3 100050501031003 0.00 0.00 0.00
4 100050501031006 0.00 0.00 0.00
5 100050501032001 13.00 0.00 8.00
& 100050501032003 0.00 0.00 0.00
7 100050501032004 0.00 0.00 0.00
8 100050501032005 1.00 0.00 1.00
9 100050501032009 0.00 0.00 0.00
10 100050501032010 0.00 0.00 0.00
1 100050501032016 4.00 0.00 3.00
12 100050501032017 0.00 0.00 0.00
13 100050501032018 0.00 0.00 0.00
14 100050501032019 5.00 0.00 3.00
15 100050501032020 0.00 0.00 0.00
16 100050501032021 0.00 0.00 0.00
17 100050501032022 0.00 0.00 0.00
18 100050501032023 0.00 0.00 0.00 v

< >

Close Map Print

Figure 8-7 Building Stock Damage by Building Type Table

8.3.3 General Building Stock Damage Count

Select By Count from the Results > General Building Stock menu (Figure 8-5) to view and map the
tabular damage results. For County by Occupancy, the user can choose counts based on General
Occupancy Type or Specific Occupancy Type and choose between Pre-Firm, Post-Firm, or All (Figure
8-8). Use the drop-down menus to select which data to view.
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[87 General Building Stock Damage Count

Count By Occupancy  Count By Type

Results for
Scenario; Case2

Retumn period: 100

General Occupancy Type | | Residential v | | Pre-Firm

CensusBlock TotalBuildings BldgswithSubstantialDmg UndamagedBldas PctDr ~

1 100050501031000 I 0 0 0

2 100050501031002 0 0 0

3 100050501031003 0 0 1]

4 100050501031006 0 0 0

5 100050501 032001 8 1 7]

B 100050501032003 0 0 0

7 100050501 032004 0 0 1]

a8 100050501032005 0 0 0

] 100050501032009 0 0 0

10 100050501032010 0 0 1]

1 100050501032016 1 0 1

il 100050501032017 0 0 1]

13 100050501032018 0 0 0

14 100050501032019 2 0 2
15 100050501032020 0 0 1] v
< >

Close Map Print

Figure 8-8 General Building Stock Damage Count Table

8.3.4 General Building Stock Direct Economic Losses

The Economic Loss option on the Results > General Building Stock menu allows the user to view and
map economic losses for the GBS by Census block by full replacement value and depreciated

replacement value. Direct economic losses can be displayed By General Occupancy, By Specific
Occupancy, By General Building Type, and Total as shown in Figure 8-9. Use the drop-down menus to

select which data to view.
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Results for

Scenario; Case2

[® 7 Direct Economic Losses for Full Replacement Value (thous. dollars)

By General Occupancy By Specific Occupancy By General Building Type  Total

Retumn period: 100

I Pre-Firm v |
Residential
Cammercial
Industrial
Agriculture
Religious/Non-Profit TotalLoss BuildingLoss ContentsLoss Inventaryloss RelacationC ~
G avernment 0 0 0 0
E-:Iuc-ahllc-n . S—— 3 1 1 0
3 100050501031003 0 0 0 0
4 100050501031006 0 0 0 0
5 100050501032001 121 368 439 0
B 100050501032003 0 0 0 0
7 100050501 032004 0 0 0 0
8 100050501032005 39 12 16 0
] 100050501032009 0 0 0 0
10 100050501032010 4 2 2 0
1 100050501032016 174 50 70 0
il 100050501032017 0 0 0 0
13 100050501032018 0 0 0 0
14 100050501032019 407 125 185 0
15 100050501032020 0 0 0 0 v
< >
Close Map Print

Figure 8-9 General Building Stock Direct Economic Losses for Full Replacement Value (By
General Occupancy) Table

8.3.5 Viewing and Exporting Data from Building Stock Damage Menus

To view the damage results spatially, click on one of the columns with loss values, such as the
TotalLoss field (Figure 8-10) on the desired tab of the Direct Economic Losses table and click the
Map button at the bottom right-hand corner. The data will appear a new data layer within the Hazus
project and Esri shapefile format. Once the data are listed in the Flood Map Table of Contents, right
click on the data layer, and export the data to a shapefile, which can be imported into database and

spreadsheet programs for further analysis.

To view the damage results only in a tabular format, right click within the table and select Export

(Figure 8-11).
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Results for

Scenario; Case2

[87 Direct Economic Losses for Full Replacement Value (thous. dollars)

By General Occupancy By Specific Occupancy By General Building Type  Total

Retumn period: 100

Pre-Firm v
 CensusBlock TotalLoss BuildingLoss ContentsLoss Inventorploss  RelocationC A
1 |100050501031000 0 0 0
2 |100050501031002 3 1 1 0
3 |100050501031003 0 0 0 0
4 | 100050501031006 16 1 ] 0
5 | 100050501032001 1554 387 564 0
6 |100050501032003 0 0 0 0
7 | 100050501032004 0 0 0 0
8 |100050501032005 B4 18 23 1
9 |100050501032009 0 0 0 0
10 100050501032010 1 7 23 1
11 |100050501032016 576 68 164 0
12 |100050501032017 0 0 1] 0
13 100050501032018 447 47 73 0
14 |100050501032019 442 13 136 0
15 | 100050501032020 0 0 0 0 v
< > B
Close Map Print

Figure 8-10 General Building Stock Direct Economic Losses for Full Replacement Value (Total)

Results
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[87 Direct Economic Losses for Full Replacement Value (thous. dollars) — O X
By General Occupancy By Specific Occupancy By General Building Type  Total
Results for
Scenario; Case2 Retumn period: 100
| v [ |Pre-Firm v
CensusBlork Tatall ne= Ruildinal nes ContentsLoss InventoryLoss RelocationC ~
1 10005050103 Add New Record 0 i
B D B Delete Selected Records ! :
3 10005050103 CrTE e e 0 0
4 10005050103 Import 0 0
5 10005050103 439 0
§ 10005050103 Export 0 0
7 10005050103 Dats Dchiorumn 0 0
8 10005050103 N 16 0
] 10005050103 Meta Data 0 0
10 100050501 0320710 1 p 2 0
1 100050501032016 174 50 70 0
il 100050501032017 0 0 0 0
13 100050501032018 0 0 0 0
14 100050501032019 407 125 185 0
15 100050501032020 0 0 0 0 v
< >
Close Map Print

Figure 8-11 Export General Building Stock Direct Economic Losses for Full Replacement Value
(By Occupancy) Results

8.4 Combined Wind and Flood Loss

When a storm surge analysis has been performed (see O for all steps in that type of analysis), the
user can show results from the combined wind flood loss analysis with the Combined Wind and
Flood Loss menu (Figure 8-12). Selecting that menu will bring up the window shown in Figure 8-13,
which includes some of the fields that Hazus calculated when a combined hurricane wind and flood
surge analysis was conducted, where results are shown for each hazard type individually and the
weighted combination. The combined losses are weighted based on how each hazard type
contributes to overall damages, with flood hazards typically damaging the lower portions of a
structure (foundation, lower floors) and hurricane wind hazards typically damaging upper portions of
a structure (roof, upper floors). Refer to the Hazus Flood Model Technical Manual (FEMA, 2024) and
the Hazus Hurricane Model Technical Manual (FEMA, 2024) for more details on how the combined
results are calculated.
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Results | Bookmarks |Insert Selection C

View Current Scenario Results By...
Flood Hazard Maps
General Building Stock

Combined Wind and Flood Loss

Essential Facilities

User Defined Facilities
Transportation Systems
Utility Systems
Vehicles

Debris

Shelter

Summary Reports...

Figure 8-12 Results > Combined Wind and Flood Loss Menu

[ Combined FL/HU Surge Direct Economic Losses For Full Replacement Value - O X
By General Occupancy By Specific Occupancy By General Building Type  Total

Results for

Scenario: CharlestonSC Return period: Mix0

Residential v [ IPre-Firm v ]

CensusBlock | BldgFloodLoss BldgwindLoss BldgCombLoss ContFloodLoss Contw ~

1 450190020031014 0.00 21.51 2151 0.00
2 450190026041015 0.00 420,03 42003 0.00
3 450190028021005 0.00 345.44 345.44 0.00
4 450190031072002 0.00 413,98 41398 0.00
5 450190043004027 0.00 24.33 2433 0.00
6 450190050001229 15.00 51.40 6327 8.00
7 450190058002052 0.00 11.84 11.84 0.00
8 450190020041039 193.00 258.66 42933 112.00
9 450190020062043 0.00 141.92 141.92 0.00
10 450190025023083 0.00 2869 2869 0.00
11 450190026042006 0.00 8.95 8.95 0.00
12 450190028011027 0.00 121.05 121.05 0.00
13 450190046081005 17.00 48.65 62.25 10.00
14 450190050003063 0.00 31.79 3N79 0.00
15 450190055002002 0.00 133.10 13310 0.00 v

< >l

Close Map Print

Figure 8-13 Combined FL/HU Surge Direct Economic Losses for Full Replacement Value (By

General Occupancy) Table
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8.5 Essential Facilities

Essential Facilities results, selected in Figure 8-14 and shown in Figure 8-15, allow the user to view
and map losses and damages to Essential Facilities, including Medical Care Facilities, Emergency
Centers, and Schools. See Section 8.3.5 for general methods to create maps and export data from

the Flood Model results.

B 3=

User Defined Faciliti

Utility Systems
Vehicles

Transportation Systel

Essential Facilities
View Essential Facility Results

Debris
Shelter

Summary Reports...

| Results i Bookmarks Insert Selection Geoprocessing
1 View Current Scenario Results By...
Flood Hazard Maps

General Building Stock
Combined Wind and Flood Loss

Figure 8-14 Results > Essential Facilities Menu

Medical Care Facilties  Emergency Centers  Schools

Results for
Scenario: CharlestonSC

[®7 Essential Facilities Damage and Economic Loss (thous. dollars)

- O X

Return period: Mix0

FacilityN ame

EfClass Description

ControlingHazard A

ROFER HOSPITAL

EFHL

Large Hospital [greate

SC000102 PALMETTO LOWCO

EFHM

Medium Hospital (S0

Close

/|

Mep || Pint

Figure 8-15 Essential Facilities (Medical Care Facilities) Table
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8.6 User-Defined Facilities

User-Defined Facilities results, selected in Figure 8-16 and shown in Figure 8-17, allow the user to
view and map losses and damages to individual UDFs. See Section 8.3.5 for general methods to
create maps and export data from the Flood Model results.

Results | Bookmarks Insert Selection Geoprocessing C
“LalF=1"

View Current Scenario Results By...
Flood Hazard Maps >
General Building Stock >

Combined Wind and Flood Loss

Essential Facilities

User Defined Facilities

Transportation Systel e, Defined Facilities

Utility Systems

Vehicles

View User Defined Facility Results

Debris
Shelter

Summary Reports...

Figure 8-16 Results > User-Defined Facilities Menu

[87 User Defined Facilities Loss - U X
Results for
Scenario: cese2 Retum perod: 100
BldgCost ContentCost BldgDmgPct = ContDmgPct | BldglossUSD ContentLossUSD Iny A
1 $102,751.73 $102,751.73 46.00 75.00 47,265.80 77.063.80
2 $105,433.38 $105,433.38 46.00 75.00 48.493.35 79,075.03
3 $528.552.63 $528,552.63 46.00 75.00 243.134.21 396.414.47
4 $175,557.56 $175,557.56 46.00 75.00 80,756.48 131,668.17
5 $434,230.91 $434,230.91 46.00 75.00 199.773.82 325.718.18
B $387,226.00 $387,226.00 46.00 75.00 178,123.96 290,413.50
7 $6.417,598.50  $3.208,799.25 21.00 56.00 1.347 B95.69 1.796,927.58
8 $585,344.50 $292,672.25 71.00 74.00 415,594.60 216577 47
9 $202,413.41 $101,206.70 71.00 74.00 143,71352 74,892.96
10 $472503.72 $236,251.86 71.00 74.00 335.477.64 174,826.38
11 $818,377.25 $409,188.63 71.00 74.00 581.047.85 302,799.58
12 $808,856.94 $808,856.94 46.00 75.00 37207419 B06.642.70
13 $292,7685.13 $146,392.56 21.00 56.00 51,484.88 81,979.684
14 $454,912.84 $454,912.84 46.00 75.00 209,253.91 34118463
15 $207,293.58 $207,293.58 46.00 75.00 95,355.05 155,470.18
16 $244,108.53 $244,108.53 22.00 100.00 53.703.88 244108.53
17 $1,482,191.75 $741,095.88 21.00 56.00 311,260.27 41501369
18 $3,273,864.50  $1636,932.25 21.00 56.00 £87.511.55 916,682.06
19 $1,733,631.00 $866,815.50 21.00 56.00 364,062.51 48541668
20 $3651,72275  $1,825,861.38 21.00 56.00 76E.861.78 1,022,482.37
21 $1,195,762.25 $537,881.13 21.00 56.00 251,110.07 33481343
22 $1,035,402.69 $517.701.34 21.00 56.00 217,434.56 289,912.75 %
e #7AA AR AR 44 44T A4A AR A4 AN cr an 4nd A7A An Fam Ann o4 > ml
Close Map Print

Figure 8-17 User-Defined Facilities Loss Table
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8.7 Transportation Systems

Transportation Systems results, selected in Figure 8-18 and shown in Figure 8-19, allow the user to
view and map losses and damages to transportation systems, including Highway, Railway, Light Rail,
Bus, Port, Ferry, and Airport. However, losses from flood will only be calculated for bridges and only
as they relate to scour. See Section 8.3.5 for general methods to create maps and export data from

the Flood Model results.

Results | Bookmarks |Insert Selection Geoprocess

View Current Scenario Results By...
Flood Hazard Maps

General Building Stock
Combined Wind and Flood Loss
Essential Facilities

User Defined Facilities

O %

Transportation Systems

Summary Reports...

Utility Systems | Transportation Systems
Vehicles View Transportation System
Debris Results

Shelter

Figure 8-18 Results > Transportation Systems Menu

[ Transportation System Damage and Economic Loss (thous. dollars) — O X
Highway Railway Light Rail Bus Port Femy  Airport

Results for

Scenanio; cssed Return period: 100

Highway Bridges v|

Highwa d BridgeMName BridgeClass Description FailureProb Lo: A
1 HIOOOEE? KAHANA STRM/AKAF HWB3 Single Span | (Not H 5.00
2 HIODOE72 UKUMEHAME STRI HWB3 Single Span | (Not H, 1.00
3 HIDDOE?3 HONOKAHUA STRM HwB22 Continuous Concrete, 025
4 HIDDOE?S WaIKAPL STRM — HWB10 Continuous Concrete, 025
L) HIDDOES3 K&IPOIOI STRM HwB10 Continuous Concrete, 025
[ HID0O708 00PUOLA STRM  HWB3 Single Span | (Not HY 1.00
7 HIDO0711 FPUDHOKAMOA STR HWB10 Continuous Concrete, 0.25
] HIooo721 EAST WAILUAIKI ST HWB3 Single Span | (Not Hy, 1.00
9 HID0O756 KEAHUAMNI GULCH HWB3 Single Span | (Not Hy, 1.00
10 HI000757 HAPAPA GULCH  HWwB3 Single Span | (Not H, 1.00
1 HIDOD763 KaMALD-LUNMD STF HWB22 Continuous Concrete, 0.25
12 HIDOO773 KAINALL STRM(KUF HWB3 Single Span | (Not Hy 1.00
13 HIOOT141 PUOHOKAMOA STR HDFLT Default Bridge 0.25
14 HIDOT150 EAST WAILUAIKI ST HDFLT Default Bridge 0.25
15 HIDo1202 00PUOLA STRM ~ HDFLT Default Bridge 0.25 v
< >
Close Map Print

Figure 8-19 Transportation Systems Damage/Economic Loss (Highway) Table
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8.8 Utility Systems

Results | Bookmarks Insert Selection Geoproces

View Current Scenario Results By... h | g;
Flood Hazard Maps »
General Building Stock 3

Combined Wind and Flood Loss

Essential Facilities

User Defined Facilities

Transportation Systems rl.:

| Utility Systems |
Vehicles Utility Systems
Debris View Utility System Results
Shelter
Summary Reports...

Utility Systems results, selected in Figure 8-20
Figure 8-20 and shown in Figure 8-21, allow the user to view and map losses and damages to utility
systems, including Potable Water, Wastewater, Oil, Natural Gas, Electric Power, and
Communications. See Section 8.3.5 for general methods to create maps and export data from the
Flood Model results.

Results | Bookmarks Insert Selection Geoproces

View Current Scenario Results By... h i El
Flood Hazard Maps >
General Building Stock 3

Combined Wind and Flood Loss

Essential Facilities
User Defined Facilities

Transportation Systems rL:

| Utility Systems |
Vehicles Utility Systems
Debris View Utility System Results
Shelter
Summary Reports...

Figure 8-20 Results > Utility Systems Menu
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Utility System Damage and Economic Loss (thous. dollars)

Potable Water ‘Waste Water 0l Matural Gas  Electic Power  Communications

Results for
Scenario: csse

Retum period: 100

Table Type: |Washe \Water Treatment Plants

F. ame | UtiFcltyClass

Description

US ARMY CORPS OI'WDFLT Default Facility

US ARMY CORPS OI'wWDFLT Default Facility

Cose | M || Pin

Figure 8-21 Utility Systems Damage/Economic Loss (Waste Water Treatment Plants) Table

8.9 Vehicles

Vehicles results, selected in Figure 8-22 and shown in Figure 8-23, allow the user to view and map
losses and damages to vehicles by Census block and for either night or day times. See Section 8.3.5
for general methods to create maps and export data from the Flood Model results.

ResultsiBookmarks Insert  Selection

View Current Scenario Results By...

Flood Hazard Maps

General Building Stock
Combined Wind and Flood Loss

Essential Facilities
User Defined Facilities

Transportation Systems
Utility Systems

Debris |y oticles

View Vehicular Results
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Figure 8-22 Results > Vehicles Menu

[®7 Vehicle Damage and Economic Loss (dollars) — O X
Damage Loss

Results for

Scenario: csse2 Retumn period: 100

Day v

CensusBlock VehicleType TotalD amagedVehicles TotalUndamagedvehicles ~
1 [Eoosooicoior Joa 0 0
2 150090301001017  LtTrk 0 0
3 150090301001018  Car 2 0
4 150090301001018  LtTrk 1 0
5 150090301001024 Car 76 0
B 150090301001024  HvTrk 5 0
7 150090301001024  LtTrk 56 0
8 150090301001030  Car 1 0
9 150090301001030  HvTik 0 0
10 150090301001030  LtTrk 0 0
11 150090301001032  Car 16 0
12 150090301001032  HvTrk 1 0
13 150090301001032  LtTrk 12 0
14 150090301001035 Car 2 0
15 150090301001035  LtTrk 2 0
16 150090301001036  Car 2 0 v
< >

Close Map Print

Figure 8-23 Vehicle Damage and Loss (Damage) Table

8.10 Debris

Debris results, selected in Figure 8-24 and shown in Figure 8-25, allow the user to view and map
finish, structural, and foundation building debris results by Census block. See Section 8.3.5 for
general methods to create maps and export data from the Flood Model results.

Results | Bockmarks Insert Selection (.'Q

View Current Scenario Results By...
Flood Hazard Maps »
General Building Stock >
Combined Wind and Flood Loss
Essential Facilities

User Defined Facilities

Transportation Systems FL:
Utility Systems

Vehicles

Debris

Shelter Debris

Summary Reports,| View Debris Results
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Figure 8-24 Results > Debris Menu

[#7) Debris Generation

Results for

Scenario: csse

d X

Return period: 100

CensusBlock TotalTons FinishTons StuctureTons FoundationT ons A
1 37.02 27.30 4273 26.93
i 150090301001018 582.73 162.43 257.60 162.70
3 150030301001024 4,268.31 1.499.67 1,696.91 1.071.73
4 150030301001027 13250 37.07 58.43 36.94
5 150030301001030 634.90 179.45 279.15 176.30
B 150090301001031 59.49 21,97 23.00 14.52
7 150090301001032 1,235.40 351.10 541.93 34231
] 150090301001035 105.24 31.36 45.28 2860
] 150090301001036 203.08 56.47 89.86 56.75
10 150090301001039 101.03 3010 4347 27.46
1 150090301001043 1,143.98 BES.47 293.28 185.23
12 150090301001044 87227 24717 38312 241.97
13 150090301001045 514.47 148.02 224 B0 141.85
14 150090301001046 965.43 266.41 428.43 270,59
15 150030301001056 18393 110,05 45.28 28.60
16 150030301001064 53.43 21.97 23.00 14.52
17 150030301001066 59.49 21.97 23.00 1452
18 150030301001069 150.99 40.74 6757 4268
19 150090301001070 59.49 21,97 23.00 14,52
20 150090301001072 0.00 0.00 0.00 0.00
21 150090301001073 922,25 259,60 406.14 256.51
22 150090301001078 398,93 177.28 135.85 85.80
23 150090301001086 150.99 40.74 67.57 42,68 v
< i T o - o >
Close Map Print

8.11 Shelter

Figure 8-25 Debris Generation Table

Shelter results, selected in Figure 8-26 and shown in Figure 8-27, allow the user to view and map the
estimated displaced population and the short-term shelter needs by Census block. See Section 8.3.5
for general methods to create maps and export data from the Flood Model results.
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Results | Bookmarks Insert Selection Geopn

View Current Scenario Results By... h E
Flood Hazard Maps »
General Building Stock »

Combined Wind and Flood Loss
Essential Facilities

User Defined Facilities
Transportation Systems r
Utility Systems
Vehicles
Debris

Shelter

Summary Reports... | Shelter

View Shelter Results

Figure 8-26 Results > Shelter Menu

B Displaced Population and People Needing Shelter - O x
Results for
Scenaria: 100yvear Return period: 100
CensusBlock DigplacedPopulation PeopleMesdingS helter -
1 200 0.00
2 2R0032056002007 0.00 0.00
3 2R0032057003000 47.00 0.00
4 2R0032057003001 8.00 0.00
5 2R0032057003003 E.00 200
B 2R0032057003004 4.00 1.00
7 2R0032057003006 7.00 0.00
8 2R0032057004006 1.00 0.00
9 2R0032057004007 28.00 1.00
10 2R0032057005000 453,00 19.00
11 2R0032057005001 126.00 200
12 2R0032057005002 53.00 0.00
13 2R0032057005003 21.00 1.00
14 2R0032057005005 0.00 0.00
15 2R0032058001002 200 0.00
16 2R0032058001007 126.00 Z2.00
17 2R0032058002002 44.00 23.00
18 2R0032058002003 4.00 4.00
19 2R0032058002004 £4.00 12.00
20 2R0032058002005 178.00 13.00
21 2R0032058002006 15.00 4.00
22 2R0032058002007 g2.00 15.00
23 2R0032058003000 126.00 13.00 o
£ Tt o o >
Cloze Map PFrint

Figure 8-27 Shelter Table

8.12 Summary Reports

The Summary Reports results, selected in Figure 8-28 and shown in Figure 8-29, allow the user to
view and print a wide variety of reports on topics, including Inventory, Buildings, Lifelines, and
Losses. The reports are created using the Crystal Reports engine that is included as part of Hazus
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installation. Figure 8-30 and Figure 8-31 show examples of the many reports available, as listed in
Table 8-1. Figure 8-31 shows the report-viewing window in Hazus, which contains icons along the top
to export or print reports and navigate through report pages. For example, the left-most icon (as
shown in Figure 8-31 allows the user to export a report in pdf format. Figure 8-32 shows the export

window for the user to select the report export format and file location.

Results | Bookmarks Insert Selection Geoproc

View Current Scenario Results By... h 1l
Flood Hazard Maps 3
General Building Stock 3

Combined Wind and Flood Loss
Essential Facilities

User Defined Facilities
Transportation Systems :)lﬁ
Utility Systems
Vehicles
Debris

Shelter

Summary Reports... |

Summary Reports...

Select Summary Reports (Crystal)

Figure 8-28 Results > Summary Reports Menu

Summary Reports X

Inventory  Buildings Lifelines  Induced Losses  Other

Please select the summary reports] to view:

Building Stock Dollar Exposure By Building Type
Building Stock Dollar Exposure By Occupancy
Transportation Systems Dollar Exposure

Utility System Dollar Exposure

WVehicle Dollar Exposure [Day]

Yehicle Dollar Exposure [Night)

View Close

Figure 8-29 Summary Reports (Inventory) Window
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HAZUS

Transportation System Dollar Exposure

RiskMAP

Increasing Resilience Together

March 20, 2024

All values are in thouzands of dollars

Highway R ailway Light Rail Bus Facility Ports Ferries Airport Total
Massachu setts I
Essex
Segments 742,437 4,931,817 ] 0 0 0 o 5,674,253
Bridges B5,544 5,190 0 0 0 0 o 70,724
Tunnek [ [} ] 0 0 0 o o
Facilities o ] 0 0 20881 0 o 20861
Total 807,981 4,937,007 o 0 20,861 0 0 5,765,649
Middlesex
Segments 765,530 13,089,216 0 0 0 0 0 13,834,852
Bridges 77.893 5,190 0 0 0 0 o 83083
Tunnek 0 o 0 0 0 0 o o
Facilities 0 ] 0 0 45,200 0 ] 45,200
Total 843,429 13,074,506 o 0 45,200 0 0 13,963,135
Suffolk
Segments 820,088 3,786,259 1,395,154 0 0 0 o 6,001,498
Bridges 128,204 10,380 0 0 0 0 o 147,284
Tunnek ] [ ] 0 0 0 o o
Facilitizs o o 0 0 24228 0 o 24,338
Study Region: SaugusRiver Page:1of2
Scenario: 100year
Retum Period: 3

Figure 8-30 Example - Transportation Systems Exposure Summary Report
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G Building Damage By General Occupancy

[m] x

Business Objects’

~
-
Building Damage By General Occupancy R]_Sk MAP
Increasing Resilience Together
March 20, 2024 All values are in thousands of square feet
Square Footage Distribution by Damage Percent Range
Total Dmg Square Footage <1 1-10 11-20 21-30 340 41-50 Substantial
Massachu setts I
Essex
Agriculture 7.98 0.74 228 372 093 018 000 0.00
Commercial 1.407.87 28011 345.75 £59.50 7722 2208 282 0.09
Education 118.69 84.08 52.05 0.58 0.00 0.00 0.00 0.00
Government 8770 7.08 2041 6013 007 002 000 0.00
Industrial 626.69 8 45 8827 38275 11233 2065 2780 8 a4
Religion 100.09 2.91 11.29 79.89 000 0.00 000 0.00
Residential 3.388.03 40817 718.57 1.299.15 714.47 180.40 52.86 16.40
Total 5,734.83 885.55 1,218.70 2,385.69 905.13 23333 83.49 2293
Middlesex
Agriculture 9.01 1.56 485 2.55 0.25 0.01 0.00 0.00
Cemmercial 31272 3536 140 82 121 80 1091 372 001 0.00
Education 35271 7863 27408 001 000 000 000 0.00
Government 281.45 9264 169.48 29.20 008 0.00 000 0.00
Industrial 1232 47.78 42.18 2485 19.85 544 0.27
Religion 995 770 593 000 000 000 0.00
Residential 2,155 60195 688 20 213 31 6463 2084 1102
Total 3,287.45 832.45 132276 757.09 249.37 88.20 26.29 11.29
Study Region: SsugusRiver Page : 1 of 4 v

Figure 8-31 Example - Building Damage By General Occupancy Summary Report

Export

Format:

&3 Adobe Acrobat (PDF)

Destination:

& Disk file

v

Cancel

Figure 8-32 Report Export
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Tab

Inventory

Inventory

Inventory

Inventory

Inventory

Inventory

Buildings

Buildings

Buildings

Buildings

Buildings

Buildings

Buildings

Table 8-1 List of Summary Reports

Report

Building Stock Dollar
Exposure by Building Type

Building Stock Dollar
Exposure by Occupancy

Transportation Systems
Dollar Exposure

Utility System Dollar
Exposure

Vehicle Dollar Exposure
(Day)

Vehicle Dollar Exposure
(Night)

Building Damage by
Building Type

Building Damage by
General Occupancy

Building Damage by
General Occupancy (Post-
FIRM)

Building Damage by
General Occupancy (Pre-
FIRM)

Building Damage Count by
General Building Type

Building Damage Count by
General Occupancy

Building Damage Count by
General Occupancy (Post-
FIRM)

Description

Dollar exposure (in thousands of dollars) of the building
stock by building type in the Study Region.

Dollar exposure (in thousands of dollars) of the building
stock by occupancy in the Study Region.

Dollar exposure (in thousands of dollars) of the
transportation systems in the Study Regjon.

Dollar exposure (in thousands of dollars) of the utility
system in the Study Region.

Dollar exposure (in thousands of dollars) of vehicles
(during the day) in the Study Region.

Dollar exposure (in thousands of dollars) of vehicles
(during the night) in the Study Region.

Building damage (square footage distribution by
percent damage) by building type caused by the hazard
in the scenario. All values are in thousands of square
feet.

Building damage (square footage distribution by
percent damage) by general occupancy caused by the
hazard in the scenario. All values are in thousands of
square feet.

Building damage (square footage distribution by
percent damage) by general occupancy (Post-FIRM)
caused by the hazard in the scenario. All values are in
thousands of square feet.

Building damage (square footage distribution by
percent damage) by general occupancy (Pre-FIRM)
caused by the hazard in the scenario. All values are in
thousands of square feet.

Building damage (building count by percent damage) by
general building type caused by the hazard in the
scenario.

Building damage (building count by percent damage) by
general occupancy caused by the hazard in the
scenario.

Building damage (building count by percent damage) by
general occupancy (Post-FIRM) caused by the hazard in
the scenario.
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Tab

Buildings

Buildings

Buildings

Buildings

Buildings

Buildings

Lifelines

Lifelines

Lifelines

Lifelines

Lifelines

Induced

Losses

Losses

Losses

Losses

Report

Building Damage Count by
General Occupancy (Pre-
FIRM)

Emergency Operation
Center Damage &
Functionality

Fire Station Damage &
Functionality

Hospital Damage &
Functionality

Police Station Damage &
Functionality

School Damage &
Functionality

Highway Bridge Damage &
Functionality

Light Rail Bridge Damage &
Functionality

Potable Water Facility
Damage

Railroad Bridge Damage &
Functionality

Wastewater Facility
Damage

Debris Generated

Annualized Direct
Economic Losses for
Buildings

Combined Wind and Surge
Loss

Depreciated Direct
Economic Losses for
Buildings

Direct Economic Losses for
Buildings

Description

Building damage (building count by percent damage) by
general occupancy (Pre-FIRM) caused by the hazard in
the scenario.

Damage and functionality of Emergency Operation
Center caused by the hazard in the scenario.

Damage and functionality of Fire Stations caused by the
hazard in the scenario.

Damage and functionality of Hospitals caused by the
hazard in the scenario.

Damage and functionality of Police Stations caused by
the hazard in the scenario.

Damage and functionality of Schools caused by the
hazard in the scenario.

Damage and functionality of Highway Bridges caused by
the hazard in the scenario.

Damage and functionality of Light Rail Bridges caused
by the hazard in the scenario.

Damage to Potable Water Facilities caused by the
hazard in the scenario.

Damage and functionality of Railroad Bridges caused by
the hazard in the scenario.

Damage to Wastewater Facilities caused by the hazard
in the scenario.

Estimated total of debris generated (in tons) by the
hazard in the scenario.

Annualized direct economic losses (in thousands of
dollars) for buildings resulting from the hazard in the
scenario.

Direct economic losses (in thousands of dollars) for the
combined results from wind and flood hazards in a
storm surge scenario.

Depreciated direct economic losses (in thousands of
dollars) for buildings resulting from the hazard in the
scenario.

Direct economic losses (in thousands of dollars) for
buildings resulting from the hazard in the scenario.
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Tab

Losses

Losses

Losses

Losses

Losses

Losses

Other

Other

Report

Direct Economic Losses for
Transportation

Direct Economic Losses for
UDFs

Direct Economic Losses for
Utilities

Direct Economic Losses for
Vehicles (Day)

Direct Economic Losses for
Vehicles (Night)

Shelter Requirements

Flood Global Risk Report

Quick Assessment

Description

Direct economic losses (in thousands of dollars) for
transportation resulting from the hazard in the scenario.

Direct economic losses for user-defined facilities (UDFs)
resulting from the hazard in the scenario.

Direct economic losses (in thousands of dollars) for
utilities resulting from the hazard in the scenario.

Direct economic losses (in thousands of dollars for
vehicles (during the day) resulting from the hazard in
the scenario.

Direct economic losses (in thousands of dollars) for
vehicles (during the night) resulting from the hazard in
the scenario.

Estimated number of persons to seek temporary shelter
in public shelters as a result of the hazard in the
scenario.

Includes general description of the region, building
exposure by occupancy type (one for the Study Region
and another for the scenario), expected building
damage by occupancy and expected building damage
by building type, expected damage to Essential
Facilities, debris generated, shelter requirements,
building-related economic loss estimates, and regional
population and building value data.

Includes regional statistics (area in square miles,
number of Census blocks, number of buildings, number
of people in the region, building exposure) and scenario
results (shelter requirements and economic loss).
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Section 9. Model Menu: Other Items

This section addresses the File menu, the Help menu, and the Customize menu. The primary focus is
on any menu items that are different in the Hazus version of ArcMap compared with a typical ArcMap

instance.

9.1 File Menu

The File menu, shown in Figure 9-1, is largely the same as the usual ArcMap File menu. The only two
differences are the first two items: Switch Hazard... and Study Region Wizard....

>
4

-

g B @ B85S

R @

File | Edit View Inventory Hazard Ar

Switch Hazard...

Study Region Wizard...
Save Ctrl+S
Save As...

Save A Copy...

Share As

Add Data

Sign In...

ArcGIS Online...

Page and Print Setup...

Print Preview...

Print...

Export Map...

Analyze Map...

Map Document Properties...

1 C:\HazusData\Re...\hazusFl.mxd

2 C\HazusData\Re...\hazusFl.mxd

3 CG\HazusData\Re...\hazusFl.mxd

Exit Alt+F4

Figure 9-1 Hazus File Menu

]

The Switch Hazard option opens the Select Hazard dialog (Figure 9-2), which allows the user to
switch between hazard types if the region was created with multiple hazards. Figure 9-2 shows an
example related to storm surge where the Study Region has data and analyses for both the
Hurricane Model and the Flood Model. When the user selects a new hazard, ArcMap will close and

re-open with the selected hazard.
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Select Hazard K

The region vou have selected has data for the hazards listed below. You can only work
on one hazard at a time.

You can always switch hazards at any time from the study region menu.
Please select the hazard to be current when your region is opened.
E arthquake
(®) Flood
() Hurricane

T sunami

Cancel

Figure 9-2 Select Hazard Dialog

The Study Region Wizard... option opens the Hazus startup screen (Figure 9-3

Hazus Startup X

Welcome to Hazus.

In order to use Hazus, you need to define the study
region to be uged in the analysis.

Please select the desired option below, and a wizard
will guide you through the necessary steps.

Create a new reqion

Delete a region
Duplicate a region
Export/Backup a region

Import a region

a
Q
=]
sl
[T
.
w
x
o
-
o
-
| =
[+ 4
=3
[}
-
S
<1
=
72}
=
[F¥]
=
=
[+ =
[ =
-
ok

Rins Arwpssmart Risk Amtuction @ FEMA

Exit

Figure 9-3). The only option available is Open a region. Click OK to select from any of the previously
created regions and launch ArcMap.

Page 9-2




Hazus Flood Model User Guidance

Hazus Startup X

Welcome to Hazus.

In order to use Hazus, you need to define the study
region to be used in the analysis.

Please select the desired option below, and a wizard
will guide you through the necessary steps.

Create a new region

Delete a region
Duplicate a region
Export/Backup a region

Import a region

[&]
Q
(@]
=
(1
.
w
x
=4
=
o
T
| =
[+
=3
(71
-
s
<T
e
=
w
i
w
=
<
[
e
-4
-
- =

Rins Aawsnsrmant Rltk Amtuction @ FEMA

Exit

Figure 9-3 Study Region Wizard

The remaining File menu options are the same as those normally found in ArcMap. Please refer to
Esri documentation for any questions regarding these options.

9.2 Help Menu

The Help menu, shown in Figure 9-4, is largely the same as the usual ArcMap Help menu. The only
two differences are the Obtaining Technical Support... and About Hazus-MH options.

[ Help |
&) ArcGIS Desktop Help
(3] ArcGIS Desktop Web Help

Obtaining Technical Support...
About Hazus-MH

About ArcMap...

Figure 9-4 Hazus Help Menu

Selecting the Obtaining Technical Support... option will open the Technical Support window (Figure
9-5), which provides a phone number and email address for the user to refer any technical questions
regarding Hazus.
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Technical Support X

Hazus

You may obtain technical assistance for Hazus by calling 877-336-2627 or
sending an email to: FEMA-Hazus-Support@fema. dhs. gov.

Figure 9-5 Technical Support Window

Selecting the About Hazus-MH option will open the About Hazus window (Figure 9-6), which shows
the copyright information for Hazus.

About Hazus *

Hazus B.1
@ Feleaze : 17.1.0
Copynght [c] 1997-2023 Federal Emergency Management Agency.

Developed by the Department of Homeland Securnity/Federal Emergency b anagement
Agency/Matural Hazard Rizk Assessment Program.

Figure 9-6 About Hazus Window

The remaining options on the Help menu are the same as those normally found in ArcMap. Please
refer to Esri documentation for any questions regarding these options.

9.3 Customize Menu

The Customize menu, shown in Figure 9-7, is largely the same as the usual ArcMap Customize menu.
The only addition to the menu is Flood Options....

Customize | Windows Help

Toolbars »

Extensions...

Add-In Manager...
Customize Mode...

Style Manager...
Flood Options...

ArcMap Options...

Figure 9-7 Hazus Customize Menu
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Selecting Flood Options... will open the Flood Options window (Figure 9-8), which has four tabs:
Startup Options (Figure 9-8), Raster Options (Figure 9-9), Automation (Figure 9-10), and Repository.
Although the Repository tab is not disabled, the functionality does not work. The Startup Options tab
gives the user some choices of what will appear when a Hazus ArcMap document is launched.

Flood Options X

Startup Options ~ Raster Options  Automation  Repository

[] Always show DEM (if available)
[] Always show computed Reaches [if available)
[] Open last Scenario (if available)
[] Show reda analyses Waming message boxfes)

[] &utomatically remave problem reach(es)

CustomBuffer [default: 2000 m)
Cancel

Figure 9-8 Flood Options (Startup Options) Window

The Raster Options tab (Figure 9-9) gives the user control over how rasters will be symbolized and
displayed in the Table of Contents.

Flood Options X

Startup Options ~ Raster Options  Automation  Repository

[ ] Automatically Merge multiple DEM paths without asking

Default raster transparency: 50| (0-100%)

Cancel

Page 9-5




Hazus Flood Model User Guidance

Figure 9-9 Flood Options (Raster Options) Window

The Automation tab (Figure 9-10) allows the user the set the parameters for a scenario to run from
stream networks. To run:

1.

2.

Select the Run Automation checkbox.
Enter the Drainage Area for the Study Regjon.

DEM Path is automatically included based on the previous DEM analysis. Editing the path will
have no effect on the DEM or DEM Path.

Enter a Scenario Name (the name must be unique). All reaches that are developed by the stream
network will be selected and included in the scenario.

Select a Return Period. If the user selects the Single return period, Hazus will run through the
GBS analysis. If the user selects the Suite option, Hazus will run through the GBS analysis and
the AAL analysis.

Click OK.

Flood Options X
Startup Options ~ Raster Options ~ Automation  Repository
(] Run Automation
Drainage Area; | |[0.25 - 400 sq miles.)

DEM Path: [:\HazusData\R egionsiM ontgomerg,-l.

Scenario Name:

Return Period: At P

Figure 9-10 Flood Options (Automation) Window
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Section 10. Advanced Hazus Analysis: User-Defined
Inventory Data

The Hazus baseline data inventory provides many datasets that support analysis, but in certain
areas, a custom dataset may be more relevant to the Study Region being analyzed. Although Hazus
data for a given location includes default inventory data for most data types, users may want to edit
existing data or input their own data for certain type of analysis. Users should perform all data
editing and entry using the Hazus Comprehensive Data Management System (CDMS) (Figure 10-1).
CDMS will use Hazus Flood Model default values when critical attributes have not been populated
(see Section 10.1 for baseline values). When CDMS is used to update the user-defined inventory
data at the state level, these updated data will automatically be included in any Hazus Study Regions
for that state. Details on using CDMS to import UDF and data requirements can be found in the
Hazus Comprehensive Data Management System User Guidance (FEMA, 2019).

. Comprehensive Dato Management Systern (COMS) = Eem==

File Tools @ Help

Welcome to the Hazus-MH

@ FEMA Comprehensive Data Management System

(Hilzee ez o o e el CDMS Repository [hict yet transferred into Statewide Layers) u

Category Layer Records Upload Date Uploaded By

Import into €DMS Repository from File

Import into COMS Repository from
Hazus-MH Study Region

‘ Building-Specific Data ‘

Query/Export

Transfer to Statewide Dataset
Update Study Region with Hazus-MH
Data

[Oriy last 10 updates are displaged below. To view all records run the u
Statewide Layer Modification History el e e gl

State Category Layer Records Upload Date Uploaded By

Current State

Please select HAZUS statewide

) Exit COMS

Figure 10-1 Hazus Comprehensive Data Management System

10.1 UDF Required Attributes

Table 10-1 presents the attributes required for analysis of UDFs within the Flood Model. If any of the
attributes are not imported (i.e., mapped), Hazus will populate them with baseline values. Although
those values can be edited later through the Hazus interface, doing so is not practical for such a
large number of records. Therefore, having the correct values in the imported file is more efficient
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than editing them later. Note that the minimum required attributes for UDF analysis in Hazus are
indicated by “Yes”, however, the minimum required attributes for CDMS are only Occupancy Type
and Building Area. More detailed information about preparing UDF for import via CDMS is available in
the Hazus Comprehensive Data Management System User Guidance (FEMA, 2019).

Table 10-1 UDF Attribute Descriptions

Attribute Description M|n.| mum Field Type Comments
Requirement
ID Hazus-assigned Yes Text, If the user wants to include
unique identifier (generated by Length: 8 their own unique identifier
for each record Hazus) for each structure, suggested
fields are “Name” and
“Comment.”
Name Structure name No Text, This field can be used for
Length: 40 user’s unique identifier for
each structure, which may be
local parcel ID if available.
Address Structure street No Text,
address Length: 40
City Structure city No Text,
Length: 40
State Structure state No Text,
Length: 2
ZipCode Structure zip No Text,
code Length: 10
Contact Structure No Text,
additional Length: 40
contact
Phone Structure phone No Text,
Length: 14
Occupancy Hazus-specific Yes Text, CDMS requires that
occupancy type Length: 5 occupancy type is defined by

the user. See Hazus
technical manuals or Hazus
Inventory menu for detailed
list of Hazus-specific
occupancies.
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Attribute

Cost

YearBuilt

Area

NumStories

FoundationType

FirstFloorHt

ContentCost

Description

Building
replacement
value = cost to
replace the
building in case
of damage in
whole dollars
(not thousands)

Year structure
was built

Building finished
floor area in
square feet

Number of
stories in the
building

Foundation type
of the structure

First floor height
above grade

Contents
replacement
value

Minimum
Requirement

Yes

No

Yes

Yes

Yes

No

No

Field Type

Currency

Number

Real,
Length: 40

Int,
Length: 40

Text,
Length: 1

Float,
Length: 4

Default: 1

Money,

Default: O

Comments

Primary source should be
cost-estimating guides
($/s0q.ft). CDMS will use Area,
Occupancy and default GBS
to estimate Cost if not
provided by the user.

User should provide the year
built between 1500 and
2100.

Required from user. CDMS
will use Area, Occupancy and
default GBS to estimate Cost
if not provided by the user.

CDMS will assume 1 if not
populated. See

Table 10-2 for acceptable
values.

CDMS will assume 7 (slab on
grade) if not populated. See
Table 10-4 for acceptable
values. Used to determine
with or without basement for
RES1 occupancies.

Value should be locally
derived. CDMS will assume 1
if not populated. See Table
10-4 for acceptable values.

If not populated, CDMS will
assume default value based
on Cost and standard Hazus
default contents value
multiplier assumptions. See
Hazus technical manuals or
Hazus Analysis menu for
specific multipliers.
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Attribute Description Mm.' mum Field Type Comments
Requirement

BldgDamageFnld Building No Number, If not populated, Hazus will
Damage Length: 10 assume the GBS default
Function ID value based on Occupancy,

Number of stories, and
Foundation Type. See Hazus
technical manuals or Hazus
Analysis menu for specific
values.

ContDamageFnld Contents No Number, If not populated, Hazus will
Damage Length: 10 assume the GBS default
Function ID value based on Occupancy,

Number of stories, and
Foundation Type. See Hazus
technical manuals or Hazus
Analysis menu for specific
values.

InvdamageFnid Inventory No Number, If not populated, Hazus will
Damage Length: 10 assume the GBS default
Function ID value based on Occupancy,

Number of stories, and
Foundation Type. See Hazus
technical manuals or Hazus
Analysis menu for specific
values.

FloodProtection  Level of No Int Hazus will assume O if not
protection populated. If near dam or
provided by a levee, set value for level of
dam or levee in protection in Return Period
Return Period) (e.g., 100 for protection

behind a 100-year flood
rated levee

ShelterCapacity  Capacity, in No Smallint, Not used in Hazus.
number of Length: 2
people, for Precision: 5
structure
providing shelter

BUPower Is backup power No Bit, No (default) = O, Yes = 1. Not
available? Length: 1 used in Hazus.
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Attribute Description Mm.' mum Field Type Comments
Requirement
Latitude/Longitu  The location of Yes Decimal, Importing data in CDMS will
de the structure Length: 9, pull location from spatial
Precision: 11, attributes of each structure
Scale: 6 point; manually entered data
with Hazus user interface will
require entering values when
adding a UDF point.
Census Tract The Census No Text,
Tract where the Length: 11
UDF is located
Comment Open text field No Text, Text field for additional
Length: 40 information.

Table 10-2 NumStories Field Description

Occupancy Number of Stories NumStories
from Parcel Data Value
RES1 1 1
RES1 2 2
RES1 3 3
RES1 Split-Level 4
RES2 1 1
RES2 2 2
RES2 3 3
RES3 1-2 1
RES3 3-4 3
RES3 5+ 5
All other occupancies 1-3 1
All other occupancies 4-7 4
All other occupancies 8+ 8
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Table 10-3 DesignLevel Field Description

Year Built Design Level Value
Prior - 1950 1
1950 - 1970 2

Post 1970 3
O (set to Null) 0

Table 10-4 FoundationType Field and FirstFloorHt Field Description

Foundation Type FoundationType  Default FirstFloorHt

from Parcel Data Value (feet) Value
Pile 1 7
Pier 2 5
Solid Wall 3 7
Basement/Yard 4 4
Crawl Space 5 3
Fill 6 2
Slab on Grade 7 1

These values are based on Pre-FIRM construction for
Riverine, Great Lakes, and Coastal Construction Census
blocks as defined through the Flood Specific Occupancy
Mapping table.

10.2 UDF User-Supplied Inventory

The creation of user-supplied inventory can require varying levels work to prepare. The extent of
preparation and data compilation work involved depends on the condition and completeness of
existing information, required data conversions, and the contributions of subject expertise. The
greatest impact from enhanced inputs is produced by editing both the default inventory.

The most detailed type of analysis incorporates the results from completed loss studies. For
example, the output of loss estimates performed using locally developed traffic models that have
identified the bridges most susceptible to damage can be included. Similar analyses can provide
information on water distribution or other pipeline systems. Updates to the vulnerability ratings for
each model building type will also produce more accurate analysis results.

Running a baseline analysis for comparison with results after introduction of user-supplied data is
recommended. Sensitivity of the loss estimation methodology under local conditions is measured
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best by review of outputs after inclusion of each enhanced inventory. Good record-keeping and
inventory of documentation are essential.

In some cases, data collected will have to be adjusted so that the inventory is classified according to
the systems defined in the methodology. For example, a school may have two building wing additions
that were constructed over the 40-year lifetime of the structure. Each era of construction used
improved materials, but the best materials were used to construct the smallest addition. The
individual responsible for assigning the building type of the school according to the Hazus
methodology will need to define and document the criteria applied to classify the structure. The
easiest approach is to break the facility into different entries (i.e., records).

Consult the Hazus Comprehensive Data Management System User Guidance (FEMA, 2019) for
specific information on use of that tool for data editing and entry.
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Section 11. Advanced Hazus Analysis: Hurricane Surge
Scenario

The Hazus tool can run a combined hurricane and flood hazard analysis for coastal areas. To run a
combined hurricane and flood hazard, a multi-hazard (flood and hurricane) Study Region that
includes a shoreline must be built. To build the Study Region, follow the workflow shown in Table
11-1. The inputs will be used to determine the extent of flooding due to a wind-driven storm and
estimate the flood losses associated with the hurricane.

Table 11-1 Workflow to Build Multi-Hazard Study Region

Model Inputs
Hurricane = Define/Select Hurricane Scenario
= Run Analysis with Surge-Only or Surge and
Waves

= Display Wind-Only Losses

Flood = Select Storm Surge
- Define Topography
= Define Scenario
= Delineate Floodplain
= Run Flood-Only Analysis
= Run Combined Loss Analysis

Hurricane or = Display Combined Losses
Flood

11.1 Storm Surge Scenario Options

The storm surge scenario options are available for four hurricane scenario types:

= Historic (It is recommended when selecting from the historic data to run storm surge is
applicable. These include observed data from recent events and additional files to improve the
reliability of the surge data)

=  User-defined
= Hazus import

= Hurrevac Hurricane Hazard Import Tool (HHIT) or .stm file library import; also see the Hazus
Hurricane Model Technical Manual (FEMA, 2024)

The storm surge scenario options are not available for:

= Hurricane surface wind file (.dat file format)
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=  Probabilistic

To run a storm surge analysis, the Study Region must have been created for both Hurricane and
Flood Hazard analysis. As shown in Section 3, start with create a New Region Wizard (Figure 11-1).
Check both Flood and Hurricane hazard boxes and click Next.

Create New Region X

Hazard Type
The hazard type controls the type and amount of data that will be aggregated. The hazard type selected affects the
analysis options that will be available.

Your study region can include one or more of the following hazards. Check below the
hazard(s) you are interested in.

[ Earthquake
v Flood
[¢ Hurricane

[ Tsunami

Notes:
1. Selection of hazards listed above depends upon the hazard modules installed.

2. Once a study region is built with a given hazard(s), it cannot be modified later on, in
other words, you cannot add another hazard to it. Alternatively, you may re-create a
similar region with different hazard(s).

3. If you are creating a Near Source only Tsunami region, please also check Earthquake
checkbox.

< Back | Next > | Cancel

Figure 11-1 Select Hazards for New Region

Specify the Study Region and finish the Create New Region wizard.

NOTE: Limiting storm surge Study Regions to a single county is recommended. In some cases, a very
large single county may need to be split into two regions.

Open a region and select the new multi-hazard. When prompted, select the Hurricane Model to open
first, as shown in Figure 11-2. Click Next and then click Finish to open the region.
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Open Region X

Study region hazards selection
If a region has data for multiple hazards, one only can be worked on at a time, and needs
to be selected before the regions is opened.

The region you have selected has data for the hazards listed below. You can only work
on one hazard at a time.

You can always switch hazards at any time from the study region menu.
Please select the hazard to be current when your region is opened.

" Earthguake

" Flood

® Hurricane

" Tsunami

< Back | Next = I Cancel

Figure 11-2 Select Hurricane Model First in Study Region

Analysis > Set Optimized Analysis Mode must be “Off,” as shown in Figure 11-3.

Analysis | Results Bookmarks Insert Selection Geoprocessing Customize

Damage Functions E GlE B P
-

Loss Functions

Loss of Use Functions
Debris Functions
Parameters »
| Set Optimized Analysis Mode OFF
User Supplied Coastal Surge Grid NO

Run...

Set Optimized Analysis Mode OFF

OFF: Performs analysis at Census
Show Coastal Surge Status Block level. Required for Storm

Surge, ON: Performs analysis at
/ Census Tract level,

Figure 11-3 Ensure Optimized Analysis Mode is Off
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Check Hazard > Show Current to make sure the scenario is set to manual, Hazus import, historical,
or Hurrevac import (Figure 11-4). If the scenario needs to be changed, use Hazard > Scenario to
open the Scenario Management Wizard discussed previously (Figure 11-5).

Hazard | Analysis Res

Scenario...

Show Current

Figure 11-4 Review Scenario in Hazard > Show Current

Scenario Wizard bt

Welcome to the Hurricane Scenario
Management Wizard

The Scenario Management Wizard will guide you through the process of defining a storm track for
a hurmicane scenario.

Hurmicane scenarios may be created by importing data from a file, manually entering data, or
copying an existing scenario.

Additionally, you can export a scenario to a file or delete a scenario that is no longer needed.

W
=
<
O
x
id
-
L

< Back Cancel

Figure 11-5 Scenario Management Wizard

11.2 Run Storm Surge Analysis

Open the Analysis Options from the Analysis > Run menu (Figure 11-6). When storm surge is
selected, as shown in Figure 11-7, a storm surge analysis using the National Oceanic and
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Atmospheric Administration (NOAA) Sea, Lake, and Overland Surges from Hurricanes (SLOSH) model
is executed in the Hurricane Model to produce estimates of coastal still water elevations. Note that
the storm track that is used should extend beyond the outer boundary of the applicable SLOSH basin
grids.

Analysis | Results Bookmarks Insert Select

Damage Functions

Loss Functions
Loss of Use Functions
Debris Functions

Parameters >

Set Optimized Analysis Mode OFF
User Supplied Coastal Surge Grid NO

Run...

Show Coastal Surge Status | Run Analysis
Run Analysis

]

Figure 11-6 Analysis Run Storm Surge Menu

Analysis Options X

- General Buildings A Select Al

=[] Essential Facilties

[ Medical Care el
Flrg Slatlor?s Expand Al
Police Stations
Emergency Centers Callapse Al
--[4] Schools

- User-Defined Buildings
|Z—Z|--- Induced Physical Damage
=-{7] Debiis

=[] Trees
Tree Blowdown
=-[£] Direct Social and E conomic Loss
Direct Economic Loss - General buildings

2] Direct Social Loss - Shelter
—-[¥] Storm Surge

[ Deep water and near shore wave models
-] Near shore wave model only

[ No waves
B--- Automated Output Options Output Options

: Create Summary Reports

[ Create Maps v | Run Analysi8|

.Ph}lsical Damage Related. Cancel

Figure 11-7 Analysis Options for Storm Surge
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In addition, there are options for running coupled surge and wave analysis using the Delft University
Simulating WAves Nearshore (SWAN) model if checked (refer to the Hazus Flood Model Technical
Manual (FEMA, 2024) for more details on the modeling approaches used for SWAN and SLOSH):

= Deep water and near shore wave models. A coarse analysis of the entire northwest Atlantic basin
is run, and the results are then coupled into one or more nearshore wave grids, which are
superimposed on the relevant SLOSH basin(s). This option is the most detailed and slowest
running. The storm track used should also extend all the way out to 60 degrees west longitude
when this option is selected.

= Near shore wave model only. This option runs a coupled surge and wave analysis within the
relevant SLOSH basin(s) only. This option is faster than the first option but still significantly
slower running than the “no waves” option.

=  No waves. This option skips the SWAN model entirely. For this case, the Flood Model assumes
depth-limited waves at the coastline rather than using significant wave heights produced by
SWAN. This is the fastest option.

When appropriate boxes have been checked in the Analysis Options, click Run Analysis.

At the start of the analysis, the Hurricane Model prompts the user for an initial water level in feet
with respect to the North American Vertical Datum (NAVD) 1988 datum shown in Figure 11-8. This
represents the water level along the coast that would have been expected (in the absence of the
hurricane) near the center of the Study Region at the time of hurricane landfall. The initial water level
can be estimated by using NOAA tide forecasts plus the pre-storm tidal anomaly (i.e., the difference
between the forecast and observed water level 2 days before landfall).

Initial Water Level

Input initial water level in feet above (positive) or
below (negative) mean sea level.

Figure 11-8 Provide Initial Water Level

When running a coastal surge hazard analysis (Figure 11-9) in the Hurricane Model, a second
progress dialog will appear after the wind-only damage and loss calculations are completed (Figure
11-10).
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Run Analysis

Analysis Progress

Total

Aggregating Tree Blowdown Functions...

= Cancel |

Figure 11-9 Run Analysis Progress Status Window

Run Storm Surge

Storm Surge Progress

Total

Computeiw/ind--01

. LCancel

Figure 11-10 Run Storm Surge Progress Status Window

When a hurricane coastal storm surge analysis is run, two sets of direct building losses are
produced: one set for the wind damage by itself and a second set for the combined wind and surge
damage. When the coastal surge analysis is complete, click the Analysis > Show Coastal Surge
Status to confirm that the analysis was successful, as shown by the status box in Figure 11-11.

Coastal Surge Status X

Storm Surge hazard analysis is complete. Switch to the Flood
Maodel to delineate the floodplain and compute losses, (1)

Figure 11-11 Coastal Surge Status Window
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To obtain the combined wind and surge losses, users must run a Coastal Surge analysis and

calculate the combined losses in the Flood Model. See further instructions in the Hazus Flood Model

Manual.

11.3 Storm Surge

After the Hurricane Model has been run, reopen the Study Regjon in the Flood Model.

View as Flood, shown in Figure 11-12. Click Next and then click Finish to open region.

Select Hazard

E arthgquake

(®) Flood
() Hurricane

T sunami

You can always switch hazards at any time from the study region menu.

Pleaze select the hazard to be current when your region is opened.

Figure 11-12 Select Flood Model in Study Region

Open the Hazard menu and select Flood Hazard Type (Figure 11-13).

Hazard ‘ Analysis Results Bookmarks Insert

Flood Hazard Type...

' w
sea

User Data

AR o &

Flood Hazard Type...

Scenario Select the flood hazard type

Riverine

Coastal

»

3

Figure 11-13 Select Flood Hazard Type

Select the Flood Hazard type Storm Surge and click OK (Figure 11-14).

X

The region you have selected has data for the hazards listed below. You can only work
on one hazard at a time.

Cancel
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Flood Hazard Type

() Riverine only
() Coastal only

(®) Storm surge

Study reqion flood hazard type

() Riverine and coastal

Combined wind and flood

Cancel

Figure 11-14 Select Storm Surge

After the hazard type is set, the user must import a DEM for the Study Region by opening the Hazard
menu and selecting the User Data dialog (Figure 11-15).

Hazard ‘ Analysis Results Bookm

Flood Hazard Type...

[ User Data

Coastal

Figure 11-15 Select User Data to Import DEM

User Data

Scenario »
User Data

Riverine »

The User Data dialog will only contain two tabs, DEM and Storm Surge. Use the Browse button to add
the DEM to the Model (Figure 11-16). Figure 11-17 shows the Storm Surge tab, where the Surge

Elevation Grid (SLOSH) and Significant Wave Height Grid (SWAN) that were produced by the

Hurricane Model are in the Study Region folder as surge.flt, surge.hdr (SLOSH), and waveht.flt,
waveht.hdr (SWAN). When the DEM is uploaded, click OK. See the Hazus Flood Model Technical

Manual (FEMA, 2024) for more details about obtaining DEM data.
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User Data

DEM  Storm Surge

DEM metadata
Vertical units Meotars 2
Vertical datum

NAVDSE8 v

Other vertical datum

Select DEM dataset(s)

C:\HazusData\HazardinputWDEM\CHarlestonSC\WUSGS_1_n34w079.tif A
C:\HazusData\Hazardinput\DEM\CHarlestonSC\USGS_1_n33w080.tif
C:\HazusData\Hazardinput\DEM\CHarlestonSC\USGS_1_n34w080.tif
C:\HazusData\Hazardinput\DEM\CHarlestonSC\USGS_1_n32w081.tif
C:\HazusData\HazardIinput\DEM\CHarlestonSC\USGS_1_n33w081 tif -
C:\HazusData\Hazardinout\DEM\CHarlestonSC\USGS 1 n34w081tif REMOVE

Determine required DEM extent ‘

Progress 1]

‘ oK H Cancel

Browse...

Figure 11-16 Add User Data DEM to Model
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User Data

DEM Storm Surge

Surge grids

Surge Elevation Grid (SLOSH)

C:\HazusData\Regions\CHarlestonSClsurgeft

Significant Wave Height Grid (SWAN)

C:\HazusData\Regions\CHarlestonSCiwav ehtft

Progress
OK Cancel

Figure 11-17 Review User Data in Storm Surge Tab

When the DEM uploads successfully, the user needs to create a new scenario next, using Hazard >
Scenario > New (Figure 11-18). Enter a unique name for the scenario and click OK (Figure 11-19). In
the storm surge scenarios, the surge and wave height files are automatically selected, and users do
not need to select or save any features because the Hurricane Model supports only one scenario per
Study Region.

Page 11-18




Hazus Flood Model User Guidance

Hazard | Analysis Results Bookmarks Insert Selection Geoprocessing
Flood Hazard Type... v o2 Gil e s
User Dat — ”
ser Data [ ) .
Scenario 4 || New...
Riverine »
Coastal > New...
Create New Study Case

Figure 11-18 Select New Scenario in Hazard Menu

Create New Scenario

Enter a unique name for the New Scenario:

CharlestonSC

Description
Storm Surge Analysis]

Cancel

Figure 11-19 Provide Name for New Scenario

If the user selected No Waves in the Storm Surge analysis for the Hurricane Model, only the surge
elevation grid was created for the Study Region. The wave height grid (waveht.flt) was not produced

and the shoreline needs to be characterized. In this case, after creating a new scenario, the
shoreline limits dialog will pop up, as shown in Figure 11-20.
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Shoreline Limits

Optionally draw shoreline startline, endline, and breaklines. Single dick
to add a vertex and double dick to finish drawing the line. For
breaklines only, right dick a line to remove it.

Current shoreline

< Previous Shoreline 1 of 8 Next Shoreline >
Limit type Action

(@) Startline Draw

(O Endline

(O Breakline Use Default

o>

Figure 11-20 Input Shoreline Limits

After clicking Next, there will be an additional shoreline characterization dialog, as shown in Figure
11-21. The Shoreline Type tab has one required input (wave exposure).

Shoreline Characteristics

Current shoreline: : _
< Previous Shoreline 1 of 8 Next Shoreline > Apply to All Segments

Shoreline Type

Shoreline characterization

Wave exposure

Open coast (full exposure) v

Cancel = Back Finish

Figure 11-21 Select Shoreline Characteristics
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The options for the wave exposure include:

=  Open coast (full exposure): Any shoreline where the storm surge and waves come directly off
open waters without the benefit of barrier islands or other land mass protection. Think in terms
of lines of waves marching directly onto the shoreline uninterrupted. Full exposure is the Hazus
default.

=  Moderate exposure: Best represented by a shoreline that is slightly protected from the storm
surge and associated waves. Moderate exposure might be a shoreline that has small islands or a
low-lying sandbar that help break the direct force of the waves on the shoreline. A shoreline with
moderate exposure might be angled to the direct line of the waves and will therefore receive a
portion of the wave front.

=  Minimal exposure: Best represented by a shoreline that is not in direct line with the storm surge
or the waves. Minimal exposure might include an exposed shoreline that is running close to
parallel to the storm surge and is therefore not bearing the brunt of the wave fronts.

=  Sheltered: Best represented by the shoreline within a bay or protected by a larger barrier island.
Sheltered could also be a shoreline along a large river inlet. The shoreline is sheltered from the
wave front and is most likely subjected to stillwater flooding.

The default parameter is Open coast (full exposure). At the top of the screen, the user can switch
from one shoreline segment (if more than one) to another and back. If there are multiple segments
and most have a single characteristic and a few have unique characteristics, the user can save time
and effort by applying the common characteristic to all segments by pressing Apply to All Segments
and then editing the unique segments.

After selections, click Finish.

Proceed to Delineate Floodplain by going to the Hazard Menu and selecting Coastal (Figure 11-22).
When it is finished, the completion window will be shown as in Figure 11-23.

Hazard | Analysis Results Bookmarks |Insert Selection Geoprocessing

Flood Hazard Type... | ]2 GG B e
User Data n t‘?:l x@v _

Scenario »

Riverine »

Coastal 4 ” Delineate Floodplain

Delineate Floodplain

Delineate Floodplain

Figure 11-22 Select Coastal to Delineate Floodplain
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Coastal

Successfully computed coastal flood hazard.
Total time: Hours: 0, Mins:50, Secs:47

Figure 11-23 Delineate Floodplain Completion Status Window

Figure 11-24 displays the completed hazard portion of a storm surge model. The coastal surge
model outputs a flood depth grid named “Mix0_c” to the map, which comprises SLOSH and wave

height grids.

@ Hazus: Flood - CHarlestonSC (CharlestonSC)
File Edit View |Inventory Hazard Analysis Results Bookmarks Inset Selection Geoprocessing Customize Windows Help

Bx o cid-[om L EERDEO R,
VW IHHE AL TN FECIFY . TRl

;A&

Table Of Contents

Eles8ia

¥

2 x

B & layers

= @ Mix0c
Value

= @ BoundaryPolygon
o

~

'High:36.168

" Low: 1.66893e-05

= @ ChosenShorelines
= @ RegionShore
-—
=] RegionDEM
Value
- High: 117.338

“Low:-54.0415

= [ Census Blocks
[J Census Blocks
=] Census Tracts
[] Census Tracts
=] Hillshade

Value

High: 254

Soeuon

v

aplan <

-80.345 32.765 Decimal Degrees

‘ yoleas ﬂ‘ Bojelen ﬂ‘

Figure 11-24 Example - Coastal Surge Floodplain Delineation

The next step to complete the analysis is by using the Analysis Menu and choose Run (Figure 11-25).
Next, check the General Building Stock Damage and Loss option and click OK (Figure 11-26).
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Analysis | Results Bookmarks Insert

Damage Functions » :
i Restoration Functions >
iy Parameters »

Average Annualized Loss
Combined Wind and Flood...
Run

Run

Calculate Loss

Figure 11-25 Select Run in Analysis Menu

Analysis Options

=B General Building Stock Damage and Loss
E Building and Content Damage (%)
Direct Economic Loss ($) (Bidg, Cont, Inv)
Damage Building Count

F E Depreciated Building and Content Loss ($)
-] Essential Facilties Select All
|:| User Defined Structures
@[] Transportation Systems Deselect All
@-[] utiity Systems L

[Jvehicles

-[_]Debris

@[] Direct Social Loss

Cancel

C:\has 105.60 GB free space;

Figure 11-26 Select Preferred Analysis Options
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The final step of a storm surge analysis is to calculate the combined hurricane wind and coastal
storm surge losses, using the Analysis Menu and selecting Combined Wind and Flood... (Figure
11-27). When the combined losses are completed, click OK to the message box (Figure 11-28).

Analysis | Results Bookmarks Insert Select

Damage Functions > r r_;
Restoration Functions > B
Parameters »

Average Annualized Loss
Combined Wind and Flood... |
Run Combined Wind and Flood...

Calculate Combined FL/HU
Coastal Surge Economic Loss

Figure 11-27 Select Combined Wind and Flood to Calculate Losses

Combined Coastal Surge analysis X
The Combined Wind and Flood
analysis has finished.

Figure 11-28 Combined Coastal Surge Status Window

When the analysis options have finished running, use the Results Menu (Figure 11-29) to View
Current Scenario Results By..., select the scenario in the drop-down, and click OK, as shown in Figure
11-30.
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Results l Bookmarks Insert Selection Geoprocessing Customize
View Current Scenario Results By...
| B B

Flood Hazard M
R View Current Scenario Results By...

S Stoclf: Select Return Period to Report on

Figure 11-29 Select View Current Scenario Results

View Results by

Scenario Mame:

‘Charlestans C

Scenario Description:

Storm Surge Analysis

Available Results:

What-[f Options:

| oK | Cancel ‘

Figure 11-30 Select Available Results for Surge Analysis
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The combined losses can be viewed either in the Flood Model or in the Hurricane Model using either
the Results > Combined Wind and Surge Loss menu (Figure 11-31 and Figure 11-32) or the Results
> Summary Reports > Direct Losses - Combined Wind and Surge Loss summary report. An example

results table is shown in Figure 11-33

[87 Combined FL/HU Surge Direct Economic Losses For Full Replacement Value — O X
By General Occupancy By Specific Dccupancy By General Buiding Type  Total

Results for

Scenano: CharlestonSC Return period: Mix0

Residential v | l Pre-Firm v |

CensusBlock BldgFloodLoss BldgwindLoss BldgComblLoss ContFloodLoss Contw/ ~

1 450190020031014 | 0.00 21.51 21.51 0.00
2 450190026041015 0.00 42003 420,03 0.00
3 450190028021005 0.00 345,44 345,44 0.00
4 450190031072002 0.00 413.98 41398 0.00
5 450190043004027 0.00 24.33 24,33 0.00
6 450130050001229 15.00 51.40 63.27 8.00
7 450190058002052 0.00 11.64 11.84 0.00
g 450190020041039 193.00 258.66 42933 112.00
9 450190020062043 0.00 141.92 141,92 0.00
10 450190025023083 0.00 28.63 2869 0.00
11 450190026042006 0.00 8.95 8.95 0.00
12 450190028011027 0.00 121.05 121.05 0.00
13 450190046081005 17.00 48.65 62,25 10.00
14 450130050003063 0.00 3173 31.79 0.00
15 450190055002002 0.00 13310 13310 0.00 v

< >

Close Map Print
Figure 11-33.
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Results I Bookmarks Insert Selection Geoprocessing Cu

View Current Scenario Results By...

JalFR

User Defined Facilities

Transportation System
Utility Systems

Flood Hazard Maps »

General Building Stock >

Combined Wind and Flood Loss |

Essential Facilities Combined Wind and Flood Loss

View Combined FL/HU Coastal
Surge Economic Losses For Full
Replacement Value

Vehicles

Debris
Shelter

Summary Reports...

Figure 11-31 Select Combined Wind and Flood Loss Results (Flood Model)

Essential Facilities

Results l Bookmarks Insert Selection Geoprocessing Customize
f Storm Track > .
| BEED -,
Wind Speeds
General Building Stock >
Combined Wind and Surge Loss  » | by Occupancy

by Building Type

User Defined Facilities
Debris

i Shelter

Summary Reports

I R

Figure 11-32 Select Combined Wind and Surge Loss (Hurricane Model)
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[87 Combined FL/HU Surge Direct Economic Losses For Full Replacement Value — O X
By General Occupancy By Specific Occupancy By General Building Type  Total
Results for
Scenario; CharlestonSC Return period: Mix0
Residential v | | Pre-Firm v |
CensusBlock BldgFloodLoss BldgwindLoss BldgCombLoss ContFloodLoss Contw/ ~
1 450130020031014 | 0.00 21.51 21.51 0.00
2 450190026041015 0.00 420.03 420,03 0.00
3 450190028021005 0,00 345,44 345,44 0.00
4 450190031072002 0.00 413.98 41398 0.00
5 450190043004027 0.00 24.33 24.33 0.00
B 450190050001229 15.00 51.40 63.27 8.00
7 450190058002052 0.00 11.84 11.84 0.00
8 450190020041039 193.00 258.66 42933 112.00
] 450190020062043 0.00 141.92 141.92 0.00
10 450190025023083 0.00 28.69 2869 0.00
1 450190026042006 0.00 8.95 895 0.00
12 450190028011027 0.00 121.05 121.05 0.00
13 450190046081005 17.00 48.65 62.25 10.00
14 450190050003063 0.00 31.79 3.79 0.00
15 450190055002002 0.00 13310 13310 0.00 v
< >
Close Map Print

Figure 11-33 Example - Combined Surge Result Table

Note that combined wind and surge results are available for building, content, and inventory losses
but not for relocation, income, rental, or wage losses. The radio buttons and drop-down boxes allow
the user to filter the losses by occupancy or building type.

Hazus has a limit of one scenario for the Coastal Surge flood hazard type. If the user already
completed the coastal surge model in a Study Region and decides to re-run the Hurricane Model, the
user must delete the previous flood scenario and re-input the DEM in the User Data dialog in the
Flood Model.

11.4 User-supplied Storm Surge Depth Grid Analysis

The user also has the option of importing their own coastal surge grid created outside of Hazus. To
do this, from the Analysis menu in the Hurricane Model ensure User Supplied Coastal Surge Grid is
set to “YES” (Figure 11-34), then run a hurricane wind analysis for the Study Region. Once the
hurricane analysis has completed, reopen the Study Region in the Flood Model.
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Figure 11-34 User Supplied Coastal Surge Grid Set to YES

iAnan,rsis i Results Bookmarks Insert Selecti

Damage Functions

Loss Functions

Loss of Use Functions

Debris Functions

Parameters

Set Optimized Analysis Mode OFF
User Supplied Coastal Surge Grid  YES

Run...

Show Coastal Surge Status

With the Study Region Flood Model open go to Hazard > Flood Hazard Type and select Storm surge

(Figure 11-35). Click OK.

Flood Hazard Type X

Study region fload hazard ype
() Riverine only
(7) Coastal only

() Riverine and coastal

Combined wind and flood

(®) Storm surge

Cancel

Figure 11-35 Flood Hazard Type Storm Surge

Next go to the Hazard > User Data menu and the User Data > Storm Surge dialog box will open as
shown in Figure 11-36. Click Browse to navigate to your user-supplied storm surge grid and click OK.
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User Data

Storm Surge

Surge grids
- Select Browse to add user-supplied surge grid(s).

- Only ArcGRID, GeoTIFF, Imagine, and file geodatabase rasters are
accepted.

- Combined losses are only calculated for census blocks that intersect
both the hurricane windfield and user-supplied surge hazard data.

[C\HazusData\HazardinpullSurgelCam surgelbaura ad RN
Remove
Set
Parameters
Thedepth grid 'Laura_Ad' intersects the study region boundary.
‘Laura_Ad'validation complete
= OK Cancel

Figure 11-36 Storm Surge Data Import Dialog Box

Click Yes to Overwrite and Process your storm surge data (Figure 11-37). The storm surge data is now
ready to be brought in a New Scenario and processed in the Coastal Flood Model.

Owverwrite and Process

and will overwrite your previous stream network.
To ensure proper operation, canceling is not allowed.
Continue?

o The proceeding analysis requires raster processing

el w

Figure 11-37 Overwrite and Process User-Supplied Storm Surge Data
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Go to Hazard > Scenario > New... and name your New Scenario. The New Scenario window will open
as shown in Figure 11-38. Click the Plus button and with the mouse drag a box around the coastal
surge grid. Then click the Save button and click OK. Note that there is not an option to characterize a
shoreline as seen in Section 12.3. All shoreline characterization steps are skipped when bringing in a
user-supplied storm surge depth grid. The grid is simply selected in the User Data dialog.

Select map features to beincluded in
the scenario. Asingle scenario may
contain morethan one objecttype

Map layer type

@ User-defined depth grds

Map layer selection

Addto selection +

Removefrom selection -

Clear selection p4
Saveselection 2
OK

Figure 11-38 New Scenario Window

Next go to Hazard > Coastal > Delineate Floodplain (Figure 11-39). Click OK (Figure 11-40) and click
Yes on the next screen (Figure 11-41). Processing will take a few minutes. Click OK on the
Successfully Completed Coastal Flood Hazard dialog box (Figure 11-42).

' Hazard | Analysis Results Bookmarks Insert Selection Geopi

Flood Hazard Type... v o” Gl B F
User Data o

[ R s
Scenario 3
Riverine »
Coastal L4 H Delineate Floodplain

Figure 11-39 Delineate Floodplain
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. Coastal Hazard Analysis X
Analysis type Single Return Period v Fill Al
Output cell size: | 5p v
User-defined depth grids

DG ID | Penod(s] to Analyze | Ayvailable Penods ~
|1 jo 1] DGO0_Laura_Ad
< >

Available memory: 2129 mb. Estimated use: 30 mb oK

Figure 11-40 Coastal Hazard Analysis

Process

The proceeding analysis requires raster processing.
To ensure proper operation, canceling is not allowed.

Also, to assure synchronicity between hazard and results
any previous results for this scenario will be deleted.
Continue?

Figure 11-41 Process Coastal Hazard

Coastal X

Successfully computed coastal flood hazard.
Total time: Hours: 0, Mins:00, Secs:32

Figure 11-42 Successfully Completed Coastal Flood Hazard
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Now the user can Run > Analysis to calculate losses. It is critical to run the storm surge flood-only
losses first, before running storm surge flood and hurricane combined losses.
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Section 12. Advanced Hazus Analysis: Import User-
Defined Data

Users have the option to bypass processing the DEM if they plan to run a scenario that only includes
the flood depth grids and/or USACE HEC-RAS .FLT grids. The Hazus Program recommends users
import their specific flood hazard information from external sources via depth grids, HEC-RAS, or
other hydrologic and hydraulic model. Note that the FIT is no longer supported; however, the FIT User
Data tab can still be used to import existing FIT projects.

User Data

DEM | FIT Depth Grid | HEC-RAS

Select FIT folders

Rivetine | Coastal

- Browse...

Progress

Figure 12-1 Select FIT Tab to Import FIT Data

12.1 Import Flood Depth Grid Results (preferred method for importing flood
hazard information)

While Hazus can perform hydrology and hydraulic analysis to produce flood depth rasters,
engineering-based depth grids provide more detailed analysis and results. Users are encouraged to
research if depth grids from engineering-based studies are available to use in the advanced analysis.
Examples of common depth grid sources include the following:

=  FEMA'’s Map Service Center MSC: https://msc.fema.gov/portal/home FEMA Risk MAP program
risk databases that include high resolution lidar-based return period depth grids for many
communities based on FEMA approved hydraulic models.
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Coastal Emergency Risks Assessment (CERA): https://cera.coastalrisk.live/ Advanced
Circulation Model For Oceanic, Coastal And Estuarine Waters (ADCIRC) based current and
historic storm surge data.

USGS Flood Inundation Mapper (FIM): https://fim.wim.usgs.gov/fim/

FEMA/USGS Base Flood Elevation Viewer: https://webapps.usgs.gov/infrm/estbfe/ return period
depth grids by watershed for FEMA Region VI.

FEMA Geoplatform: https://disasters.geoplatform.gov/publicdata/NationalDisasters/ depth
grids for significant disaster events from 2012 to present developed by FEMA to support disaster
response and recovery.

12.1.1 Obtaining Data to Import Into Hazus From the Map Service Center

The following steps demonstrate how to locate and download data from FEMA’s Map Service Center
to import into Hazus.

To obtain depth grids from the FEMA MSC flood Risk MAP databases use the following steps:

1.

Go to FEMA'’s Flood Map Service Center: https://msc.fema.gov/portal/home, and select Search
All Products (Figure 12-2).

FEMA Flood Map Service Center: Welcome!

Looking for a Flood Map? @

Enter an address, a place, or longitude/latitude coordinates:

Enter an address, a place, or ongity de/latitude coordinates

Looking for more than just a current flood map?

Visit Search All Products to access the full range of flood risk products for your

community. \

Figure 12-2 FEMA Map Service Center

Users can search by the drop-down menus, jurisdiction name, or product id (Figure 12-3).
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FEMA Flood Map Service Center: Search All Products

Choose one of the three search options below and optionally enter a posting date range

Jurisdiction Jurisdiction Name

State Jurisdiction Name or FEMA ID
TEXAS v

County o He
HARRIS COUNTY v

Community
HARRIS COUNTY ALL JURISDICTION v

> Filter By Posting Date Range (Optional)

Clear All Fields

Figure 12-3 Map Service Center Search Options

Product ID @

Product ID

3. The search results will appear in a list. When you click on a drop down arrow in the Download
column, a table with the items available to download appears (Figure 12-4). Each item’s Product
ID (name) is listed, as well as the file format, date, and size. To download click on the download

link that is indicated by the green arrow with DL icon.

*  Flood Risk Maps (7))
4 Risk Repo )

d Risk Database (21)

MSC
Product ID File Format Posting Size Download
Date
FRD_12040104_05_GeoDatabase GeoDatabase 04/06/2017 498MB SDL
Flood Risk
FRD_12040104 05 GeoTIFF Product - Flood 04/06/2017 578MB oL
Risk Database
FRD_12040104_05_Shapefiles ShapeFiles 04/06/2017 8MB &0l
FRD_12040104_BB_GeoDatabase GeoDatabase 06/08/2018 397MB <D
Flood Risk
FRD_12040104 BB_GeoTIFF Product - Flood 06/08/2018 397MB oL
Risk Database
FRD_ 12040104 BB Shapefiles ShapeFiles 06/08/2018 OMB $oL
FRD_12070104_GeoDatabase GeoDatabase 09/28/2018 $oL
FRD_12070104_GeoTiffs GeoTIFFs 04/26/2016 oL
FRD 48039C GeoDatabase GeoDatabase 09/12/2018 570MB DL
FRD_48071C_Coastal_GeoDatabase GeoDatabase 08/30/2013 1541MB $oL
FRD_48071C Coastal GeaTIFFS GeoTIFFs 08/30/2013 1334MB oL

Figure 12-4 Jurisdiction Search Results
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Most study results will have a GeoTiff and a Geodatabase version with the depth grids. Hazus can
process both.

4. Data will download in a zipped file. An example of the data in the file is shown in Figure 12-5.

m LY r—

Add Data [k *
a3 E- s as

Lookin: | Analysis Rasters GeoTIFF w

i dpth_02pcttif B wse_10pcttif
ddpth_10pettif  EHwse_1pcttif

i dpth_1pct.tif B wse pctpls.tif
i dpth_1pctplstif BB wse_2pcttif

i dpth_2pct.tif ﬁwse_ripct.tif

i dpth_dpct.tif

i pet30yrehance.tif

i pctannchancetif

i wse_02pct.tif

Mame: | | Add

ll Show of type! | patasets, Layers and Results ~ Cancel

Figure 12-5 Geotiff Data from Map Service Center

Hazus uses the WGS84 UTM (Universal Transverse Mercator) Zone projection. It is important to note
that the available grid data may use a different projection than WGS84 UTM Zone. Hazus will convert
input data into ArcGIS GRID format and the WGS84 UTM Zone projection. However, for extremely
large grid data (e.g., over 1 GB) or for those in a different projection, the grids can be converted
outside of Hazus to optimize processing time in Hazus, conserve drive space and prevent potential
projection issues.

12.1.2 Importing Data Into Hazus

To import flood depth grid results into Hazus, select User Data from the Hazard menu. In the User
Data window, select the Depth Grid tab, as shown in Figure 12-6. The format of user supplied depth
grids can be Esri GRID, IMAGINE (.IMG), HEC-RAS (.FLT), tagged image file (.TIF), and file
geodatabase (fGDB).

Use the Browse... button to navigate to the location of the flood depth grid. The browse dialog is
intended to select a raster. After importing the flood depth grid, select the newly imported flood
depth grid and click the Set Parameters button. A Set Parameters window will appear (Figure 12-7).
Use the drop-down menu to select the Units (feet or meters), and then input the Return Period of the
flood depth grid. It is important that users import the flood depth grid into the correct hazard tab.
Repeat the process to import additional flood depth grids.
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User Data

Select depth grids
Riverine (Coastal

DEM FIT Depth Grid HEC-RAS

Browse...

Remove
Set
Parameters

'quickdepth’ validation complete.

The depth grid 'quickdepth'intersects the study region boundary.

OK Cancel

Figure 12-6 Select Depth Grid Tab to Import Depth Grid Data

Set Parameters

Depth grid parameters

Return period
(required for
probabilisfic

scenarios)

Units:

Feet

Meters

Cancel

Figure 12-7 Set Parameters for Depth Grid Dialog
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12.2 Import HEC-RAS .FLT Grid Results (preferred method for importing flood
hazard information)

Users of HEC-RAS can import HEC-RAS (via RAS Mapper) hydraulic output .FLT grids to be used in the
Flood Model. The HEC-RAS .FLT grids are implicitly treated as Riverine. To import HEC-RAS .FLT grid
results into Hazus, select User Data from the Hazard menu. In the User Data window, select the HEC-
RAS tab, as shown in Figure 12-8. Use the Browse button to navigate to the HEC-RAS (produced via
RAS Mapper) hydraulic output .FLT grid. The browse dialog is intended to select a floating-point
binary file. After the .FLT grid is selected, the Flood Model validates the input by making sure the .FLT
grid’s associated floodplain boundary (by default, HEC-RAS saves it as FloodMap) is located partially
within the Study Region (geographically) and contains projection information (prj.adf). The Flood
Model does not validate the integrity between the .FLT grid and the floodplain boundary polygon (by
default, HEC-RAS saves it as FloodMap). A status bar, shown at the bottom of the window in Figure
12-8, will indicate the level of progress as the data is imported and validated.

Select the newly imported .FLT grid and click the Set Parameters button. A Set Parameters window
will appear (Figure 12-9). Use the drop-down menu to select the Units (feet or meters), and then
input the Return Period of the flood depth grid. Repeat the process to import additional HEC-RAS
.FLT grids.
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User Data

|DEM | FIT | Depth Grid | HEC-RAS

Select HEC-RAS grids

CitempFLT he Ltp f

Set
Parameters

Walidated the HEC-RAS 1 file

| o || conea |

Figure 12-8 Select the HEC-RAS Tab to Import .FLT Grid Data

‘Set Fiarameters

Depth gnd parameters

Urits: [ Fast =

Return period  5qy
[optional]:

| ok || Cancel

Figure 12-9 Set Parameters for .FLT Grid Dialog
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